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Product Overview

The Simulink® Report Generator™ software creates documentation, called
reports, about Simulink®, Stateflow®, and Real-Time Workshop® data and
workflows. It enables you to:

Create reports for snapshots of models (and their properties) and diagrams.

Create interactive Web views of models and diagrams.

Create reports of code generated by the Real-Time Workshop software in
Adobe® Acrobat® PDF and Microsoft® Word formats.

¢ Document results of model simulation.

Run checks on models using Model Advisor, and report the results.
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What Is the Report Explorer?

In this section...

“About the Report Explorer” on page 1-3
“The Outline Pane” on page 1-5
“The Options Pane” on page 1-6

“The Properties Pane” on page 1-7

About the Report Explorer

The Report Explorer is the Simulink® Report Generator™ graphical user
interface (GUI). It allows you to:

¢ Create and modify report templates.

¢ Apply stylesheets to format the report.

e Specify the report file format.

® Generate reports.

To open the Report Explorer, click Tools > Report Generator in the
Simulink® model window menu bar.

1-3



Getting Started

1-4

Report Generator Help Menu
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Thiz iz the main interface for the Repart Gener
exizting Report Generator file from the lizt or cr

Properties pane

The Report Explorer has three panes:

¢ The Outline pane on the left shows the hierarchy of components in currently
opened report templates. Report components can reside within other report
components, creating parent, child, and sibling relationships. For more
information, see “The Outline Pane” on page 1-5.



What Is the Report Explorerg

® The Options pane in the middle lists the options available in the context
of the Outline pane. If no report template is open, the Options pane lists
available reports. When a report template is open, the Options pane lists
components available to insert into it. When a stylesheet is open, the
Options pane lists available attributes. For more information, see “The
Options Pane” on page 1-6 .

¢ If no report template is open, the Properties pane on the right displays
tasks the Report Explorer can perform. If a report template is open, the
Properties pane displays the properties of the currently selected item in the
Options pane. For more information, see “The Properties Pane” on page 1-7.

Tip If the Report Explorer window opens with only two panes, one of the
panes is hidden. You can move the vertical boundaries between the panes to
reveal any hidden pane, or to make visible panes wider or narrower.

The Outline Pane
The Outline pane initially includes the top level of the report template.

E‘Z Repart Generator
- 2% Report - Unnamed.ipt
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The Options Pane

The Options pane lists by category components that you can add to report
templates. In the following figure, the visible component categories are

Formatting, Handle Graphics, Logical and Flow Control, and MATLAB.
For more information about report components, see Component Reference.

The folder icon represents a component category. The blue square icon
represents a component.



What Is the Report Explorer?
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The Properties Pane

After you create a report template, the Properties pane initially shows

properties for the report template as a whole.
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Simulink® Report Generator™ Workflow

Simulink® Report Generator™ Workflow

1 Open the Report Explorer. In the menu bar on the Simulink® model
window, click Tools > Report Generator.

2 Create a new report template. For more information about report
templates, see Creating Simulink Reports.

3 Add existing Simulink or Stateflow® components to the report template,
or create your own custom components. For more information on using
components, see Working with Components.

4 Choose an existing stylesheet or create a custom stylesheet to apply styles
and standards to the report template. For more information, see “Creating
Custom Stylesheets” in the MATLAB® Report Generator™ documentation.

5 Generate the report.

The following figure illustrates a typical Simulink® Report Generator™

workflow.
Report Generator

I ]
I I
I Export |
: = Simulink !
I Web View |
I I
I I
I I
: Open :
| Create Report Create Add Apply Generate| |
I'| Simulink —| Explorer [ S€tUP ™| components [~| stylesheet =™ report | |
Il model (GUI) file !
| |
I I
I I
| |
I I
I I
| I
1 |
I I
| |

e e —— —— ——_———_——_———_—— — e e e e
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How Simulink® Report Generator™ and Simulink®
Software Interact

The Simulink® and Simulink® Report Generator™ software interact to create
reports and Web views. The following table describes these interactions.

User Interaction with Simulink Report
Interface Generator software Description
Report The Report Explorer is the Simulink Use the Report Explorer to edit
Explorer Report Generator graphical user existing report templates, components,
interface (GUI). For more information, | stylesheets, and attributes, or to
see “What Is the Report Explorer?” on | customize your own.
page 1-3.
Simulink Use Simulink model windows to: Use the Simulink model window to:
model
window ¢ Export the model to a Web view ¢ Create a report that incorporates

without using the Report Explorer

e Start the Report Explorer to export
the model to a Web view or generate
a report

the current Simulink model

¢ Export the model to a Web view

For more information, see Exporting
Simulink Models to Web Views.

Simulink Report Generator software also interacts with Real-Time Workshop®

and Stateflow® software.

Use report generation capabilities with the Real-Time Workshop software to:

¢ Create Adobe® Acrobat® PDF and Microsoft® Word documents for generated

code.

Use report generation capabilities with the Real-Time Workshop software to:

Take snapshots of charts.
Describe truth tables.

¢ Document chart hierarchy.

¢ Document Real-Time Workshop object properties.
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Supported Report Formats

When the report generation process first creates a report, it generates
a DocBook XML source file. You can customize this XML as needed.
For more information, see the OASIS DocBook TC Web page at
http://www.oasis-open.org.

Next, the report generation process converts the XML source to one of these
user-specified report formats:

¢ Rich Text Format (RTF)

¢ Hypertext Markup Language (HTML)
e Microsoft® Word (.doc)

¢ Adobe® Acrobat® PDF

Note Only PDF reports support .bmp and . jpg images.

1-11
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Browser Requirements for Web Views

Web views require a Web browser that supports Scalable Vector Graphics
(SVG). Web views use SVG to render and navigate models.

The MathWorks recommends the following Web browsers:

® Mozilla Firefox Version 1.5 or later, which has native support for SVG. To
download the Firefox browser, see http://www.mozilla.com/.

Note Firefox for Mac OS® platforms does not currently support Web views.

¢ The Microsoft® Internet Explorer® Web browser with the Adobe® SVG
Viewer plug-in. To download the Adobe SVG Viewer plug-in, see
http://www.adobe.com/svg/.

1-12
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Creating Simulink® Reports

About This Tutorial (p. 2-2)

Setting Report Options in the Report
Template (p. 2-3)

Adding Components to the Report
Template (p. 2-5)

Generating the Report (p. 2-49)

Simulink® Report Generator™
software tasks demonstrated in this
tutorial

How to create report templates and
specify options for generated reports

How to build a report by adding
components to its template

How to generate a report after
defining its components
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About This Tutorial

This tutorial demonstrates the following tasks:

¢ Inserting models and scopes into reports

¢ (Creating tables in reports using workspace data

¢ Evaluating MATLAB® expressions

¢ Inserting values of workspace variables into reports
¢ Creating reports with chapters and subsections

¢ Running loops and flow control

¢ Handling errors

It shows you how to use the Report Explorer to design a report template and
generate a report that does the following:

¢ Opens a Simulink® model for the van der Pol equation, called the vdp
model.

e Sets the Gain parameter for the Mu block to five different values.

¢ Simulates the model each time the Gain parameter is set.

¢ (Collects the results. Results that fall within a specified range appear in a

table in the generated report.

You do not need to know MATLAB or Simulink software to run this tutorial.
However, knowledge of these products might be helpful for understanding the
M-code and model simulation that executes.
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Setting Report Options in the Report Template
To create and configure the report template:

1 Start a Simulink® software session.

2 Open the Report Explorer by clicking Tools > Report Generator in the
Simulink model window menu bar.

3 Select File > New to create a report template.
4 Save the report template.

In the Properties pane:

a Specify where to save the report template. To save it in the current
working directory, select Present Working Directory from the
Directory selection list.

b Specify the report format. In the File format selection list, select
Acrobat (PDF).

¢ Enter a description for the report. In the Report description text box,
replace the existing contents with the following text.

Tip Copy and paste this code from the HTML documentation into the
Report Explorer.

Simulink Dynamic Report

This report opens up a model, sets a block parameter
several times, simulates the model, and collects the
results. Results that fall within a specified range are
displayed in a table after the test is complete.

The report is configured to test the vdp model only.
By selecting the Eval String component immediately
below the Report component, you can modify

* model

* pblock
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* parameter
* tested values

5 Click File > Save As to save the report template as
simulink_tutorial.rpt.

The Outline pane on the left displays the new file name.

Elﬂ Report Generator
27 Report - simulink_tutarial. ipt

2-4
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Adding Components to the Report Template

In this section...

“What Are Components?” on page 2-5

“Adding MATLAB® Code” on page 2-7

“Adding a Title Page” on page 2-13

“Opening the Simulink® Model” on page 2-16

“Adding Logical Then and Logical Else Components” on page 2-18
“Displaying an Error When the Model Cannot Be Opened” on page 2-19
“Creating the Body of the Report” on page 2-22

What Are Components?

Report components specify what information to include in the report. The
following figure shows a sample page from the report you create in this
tutorial, and which components you use to produce this output.

Note Report components added to the report template must not be
deactivated in order for the report to generate correctly.

2-5
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Chapter/
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Snapshot —
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Adding MATLAB® Code

The first component to add is the Evaluate MATLAB Expression component,
which evaluates MATLAB® commands in the workspace. The code in this
component assigns initial values to variables used in this tutorial.

1 In the Outline pane on the left, select simulink_ tutorial.rpt.

El?ﬂ Repart Generator
‘ff,? Feport - simulink_tutorial.rpt

2 In the Options pane in the middle, under the MATLAB category, select
Evaluate MATLAB Expression.

Evaluate MATLAR Expression
Inzert W ariable

kATLAR Property Table

MATLAB /T oolbox Yersion Mumber
Wariable Table

B OB B B E(

3 In the Properties pane on the right, click the icon next to Add component
to current report to insert the component into the report.

Note You cannot edit the component information in the Properties pane
on the right until you add the component to the report.

In the Outline pane on the left, the Evaluate MATLAB Expression
component appears under the simulink_ tutorial report template. The
Simulink® Report Generator™ software abbreviates the component name
to Eval.
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=2 ?,? Repart - simulink_tutaorial rpt*
b B Eval - ZE valuate this zhring in the bas...

EI‘Z Report Generator |

The icon in the upper-left corner of the Eval component’s icon indicates
that this component cannot have child components. By default, any
components you add while the Eval component is selected are siblings of
this component.

The options for the Evaluate MATLAB Expression component appear in
the Properties pane on the right.
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Evaluate MATLAB Expression
V¥ Inzert MATLAE expression in report

Iv Dizplay command window output in repart

E wprezsion to evaluate in the baze workspace; Eval Mow |

%Ewvaluate this string in the ba=e worlkspace

¥ Ewaluate this expression if there iz an emor:

rptgen.displavies=zage(sprintf( 'Error during
%rptgen.displaviessage( 'Halting generation'.

4| | 2

Fewert | Help |

4 Clear the Insert MATLAB expression in report and the Display

command window output in report check boxes so you do not include
MATLAB code or output in this report.

5 Add M-code to the Expression to evaluate in the base workspace text
box to specify the following values:

e The model name

¢ The block name
¢ The block parameter
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e Parameter values

® Other initial values required for processing the vdp model
Replace the existing text with the following M-code.

%The name of the model
%sthat will be changed
expModel="'vdp"';

%The name of the block in the model
%sthat will be changed
expBlock="'vdp/Mu';

%The name of the block parameter
%sthat will be changed
expParam='Gain';

%The values that will be set
sduring experimentation

expValue=[-1 0 .5 1 2];

%sexpValue can be either a vector
%sor a cell array

testMin=2.1;
testMax=3;

%---- do not change code below line ---
try
open_system(expModel);

end

expOkValues=cell(0,2);

2-10
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Note When you change a field in the Properties pane on the right, the
field background changes color (the default is a cream color), indicating
that there are unapplied changes to that field. As soon as you perform
operations on another component, the Simulink Report Generator software
applies the changes, and the background color becomes white again.

6 Select the Evaluate this expression if there is an error check box.

7 In the field under the check box, replace the existing text with the following
text:

disp([ 'Error during eval: ', lasterr])

The Report Explorer window now looks as follows.

2-11
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Tip To run the commands that you specified in your MATLAB expression,
click the Eval Now button. This button is located at the upper-right corner
of the Report Explorer. This is an easy way to ensure that your commands
are correct and will not cause report generation problems.

8 Click File > Save to save the report template.

Adding a Title Page

Create a custom title page for your report using the Title Page component.

1 In the Outline pane on the left, select the Eval component.

EI‘Z R eport Generator
= 7 Report - simulink _tutorial rpt*
L Eval - ZE valuate thiz sting in the bas...

2 In the Options pane in the middle, under the Formatting category, click
Title Page.

= - Formatting --ee-eeeeeeeeeee-
Chapter/Subsection
Image

Link,

List

Paragraph

Table

Text

Title Page

BB BB EEEE

3 Click the icon next to Add component to current report.

The Title Page component appears in the Outline pane.
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2 Creating Simulink® Reports

EI‘Z Repart Generator
= ﬁ? Report - simulink_tutorial.rpt*
Qﬁ Eval - %The name of the model Zthat wil...
-l Title Page - <No Titlex

4 In the Properties pane on the right:

a In the Title text box, enter:

Dynamic Simulink Report

b In the Subtitle text box, enter:

Using Simulink Report Generator to Document Changes

¢ In the Options section, choose Custom Author from the selection list.
d Enter your name in the text box.
e Select the Include report creation date check box.

f Select the default date and time format from the selection list. The
Properties pane on the right looks as follows.
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Title Page
—Title

Title: ID_I,Inamiu: Simulink, B eport

Subtitle: ILIsing Fiepaort Generatar to Document Changes

— Options

Image file name:l

I Cusztom author:

;l IJ ohn . Engineer

¥ Include report creation date:

f de-mmm-pyyy HH:MM: 55 (09-0ct-2006 19:20:46) |

[ Include copyright holder and vear: |

—bibstract

—Legal notice

4]

Hewert |

5 Save the report template.
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Opening the Simulink® Model

The following statement in the Evaluate MATLAB Expression component
that you created in “Adding MATLAB® Code” on page 2-7 tries to open the
vdp model:

try
open_system(expModel);
end

Tip Select the Eval component in the Outline pane on the left to look at
this code again.

To see if the vdp model was successfully opened, test the result of the
open_system command using a Logical If component.

1 In the Outline pane on the left, select the Title Page component.

2 In the Options pane in the middle, under the Logical and Flow Control
category, select Logical If. This component checks to see if a given
condition is true or false; in this case, if the model opened successfully.

i - Logical and Flow Control -
For Loop

Logical Else

Logical Elzeif

Logical If

Logical Then

While Loop

OB OB B O E

3 In the Properties pane on the right, click the icon next to Add component
to current report. The Logical If component appears as if in the
Outline pane.
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Adding Components to the Report Template

=- ‘?J Report Generator
= % Report - simulink_tutorial.rpt*
E Ewal - ZThe name of the model Zthat wi.,
{}Eﬁ Title Page - Dynaric Simulink, Feport

L2 (e

These components are child components of the report and siblings of one
another. Components can have parent, child, and sibling relationships.

This component can have child components. “Adding Logical Then and
Logical Else Components” on page 2-18 explains how to add two child
components to the if component.

4 In the Properties pane on the right, in the Test expression text box,
replace the default text, true, with the following text:

strcmp (bdroot(gcs),expModel)

The if component name in the Outline pane changes to include this
expression.

Elf_ﬂ R eport Generator
=- %? Report - simulink_tutonal. rpts
- @l Eval - %The name of the model Zthat wil
E Title Page - Dynamic Simulink. Beport
o881 [stremplbdroat{ges) expMadel]]

The strcmp function compares the name of the open Simulink® model and
the value of expModel, which was set to 'vdp'. It tests to see if the vdp
model opened successfully. strcmp returns 1 (true) if the two strings
match, and 0 (false) if not.

5 Save the report template.
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2-18

Adding Logical Then and Logical Else Components

The if strcmp(bdroot(gcs), expModel)) component has two possible
results. Add two child components to the report template to process these
cases.

1 In the Outline pane on the left, select the if component.

El‘?J Report Generator
= 2% Report - simulink _tutorial rpt*
ﬁ Ewval - %Ewvaluate thiz stiing in the basz...
-8l Title Page - <Mo Title>
it (e

2 In the Options pane in the middle, under the Logical and Flow Control
category, double-click Logical Then.

3 In the Outline pane on the left, select the if component again.

4 In the Options pane in the middle, under the Logical and Flow Control
category, double-click Logical Else.

Both elements are added as child components to the if component, as
shown in the Outline pane.

El‘/nj Report Generator
= 7 Repart - simulink_tutarial.rpt
ﬁ Ewal - ZThe name of the model Zthat wil..
E Tithe Page - Dynamic Simulink Report
El*{ﬁﬂ if [ztrcrnp(bdrootges ] exphdadel])
‘}:%E elze
‘}E then




Adding Components to the Report Template

5 To move the else component under the then component, select the else
component and click the down arrow on the toolbar once. The Outline

pane on the left looks as follows.

EI‘Z Repart Generator
= £# Report - simulink_tutorial.rpt*

{ﬁ Title Page - Dynamic Simulink, B eport
El%%E if [ztremplbdroot{gcs). exptd odel]]
Gﬁﬂ then
0:%5 elze

6 Save the report template.

Displaying an Error When the
Opened

- B8 Eval - £The name of the model Zthat wil..

Model Cannot Be

If the if strcmp(bdroot(gcs), expModel)) component fails (the vdp model
cannot open), the else component executes. Display an error message in the

report using the Chapter/Subsection component.

1 In the Outline pane on the left, select the else component.

Elﬂ Report Generator
= 2# Repart - simulink_tutarial. rpt®

-8 Tile Page - <No Title>
-4 [true]

El%%ﬂ then
P 0:%5 todel Loop - Current model

448 Chapter - Section Title

- B8 Eval - 2E valuate this string in the bas...
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2-20

2 In the Options pane in the middle, under the Formatting category,
double-click Chapter/Subsection to add it as a child of the else
component. This component displays an error message if an error occurs
when opening the vdp model.

EIZ R eport Generator
= ¢ Report - simulink_tutorial ipt*
E Evwal - %The name of the model Zthat wil...
cﬁ Title Page - Dynamic Simulink. Beport
- 488 [stremplbdrootges) exphadel))
O,EE then
-4l else

258 Chapter - Section Title

Note When you add a component to a report, it is added by default
as a child component unless the selected component cannot have child
components.

3 In the Properties pane on the right, choose Custom from the Title selection
list, and then enter the following text in the text box:

Load Model Failed.

The Outline pane looks as follows.



Adding Components to the Report Template

=- ‘a Report Generator
= 22 Repart - simulink_tutarial.rpt
cﬁ Ewal - %The name of the model Zthat wil...
{}ﬁ Title Page - Dynamic Simulink. Report
=-448if [stremplbdroot(ges) exphadel])
ﬁﬂ then
EI*{'EE elze

- 48 Chapter - Load Model Failed.

4 In the Outline pane on the left, select the Chapter component.

5 In the Options pane in the middle, under Formatting, double-click
Paragraph.

6 In the Properties pane on the right, enter the following text in the
Paragraph Text text box to display the following error message:

Error: Model %<expModel> could not be opened.

The expression %<expModel> indicates that the value of the workspace

variable expModel is inserted into the text, as in the following example.

Error: Model vdp could not be opened.

The Outline pane on the left looks as follows.
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=- ‘}rﬂ Report Generator
= 2# Repart - simulink_tutarial.rpt
- @8 Eval - %The name of the model Zthat wil..
E Title Page - Dynamic Simulink, B eport
El?ﬁE if [ztrernplbdrootges ] exphd odel])
G,EE then
El‘%'.ﬁE elze
- 4#8 Chapter - Load Model Failed
48 Paragraph - Eror: Model %<exp

7 Save the report template.

Creating the Body of the Report

The report generation process performs several tasks to successfully open
the vdp model. Each action requires a separate component under the then
component.

Processing the Model with a Model Loop Component

The report changes the Gain parameter for the Mu block in the vdp model
several times. This task requires a Model Loop component.

1 In the Outline pane on the left, select the then component.

2 In the Options pane in the middle, scroll down to the Simulink category,
and then double-click Model Loop. It is added as a child of the then
component.



Adding Components to the Report Template

E% Report Generatar
E- f,?' Fepart - simulink_tukarial rpt

E Evwval - ZThe name of the model Zthat wil...

Qﬁ Title Page - Dynamic Simulink Repaort

El?ﬁE if [stremplbdroot(ges) esphd adel]]
E|<>.§E then
O,EE Maodel Loop - current model
El*ﬁE elze

. ¢#8 Chapter - Load Maodel Failed.

The Properties pane on the right looks as follows.

Model Loop
— Models to Include——— — Model Option
badels ta lnclude: v Active

Current block diagram todel name: I Current black diagram ;I

Traverse model: IAII spstems in model

Laook under masks: IFunctiu:unal rnazks anly

Fallaw ibrary links: IDD ot Fallow brary links

Jer [ x |« |+

uuuut

Starting system(s]: IMudeI roat

2 [ »]

Section Ophion

[~ Create section for each object in loop
[~ Dizplay the object lpe in the section tile

[~ Create link anchar for each object in loop

Fewert Help
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2 Creating Simulink® Reports

3 In the Properties pane on the right:
a Select the Active check box to process the vdp model.

b In the Traverse model selection list, select Selected system(s) only
to traverse only the vdp model.

¢ Select Model root from the Starting system(s) selection list.

d At the bottom of the Properties pane on the right, select the Create
section for each object in loop check box to create a chapter or section
for each model. When you select this check box, the component name in
the Outline pane on the left changes to Model Loop Chapter.

=- z/_ﬂ Report Generator
= 2% Repart - simulink_tutarial.rpt
‘}@ Ewal - ZThe name of the model Zthat wi...
E Title Page - Dynamic Simulink, Report
El%%E if [true)
E|<>§E then
?ﬁﬂ Model Loop Chapter - current model

¢§E elze

e Select the Display the object type in the section title check box to
include the object type (in this example, model) in the title name.

f Clear the Create link anchor for each object in loop check box.

4 Save the report template.

Adding a Paragraph for Each Model
In each Model Loop Chapter, add an explanation using the Paragraph
component.

1 In the Outline pane on the left, select the Model Loop Chapter component.

2 In the Options pane in the middle, scroll up to the Formatting category,
and then double-click Paragraph. The Paragraph component is added as
a child of the Model Loop Chapter component.
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EI“?J Repart Generator
=- ?,? Report - zimulink_tutarial rpt*
‘}ﬁ Eval - %The name of the model that wil ..
‘}ﬁ Title Page - Dynarmic Simulink, Report
E|°§H if [stremplbdroot(ges), exphdodel])
El%%ﬂ thien
EG,EE Model Loop Chapter - current model
ﬁﬂ Faragraph - <Mo Test:
El?ﬁﬂ elze
-8 Chapter - Load Model Failed,
ﬁﬂ Faragraph - Eror: Model Z<expidod...

3 In the Properties pane on the right, in the Paragraph Text text box, enter

the following text:

This report demonstrates Simulink Report Generator's ability
to experiment with Simulink systems and auto-document

the results. In this report, you load the model %<expModel>
and simulate it %<length> times. This report modifies the
%<expBlock> block's "%<expParam>" value, setting it to the
values %<expValue>. Each iteration of the test includes

a set of scope snapsnots in the report.

When this report is generated, the variable names preceded by percent
signs (%) and enclosed in brackets (<>) are replaced with the values of those

variables in the MATLAB workspace.

4 Save the report template.

Inserting a Snapshot of the Model into the Report
Inside each Model Loop Chapter component, include a snapshot of the

current model using the System Snapshot component.

1 In the Outline pane on the left, select the Model Loop Chapter component.

2 In the Options pane in the middle, scroll down to the Simulink category,
and then double-click the System Snapshot component.
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2-26

This component inserts an image of the current model into your report.
The Properties pane on the right looks as follows.

Syztem Snapshot

— Snapshot
Image file format: | FENE ==y MYl =)
Paper arientation: I Partrait ;I
Image size: I Automatic ;I I[? 9] Inches ;I

[T Usze printframe Irptdefaultframe.fig

—Digplay Options
Scaling: I |lze image zize ;I |1 a0

i

Size:  [[79] Inches x|
Alignment; I Auto j
Title: I Mone LI Mo title

Caption: I MHaone ;I Ma caption

3 In the Properties pane on the right:
a Select Zoom from the Scaling selection list.

b Enter 70 as the % value.
4 In the Outline pane on the left, select the System Snapshot component.

5 Click the down arrow on the toolbar once to move it under the Paragraph
component.

El?,ﬁE Model Loop Chapter - current rodel
ﬁﬂ Paragraph - This report demonstra...
E System Snapshat

6 Save the report template.



Adding Components to the Report Template

Adding a Loop for Processing the Model

Create a loop to process the model %length times using the For Loop
component.

1 In the Outline pane on the left, select the System Snapshot component.

2 In the Options pane in the middle, under the Logical and Flow Control
category, double-click For Loop. The For Loop component is added as a
sibling of the System Snapshot component.

E’Z Feport Generator
= f,? Repart - simulink_tutorial rpt
{}ﬁ Ewval - %The name of the model Zthat wil...
E Title Page - Dynamic Simulink. Repart
=488 [stremp{bdroot(ges) exph adel))
EI<>§E then
; El?,ﬁEl todel Loop Chapter - current rmodel
ﬁﬂ Faragraph - This repart demonstra...
‘}ﬁ Syztem Snapzhot
“gff for RPTGEN_LOOP = 1:1:5
Elc':ﬁE elze
E1-448 Chapter - Load Model Failed.
48 Paragraph - Error: Model %<expMod...

3 In the Properties pane on the right:
a In the End text box, replace the existing text with the following text:

length(expValue)

expValue is the array of Gain parameter values assigned in the Eval
component with the command expValue=[-1 0 0.5 1 2];. The
expression length(expValue) evaluates to 5 in this example.

b In the Variable name text box, replace the existing text with the name
of the for loop variable. Enter the following text:

expIteration
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2 Creating Simulink® Reports

The name of the For component in the Outline pane on the left changes
to reflect the loop variable and the termination value.

=" ‘}rﬂ Repart Generator
=2 é? Repart - zinmulink_tutonal rpk*
c‘ﬁ Ewal - T he name of the model Zthat wil...
E Title Page - Dynamic Simulink, B epart
=488 [stremp{bdroot{ges).exptodel])
El‘iiﬁla then
E|<>§E todel Loop Chapter - current model
9.35 Faragraph - This report demonstra...
_ ﬁ Sygtem Snapzhot
G.EE for explteration = 1:7:lengthlexpt’alue]
El‘r:ﬁE elze
- 438 Chapter - Load Model Failed
448 Paragraph - Error: Model %<exphad...

4 Save the report template.

Getting the Gain Parameter Value from the expValue Array

For each iteration, get a value from the expValue array to use as the Gain
parameter value. This task requires an Evaluate MATLAB Expression

component.
1 In the Outline pane on the left, select the for component.

2 In the Options pane in the middle, under the MATLAB category, double-click
Evaluate MATLAB Expression. In the Outline pane, the component name

is shortened to Eval.
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EIZ Report Generator
= £# Report - simulink_tutorial.rpt*
{ﬁ Ewal - %The name of the model Zthat wil...
Qﬁ Title Page - Dynarnic Sirmulink. Report
=1~ 488if [stremplbdroatges)exphadel])
EI@ then
El‘f'.ﬁE b odel Loop Chapter - curent model
?EE Paragraph - Thiz report demonstra. .
#ll System Shapshat
El?ﬁE for explteration = 1:1:lengthlexpy alue]
‘' Eval - %E valuate thiz stiing in the baz...

3 On the Properties pane on the right:

a Clear the Insert MATLAB expression in report and Display
command window output in report check boxes.

b Enter the following text in the Expression to evaluate in the base

workspace text box:

%sEvaluate this string in the base workspace

if iscell(expValue)
Iteration_Value=expValue{expIteration};

else
Iteration_Value=...
num2str(expValue(expIteration));

end

The Iteration Value variable represents the designated array element.

¢ Clear the Evaluate expression if there is an error check box.

4 Save the report template.

Creating a Section for Each Iteration
Create a separate section for each iteration of the loop that includes the data

using the Chapter/Subsection component.
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2 Creating Simulink® Reports

1 In the Outline pane on the left, select the Eval component.

2 In the Options pane in the middle, under the Formatting category,
double-click the Chapter/Subsection component to add it as a sibling.
This component is automatically added as Section 1 because it is inside a
Chapter component (the Model Loop Chapter component).

EI‘Z Report Generator
= £# Repart - simulink_tutarial rpt
cﬁ Eval - %The name of the model Zthat wil...
H Title Page - Dynamic Simulink Beport
EI<>§E if [stremp(bdroot{ges). exph adel])
=-4§8then
EI<>§E Model Loop Chapter - current model
ﬁﬂ Paragraph - Thiz report demaonstra...
E Syzterm Snapzhot
-5 for explteration = 1:1:length(exp' alue)
cﬁ Ewval - ZEwaluate this string in the bas.
“ 548 Section 1 - Section Title

IEI?EE elze
- 448 Chapter - Load Model Failed.
ﬁﬂ Faragraph - Emor: Model Z<exphod...

3 In the Properties pane on the right:
a In the Title selection list, select Custom.

b In the text box, enter the following title:

Processing the vdp model

This indicates that the section title comes from the first child component.
Do not change any other properties.

4 Save the report template.
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Inserting the Gain Value into the Report
Insert the Gain value that is used for each simulation.

1 In the Outline pane on the left, select the Section 1 component.

2 In the Options pane in the middle, under the MATLAB category, double-click
Insert Variable.

3 In the Properties pane on the right:
a In the Variable name text box, enter Iteration_Value.
b In the Display as selection list, select Paragraph.
The Outline pane on the left looks as follows.

Inzert Y¥anable

— Source

W ariable narme: IIteratin:nn_VaIue

" ariable location: IEase work space j

Warhing: "lteration_Yalue" nat found in warkzpace.

— Dizplay Option

Title: I.-’-'-.utu::matiu: ;I I
Size limit |32

Dizplay as: IF'aragraph j

™ lgnore if walue is empty

Revert Help

4 Save the report template.
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2-32

Setting the Gain Parameter
For each iteration, set the Gain parameter to the value you extracted from the
expValue array.

1 In the Outline pane on the left, select the Variable component.

2 In the Options pane in the middle, under the MATLAB category, double-click

Evaluate MATLAB Expression. This component is added as a sibling of
the Variable component.

= Q,EE Section 1 - Processing the wdp model
ﬁ “arable - lteration_Yalue
‘88 Ewal - ZEwaluate this zhring in the bas. ..

3 In the Properties pane on the right, clear the Insert MATLAB expression

in report and Display command window output in report check
boxes.

4 In the Expression to evaluate in the base workspace text box, replace
the existing text with the following text.

set_param(expBlock,expParam,Iteration_Value);
okSetValue=(1);

The set_param command sets the value of the Gain parameter for the Mu
block in the vdp model to the value of Iteration_Value.

5 Make sure you select Evaluate expression if there is an error. Enter
the following text into the text box:

okSetValue=logical(0);

If the set_param command works, okSetValue is set to 1. If an error
occurs, okSetValue is set to 0. The next component then reports the error
and terminates processing.

6 Save the report template.

The Outline pane on the left looks as follows.
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EI‘Z Report Generatar
= % Report - simulink_tutorial ipt
Qﬁ Ewal - %The name of the model Zthat wil...
{ﬁ Title Page - Dynamic Simulink Report
E|<>§E if [strermp(bdroot(ges) exphd aded]]
=458 then
Elﬁ.ﬁﬂ kodel Loop Chapter - curent model
0:%3 Paragraph - Thiz report demonztra...
: HH System Snapshot
E|<>§E for explteration = 1:1:length(expYalue)
‘}ﬁ Evwal - %E waluate thiz ztring in the bas...
=448 Section 1 - Processing the wdp modsl
ﬁ Yariable - Iteration_Walue
Lt Eval - zet_param[expBlock expParam,lter. ..

Checking okSetValue

Check the value of okSetValue using a Logical If component. If the value is
0, the simulation cannot proceed because the Gain parameter could not be set.

1 In the Outline pane on the left, select the Eval component for the
set_param command.

2 In the Options pane in the middle, under the Logical and Flow Control
category, double-click Logical If. The component is added as a sibling
of Eval.

Elﬁﬂ Section 1 - Proceszsing the wdp model
H Wariable - [teration_alue
oﬁ Ewal - set_param{expBlock, expPararn |ter...

|

3 In the Properties pane on the right, in the Test expression text box,
replace true with okSetValue.
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okSetValue can be 1 (true) or 0 (false), so insert two components—Logical
Then and Logical Else—to process those conditions:

1 In the Outline pane on the left, select the if (okSetValue) component.

2 To insert Logical Then and Logical Else in the correct order:

a In the Options pane in the middle, double-click the Logical Else
component.

b Select the if (okSetValue) component again.

¢ Double-click the Logical Then component. The Outline pane on the
left looks as follows.

=- ‘Z Report Generator
= ‘ff,? Repart - simulink_tutorial. rpt
c‘ﬁ Eval - %The name of the model Zthat wil...
{}ﬁ Title Page - Dynamic Simulink Report
- 4481 [stremplbdroot(ges) exphdodel])
=48 then
E|°§E kodel Loop Chapter - current model
qﬁﬂ Paragraph - This report demonstra...
E Systern Snapzhot
- 458 for explteration = 1:1:lengthlexpialue)
E Ewal - ZEwaluate thiz ztring in the basz...
E|<>,§E Section 1 - Processing the wdp madel
-l Variable - Iteration_Yalue
Gﬁ Eval - zet_param|expBlock, expParam lter...
=458 i [okSetvalue)
?ﬁﬂ ther
¢,§E elze

3 In the Outline pane on the right, select the else component.

4 In the Options pane in the middle, double-click Paragraph.
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If okSetValue = 0, the Gain parameter value is not set and the report
displays an error.
5 In the Properties pane on the right:
a Choose Custom title from the Title Options selection list.
b Enter Error in the text box next to the selection list.

¢ Enter the following text into the Paragraph Text text box:

Could not set %<expBlock> "%<expParam>" to value
%s<Iteration_Value>.

6 Save the report.

Simulating the Model, and Capturing the Scope and Data
Now that the model is open and the Gain parameter is set, use the Model
Simulation component to simulate the vdp model.
1 In the Outline pane on the left, select the then component under the if
(okSetValue) component.

2 In the Options pane, under the Simulink category, double-click Model
Simulation. In the Outline pane on the left, this component is renamed

Simulate model.
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=- ?J Report Gererator
=p g,? Report - simulink_tutorial. rpt
‘}ﬁ Evwal - ZThe name of the model Zthat wil...
‘}ﬁ Title Page - Dynarmic Simulink. B epaort
=488 [stremp(bdroot(ges] exptadsl])
EI?EE then
El‘fﬁﬂ Model Loop Chapter - current model
<>§E Paragraph - Thiz report demonstra. .
‘}ﬁ Systemn Snapshot
=58 for explteration = 1:1:lengthlexpialue)
ﬁ Ewal - ZEvaluate thiz string in the bas. .
=448 Section 1 - Processing the vdp model
‘}ﬁ Wariable - [teration_ W alue
ﬁ Ewval - zet_param(expElock, expParam,ter...
-4 iF [okSetv'alue)
El?ﬁE then
.- Simulate madel - use model start/end time
-l else

0,35 Paragraph - Could not zet Z<expBl...

EI?EE elze
- 448 Chapter - Load Model Failed,
Gﬁﬂ Paragraph - Eror: Model Z<exphdod...

3 In the Properties pane on the right:
a Clear the Use model’s workspace I/O variable names check box.
b In the Time text box, enter dynamicT.
¢ In the States text box, enter dynamicX.

d In the Output text box, enter dynamicy.
The Properties pane on the right looks as follows.
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Model Simulation
— /0 Parameters

[ Use model's workspace /0 variable names

Tirne: I dvnamicT

States: I dynamici

Qutput; I dynamic’y’

— Timespan

¥ Use model's timespan values

Start; I ]

Shop: I B0

— Simulation Optionz

[™ Compile model before simulation

Simulation Parameters:

Simulation statuz messages: I Digplay to command line

R ewvert Help

4 In the Outline pane on the left, select the Simulate model component.

5 In the Options pane in the middle:

a Scroll down to the Simulink Blocks category.

b Double-click Scope Snapshot to add it as a sibling of the Simulink

Model component.
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This component captures the scope for each iteration.

= #£| Report Generator
B f,?' Fepart - simulink_tutarial rpt
E Eval - ZThe name of the model Zthat wil...
‘}ﬁ Title Page - Dynamic Simulink Report
E|<>,§E if [gtremplbdroot[ges) exphdodel)]
EIGE then
EI".;%E Model Loop Chapter - current rmoded
GE FParagraph - Thiz repart demonstra. .
Qﬁ Syztem Snapshot
E|<>§E for explteration = 1:71:length[expy alue)
b 8 Eval - ZEvaluate this sting in the bas...
E|<>,§E Section 1 - Proceszsing the wdp model
i B8 Wariable - Iteration_Walue
HB Eval - zet_param|expBlock expParam lter...
=488 (okSetvalus)
Elvﬁﬂ then

E Simulate model - use model start/end tirme

Qﬁ Scope Snapshot - All =Y graph & open zcope blocks in reported zpztems of curent model

6 In the Properties pane on the right:
a In the Paper orientation selection list, select Portrait.
b For the Image size, enter [5 4].
¢ In the Scaling selection list, select Zoom.

d Enter 75 for the % value.
7 Save the report template.

8 To test to see if the signal data falls within a specified range, add another
Logical If component:

a In the Outline pane on the left, select the Scope Snapshot component.

b In the Options pane in the middle, scroll up to the Logical and Flow
Control category.

¢ Double-click the Logical If component.
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9 To test the signal data, replace true in the Test expression text box with
the following in the Properties pane on the right:

max (dynamicX(:,2))>testMin & max(dynamicX(:,2))

10 Save the report.

The Outline pane looks as follows:

=- ?J Report Generator

=2 é? Feport - simulink_tutorial.rpt
b Eval - ZThe name of the mads! Zthat wil ..
Qﬁ Title Page - Dynamic Simulink. Report
E|<>,§E if [stremplbdroot(gos)esphd adel]]

I_——_I?EE then

|';'|<>,§E elze

- 448 Chapter - Load Madel Failed,
0,35 Paragraph - Errar: Model Z<exphod..

El‘ﬁEI Model Loop Chapter - curent model
0,35 Paragraph - Thiz report demonstra. ..
{}ﬂ Syztem Snapshat
Elv,ﬁﬂ for explteration = 1:7:length(expt alue)
E Ewal - ZEvaluate thiz zting in the bas...
- 448 5ection 1 - Processing the vdp madel

ﬁ ariable - lkeration_\alue
ﬁ Ewal - zet_param[expBlock exspParam lter...
=488 (okSetvalus)
El%%ﬁ then
ﬁ Simulate model - use model start/end time
ﬁ Scope Snapshot - All =Y graph & open zcope blocks in reported systems of current model
O,EE if [rnax(dynammick]:, 2]]: testtin &amp; max{dynamic[;.2]]]
E-4felse

0,35 Faragraph - Could not zet %<expBl. .

11 If this condition is true, the signal data falls within the desired range.

Add a Paragraph component to print information about the signal data
in the report.

a In the Outline pane on the left, select the if component you just added.
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2-40

b In the Options pane in the middle, under the Formatting category,
double-click Paragraph so that it becomes a child of the if component.

=1- 442 [man{dynamick[: 2]]> testMin famp; max{dynamic[: 2]
458 Paragraph - <Mo Tests

¢ In the Properties pane on the right:
i From the Title Options selection list, select Custom title.
ii Type Success in the text box.

iii Enter the following text in the Paragraph text text box.

The conditioned signal has a maximum value
of %<max(dynamicX(:,2))>, which lies in the
desired range of greater than %<testMin> and
less than %<testMax>.

12 To save the success values to insert into a table at the end of the iterations,
use an Evaluate MATLAB Expression component.

a In the Outline pane on the left, select the Paragraph component.

b In the Options pane in the middle, under the MATLAB category,
double-click Evaluate MATLAB Expression.

An unintended result occurs: the new component is a child of the
Paragraph component.

El%%ﬂ if [mas(dwnarnick[: 211 testhdin & mas{dynamick[:.2]1)
EMEE Paragraph - The conditioned signa...
L H Eval - ZEvaluate this gtring in the bas...

¢ To make the new component a sibling of the Paragraph component, in
the Outline pane on the left, select the Eval component, and then Click
the left arrow on the toolbar. The Eval component becomes a sibling of
the Paragraph component.

Eleﬁﬂ if [rax{dwnamics[; 2])=testhin & max{dynamick].2]])
ﬁﬂ Faragraph - The conditioned sigha...
B :52| Eval - ZE valuate this string in the bas...
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13 In the Properties pane on the right, for the Eval component:

a Clear the Insert MATLAB expression in report and Display
command window output in report check boxes.

b In the Expression to evaluate in the base workspace text box, enter
the following to save the desired signal values in the expOkValues array:

expOkValues=[expOkValues;...
{Iteration_Value,max(dynamicX(:,2))}1;

¢ Make sure you select Evaluate this expression if there is an error.
Insert the following text in the text box:

disp([ 'Error during eval: ', lasterr])

14 Save the report template.

Creating the Post-Test Analysis Section

Now that you have collected all the desired values, create the post-test
analysis section by creating a table and inserting it into your report at the
end of this chapter.

1 In the Outline pane on the left, select the Model Loop Chapter component.
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Elﬁﬂ elze

2-42

EI?J FRepart Generatar
= f/f’ Repart - simulink_tutarial.rpt
ﬁ Ewal - £The name of the model Zthat wil...
{ﬁ Title Fage - Dynamic Simulink. Report
E|<>,§E if [stromp(bdroot[ges) .exphd adel]]
Elﬁﬂ then
EQ,EE todel Loop Chapter - cumrent model
?ﬁﬁ Paragraph - This report demonstra...
‘}ﬁ Syztem Snapshot
El?ﬁﬁ for explteration = 1:1:lengthlespt alue]

b B8 Eval - ZEvaluate this string in the bas...
El‘ﬁEI Section 1 - Procezsing the wdp model
E Wariable - [teration_'alue
‘}ﬁ Ewal - set_param|expElack.expParam.lter...
- 438 [okSetvalug]
=458 then
E b B Simulate model - Lze model start/end time
‘ﬁ Scope Snapshot - Al XY graph & open scope blocks in reported systems of curent modal
E1-452F [maxldynamicsl: 2))xtesthdin &amp; maxddvnamickl.2])]
: olﬁﬂ Paragraph - The conditioned signa...
A Eval - expOkY alues=[expOkalues;. .

E|¢§E elze

0,35 Faragraph - Could not zet Z<expBl...

=458 Chapter - Load Madel Failed.
?ﬁﬁ Paragraph - Error: Model Z<esphod...

2 In the Options pane in the middle, under the Formatting category,
double-click Chapter/Subsection.

The new section appears at the beginning of the chapter.
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E?J Report Generator
B- %? Feport - simulink_tutonial rpt*
ﬁ Ewal - ZThe name aof the model Zthat wil...

ﬁ Title Page - Dynamic Simulink, Repart

Eloﬁﬁ if [ztremplbdroot(gos) exphd adel]]

I_'—_lﬁ then
E|<>,§E Model Loop Chapter - current model
O,EE Section 1 - Sechon Title
ﬁﬂ Faragraph - Thiz report demonstra..
{ﬁ System Snapzhot
E=1- 458 far explteration = 1:1:lengthlexpy alus]
ﬁ Ewal - ZEwvaluate thiz zting in the baz...
ElﬁE Section 1 - Processing the wdp model
Qﬁ Yariable - lteration_alue
0@ Evwal - zet_param[exspBlock, expParam lter...
=488 (okSetvalus)
El?ﬁﬁ then
ﬁ Simulate model - usge model start/end time
0@ Scope Snapzhot - Al graph & open scope blocks in reported zvstems of curent model
El?ﬁﬁ if [rnax(dynarnic]:, 2] testtin &amp; maxdynamick[;.2]])
ﬁ Paragraph - The conditioned signa...
0@ Eval - explkValuez={esp0kvalues;...
Eﬁﬂ elze

O,EE Paragraph - Could not get %<expBl...

EIGEE elze
=488 Chapter - Load Madel Failed.
0,35 Faragraph - Eror: Model *<esphod...

Click the down arrow three times so Section 1 moves to the end of the

Model Loop Chapter component.
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EIZ Report Generator
=8 %? Repart - simulink_tutaral rpt
Qﬁ Eval - %The name of the model Zthat wil ..
‘ﬁ Title Page - Dynamic Sirmulink Report
El?ﬁE if [stremplbdroat{gcs) exphd adel]]
E|<>§E then
EI<>§E Model Loop Chapter - cument model
<>§E FParagraph - Thiz repart demonstra...
- H Syztem Snapshot
=488 for explteration = 1:1:lengthlzxpy alus]
ﬁ Ewal - ZEvaluate this string in the bas...
=-4#85ection 1 - Processing the vdp model
L H Variable - Iteration_alue
A Eval - zet_param|expBlock expParam lter...
= 483 (okS et/ alus)
=58 then
: E Simulate model - use model start/end time:

‘}ﬁ Scaope Snapshot - Al =Y graph & open scope blocks in reparted systems of curent modsl
El@%ﬂ if [mas[dynamics[:, 2]) testin famp; maxdynammics]: 2])]
OIEE Paragraph - The conditioned zigna...
‘- HH Eval - explkY alues=[emp0kiValues;. ..
E|¢§E elze
O,EE Faragraph - Could not zet Z<expBl...
<>§E Section 1 - Section Title
I';'IﬁH el
=448 Chapter - Load Model Failed.
<>§E Paragraph - Error; Model Z<exphdod. ..

3 In the Properties pane on the right:
a Select Custom in the Title selection list.

b Enter Post-Test Analysis in the text box.
4 In the Outline pane on the left, select the new Section 1 component.

5 In the Options pane in the middle, under the Formatting category,
double-click Paragraph. Do not change its properties.
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6 To check whether there are any signal values within the desired
range, check the array expOkValues with a Logical If component. If
expOkValues is empty, there are no signal values in the desired range.
Report the result of this check.

a In the Outline pane on the left, select the Paragraph component and
add a Logical If child component.

b In the Properties pane on the right, enter the expression to evaluate
in the Test expression text box:

~isempty(expOkValues)
This expression evaluates to 0 (false) if expOkValues is empty;
otherwise, it evaluates to 1 (true).

¢ In the Outline pane on the left, select the if (~isempty (expOkValue))
component and add the Logical Else component as a child.

d Select the if (~isempty (expOkValue)) component again and add the
Logical Then component as a child.

The two components are siblings in the Outline pane on the left.

=448 Section 1 - Post-Test Analyziz
= 488 Paragraph - <Test from childrens
=458 [~isemphy(expOky alues))
Q_E%E ther
Q_E%E elze

7 Save the report template.

8 Now, insert report components to handle the case where expOkValues is
empty; that is, where no signal values fall within the designated range.

a In the Outline pane on the left, select the else component.

b In the Options pane in the middle, double-click the Text component to
add it as a child of the else component.

¢ In the Properties pane on the right, in the Text to include in report
text box, enter the following:

None of the selected iteration values had
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a maximum signal value between %<testMin> and %<testMax>.

9 Now handle the case where expOkValues is not empty and you want to
insert a table of the acceptable signal values.

a In the Outline pane on the left, select the then component.
b Add a Text component as a child to the then component.

¢ In the Properties pane on the right, in the Text to include in report
text box, enter the following text.

%<size(expOkValues, 1)> values for %<expBlock> were

found that resulted in a maximum signal value greater

than %<testMin> but less than %<testMax>. The following
table shows those values and their resulting signal maximum.

d In the Outline pane on the left, select the Text component under the
then component of the if (~isempty (expOkValues) component.

10 To create an array for use when formatting the table, use the Evaluate
MATLAB Expression component.

a In the Options pane in the middle, double-click Evaluate MATLAB
Expression.

b In the Properties pane on the right:

i Clear the Insert MATLAB expression in report and Display
command window output in report check boxes.

ii The next component of the report uses the strings Mu Value and
Signal Maximum as table header values. Add the strings to the front
of the expOkValues cell array by entering the following text into the
Expression to evaluate in the base workspace text box:

expOkvValues=[{'Mu Value', 'Signal Maximum'} expOkValues];

iii Make sure you select the Evaluate this expression if there is an
error check box. Enter the following text into the text box:

disp([ 'Error during eval: ', lasterr])
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11 In the Outline pane on the left, select the Eval component.

12 In the Options pane in the middle, under the Formatting category,
double-click the Table component so it becomes a sibling of the Text and
Eval components.

- ﬁﬂ if [Tizempty[expOkh alues]]
—Oﬁﬂ ther
o H Tt - ZozizelenpOky alues, 1.

HH Eval - explkY alues=[{'Mu Value' 'Signal...
ol Table - <nio variable zpecified:

13 In the Properties pane on the right:

a In the Workspace variable name text box, enter expOkValues. The
Simulink Report Generator software uses the contents of expOkvalues
to construct the table.

b In the Table title text box, enter Valid Iteration Values.
14 Save the report template.

The Outline pane on the left looks as follows.

2-47



2 Creating Simulink® Reports

2-48

E- ?J Feport Generator

B Zj? Fiepart - zimulink_tutorial.rpt*
Oﬁ Ewal - %The name of the model Zthat wil...
°ﬁ Title Page - Dynamic Simulink. A eport
EI<>,§E if [stremplbdroot{ges) esptModel])

ElfiﬁE then

I':'I<>.§E elee

Eﬁﬂ Model Loop Chapter - current miodel

<=§ﬂ Faraagraph - Thiz repart demonstra...
- Systemn Snapshat

[—]<=§E for explteration = 1:1:lengthlexplf alue]

ﬁ Eval - ZE valuate thig string in the bas...
E-4#85 ection 1 - Processing the wdp model
ﬁ Yariable - lteration_alue
H Eval - zet_param[expBlock, expParam lter. ..
- 45B [okS et alue)
Eléﬁﬁ then
i oﬁ Simulate model - uze model start/znd time
Qﬁ Scope Snapshot - Al graph & open scope blocks in reported systems of current model
=482 [man(dpnamic<]:, 2])> testtin &amp; max(dynamic]; 2]]]
Oﬁﬂ Paragraph - The conditioned zigna...
-t Eval - expOky alues=[expOkV alues;. .
Eﬁﬂ elze

Gﬁﬂ Paragraph - Could not set %<expBl...

|'_—'|<=§E Section 1 - Pozt-Test Analysiz

E|€>§E Faragraph - <Text fram children:
E{éﬁ if [~izempty[expOkyalues])
EI{&E then
‘}@ Teut - Zzizelenplkitalues, 1.
‘}@ Eval - expOkY alues=[{Mu alue','Signal ..
‘}ﬁ Table - explkiy alues
Eléﬁﬁ elze

L Text - Mone of the selected

()-488 Chapter - Load Model Failed.
ﬁﬂ Faragraph - Error: Model Z<expbdod...
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Generating the Report

Now the report includes all required components. To generate the report, click
the Report icon on the toolbar. The following occurs:

1 A Message List window appears, displaying informational and error
messages as the report is processed. Specify the level of detail you would
like the Message List window to display while the report is being generated.
Options range from 0 (least detail) to 6(most detail). Click the selection
list located under the title bar of the Message List window to choose an
option, as shown in the following figure.

A Message List =10l x|
3 Important messages (running a laop) ;I

03 Mo messages

17 Error messages only

23 Warning messages

3 Imporkant messages (running a loop)

43 Standard messages (running a component)
53 Low-level messages (skakus infarmation

&) all messages

Message level 3 (Important messages) is used for the remainder of
this example.
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Hmessage List M=l E3

Beqginning repork

Looping on model "wdp”

Running FOR. loop, explteration = 1
Running FOR, loop, explteration = 2
Rurning FOR, loop, explteration = 3
Running FOR, loop, explteration = ¢
Running FOR loop, explteration =5
Converting repork

Report complete

2 The vdp model appears. You can see each time it is simulated.

3 The scope window appears. The scope graph changes each time the
parameter value changes.

4 Each component of the report is highlighted as it executes, in the Outline
pane on the left in the Report Explorer window.

When the report is complete, Adobe® Acrobat® Reader opens your report in
PDF format.
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¥R Adobe Acrobat Professional - [simulink_tutorial.pdf] -0l x|
'BHE Edit View Document Comments Tools Advanced Window Help == x|

P HRE & B W o (S 0i- @ S5
) Irsoe @@ f& - || 4 @ - @ |iD}iwi@
1 EE B+ optons~ x

[3% Dynamic Simulink Report =
@ Table of Contents
#H[% Chapter 1. Model - vdp

Dynamic Simulink Report

Using Report Generator to Document
Changes

John Q. Engineer

Y

ﬁ- comments " _Atiachments [ ModelTree ff Pages | signatures i Bookmarks “_|

[ 4 oo Tp M@ O JUH H

Ll
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Setting Report Output Options
(p. 3-2)

Converting XML Documents (p. 3-11)
Creating Log Files (p. 3-14)
Generating M-Code from Report

Templates (p. 3-15)

Working with Legacy Report
Templates (p. 3-18)

Troubleshooting (p. 3-20)

How to set options for generated
reports

How to convert XML source files to
generate a given report in a different
format

How to create log files for report
generation

How to generate M-code versions of
report templates

How to work with report templates
created in previous versions of the

MATLAB® Report Generator™
product

How to troubleshoot
report-generation issues
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Setting Report Output Options

In this section...

“Setting Preferences” on page 3-2

“Setting the Report File Directory” on page 3-3

“Setting the Report File Name” on page 3-4

“Setting the Report Format” on page 3-4

“Viewing and Printing Reports” on page 3-8

“Converting English Strings to Other Languages” on page 3-9
“Autosaving Report Templates” on page 3-9

“Regenerating Images” on page 3-9

“Including a Report Description” on page 3-9

Setting Preferences

Specify report output settings using the Preferences pane. To open this
pane, click File > Preferences. A list of available options appears in the
following table.

Option Purpose

Format ID Specify the report output format. Choices
include Acrobat (PDF), Rich Text format,
and Word document. The default is Web (HTML).

Extension Automatically sets the file extension of the
report file according to the value specified for
Format ID. The default is html.

Simulink Images Specify the format for Simulink® images to
include in the report. The default is PNG 24-bit
image.

Stateflow Images Specify the format for Stateflow® charts to
include in the report. The default is PNG 24-bit
image.
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Option

Purpose

HG Images

Specify the format for Handle Graphics® images
to include in the report. The default is PNG
24-bit image.

View command

Specify the MATLAB® command you want to
use to view the report.

Visible in Report
Explorer

Deselect this check box to make the current
output format unavailable in the Report
Explorer Interface. For example, if your
specified report format is Word document and
you deselect this check box, then the Microsoft®
Word document format is no longer available for
reports created using the Report Explorer.

Use version 1.x
environment

Choose this option to use previous versions of
MATLAB® Report Generator™ and Simulink®
Report Generator™ interfaces. For more
information, see “Using Legacy Interfaces” on
page 3-19.

Animate Report
Explorer when
generating reports

Select this check box if you want components in
the Outline pane to be animated as the report
generates. This box is selected by default.

Setting the Report File Directory

Choose a directory to which you have write privileges, to store the report file.
A list of options appears in the following table.

Directory

Option

The same directory as
the report template

Same as report template

The current working
directory

Present working directory

Temporary directory

Temporary directory

Another directory

custom. Use the Browse button (...) to select
from a list of directories.
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You can use %<VariableName> notation to specify a directory in the Custom
text box. For more information, see “% Notation” on the Text component
reference page in the MATLAB Report Generator documentation.

Setting the Report File Name

Images are placed in a directory with the same name as the report file.
For example, testreport.html images are placed in a directory named
testreport_files.

Choose a file name for the report file, using the options listed in the following
table.

File Name Option

The same file name as the Same as report template (default)
report template

A file name different from the | Custom. Enter the name of the report.
report template name

Use %<VariableName> notation to specify a file name in the Custom text box.
For more information, see “% Notation” on the Text component reference page
in the MATLAB Report Generator documentation.

Setting the Report Format

Choose the report output format in the File format text box. For example, if
you want to use Microsoft Word, choose Word document or Rich Text Format.

—Repart Format and Styleshest

File f-:urmat:l Rich Text Farmat ;I I Wery Large Type Print ;I

—Eeneration Options

[+ iew repart after generation

[T Auto save before generation

Evaluate thiz string after generation;
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Each output format has a default stylesheet associated with it. Specify the
stylesheet in the text box next to the File format text box.

The following table shows which output format to use with different software,
and which stylesheets you can use with each output format.

Viewer Format Description Stylesheets
Adobe® Adobe Acrobat | Produces a PDF | PDF (see “PDF
Acrobat® (PDF) that you can Stylesheets” on page
Reader view using Adobe | 3-5)
Acrobat Reader
software
Web browser | Web (HTML) Use for Web (see “Web
(default) publishing on Stylesheets” on page
the World Wide | 3-7)
Web
Word Rich Text Compatible Print (see “RTF
processor Format (RTF) | with most (DSSSL Print) and
or Word word-processing | Word Stylesheets” on
Document packages, page 3-8)
including
Microsoft Word
software
DocBook DocBook Produces a N/A
(XML) report in
DocBook format

Tip To create and use customized styles, see “Creating Custom Stylesheets”.

PDF Stylesheets

PDF Stylesheet

Description

Standard Print

Displays title page, table of contents, list of titles
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PDF Stylesheet

Description

Simple Print

Suppresses title page, table of contents, list of
titles

Compact Simple Print

Minimizes page count, suppresses title, table of
contents, list of titles

Large Type Print

Uses 12-point font (slightly larger than
Standard Print)

Very Large Type Print

Uses 24-point font and landscape paper
orientation

Compact Print

Minimizes white space to reduce page count

Unnumbered Chapters &
Sections

Chapters and sections are not numbered

Numbered Chapters &
Sections

Chapters and sections are both numbered

Paginated Sections

Sections are printed with page breaks

Custom Header

Lets you specify custom headers and footers

Custom Titlepage

Lets you specify custom title page content and
presentation

Logo stylesheet for
PDF

Lets you specify a logo, such as your company
logo, in the header

Verbose Print

Lets you specify advanced print options
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Web Stylesheets

Web Stylesheet

Description

Default HTML

HTML on a single page

stylesheet
Simulink book HTML HTML on multiple pages; suppresses chapter
stylesheet headings and table of contents

Truth Table HTML
stylesheet

HTML on multiple pages; suppresses chapter
headings and table of contents

Multi-page Web

HTML, with each chapter on a separate page

Single-page Web

HTML on a single page

Single-page
Unnumbered Chapters &
Sections

HTML on a single page; chapters and sections
are not numbered

Single-page Numbered
Chapters & Sections

HTML on a single page; chapters and sections
are numbered

Single-page Simple

HTML on a single page; suppresses title page
and table of contents

Multi-page Simple

HTML on multiple pages; suppresses title page
and table of contents

Multi-page Unnumbered
Chapters & Sections

HTML on multiple pages; chapters and sections
are not numbered.

Multi-page Numbered
Chapters & Sections

HTML on multiple pages; chapters and sections
are numbered
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RTF (DSSSL Print) and Word Stylesheets

RTF or Word Stylesheet

Description

Standard Print

Displays title page, table of contents, list of titles

Simple Print

Suppresses title page, table of contents, list of
titles

Compact Simple Print

Minimizes page count, suppresses title, table of
contents, list of titles

Large Type Print

Uses 12-point font (slightly larger than
Standard Print)

Very Large Type Print

Uses 24-point font and landscape paper
orientation

Compact Print

Minimizes white space to reduce page count

Unnumbered Chapters &
Sections

Chapters and sections are not numbered

Numbered Chapters &
Sections

Chapters and sections are both numbered

Note Some Web and Print stylesheets include an automatically generated
list of titles. The list of titles includes a list of table titles and a list of figures

with titles.

Viewing and Printing Reports

To view your report after generation:

* To view the report automatically, select the View report after generation
check box in the Generation Options section in the Properties pane on
the right. When report generation is complete, the viewer associated with
the report output format displays the report.

® To view the report manually, browse to the location specified in the Report
File Location section in the Properties pane on the right, and open the file.

To print your report, select the Print option from the viewer.
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Converting English Strings to Other Languages

Versions 2.0 and later of the MATLAB Report Generator and Simulink Report
Generator software use the system language settings through the Sun™
Java™ interface; therefore, they should use the language specified on your
system.

Alternatively, you can change the language directly in Java from the MATLAB
command line. The following example sets the language to Italian:

java.util.Locale.setDefault(java.util.Locale.ITALY)
Alternatively, you can set the preferred language directly in your . rpt file:

1 Right-click the Report component and select Send to Workspace.

This displays the properties of the report, which are stored in the variable
ans. Access the report’s Language property from the command line through
this variable. By default, Language is auto, which indicates that the
system’s default language is in use.

2 Override the default value of Language by setting this property to your
desired language; for example, en for English or it for Italian.

Avutosaving Report Templates

To automatically save the report template before you generate a report, select
Auto save before generation from the Generation Options section of the
Properties pane on the right.

Regenerating Images

By default, the Regenerate Simulink and Stateflow Images option in the
Generation Options section of the Properties pane on the right is cleared.
As a result, previously generated images are not regenerated each time you
generate a report, so reports generate faster. If you make changes that affect
a generated image, select this option.

Including a Report Description

Use the Report Description field in the Properties pane on the right to
record notes and comments about your report template. This text appears in
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the Properties pane on the right when you select a report template in the
Outline pane on the left.
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Converting XML Documents

In this section...
“Why Convert XML Documents?” on page 3-11

“Converting XML Documents Using the Report Explorer” on page 3-11
“Converting XML Documents Using the Command Line” on page 3-13
“Editing XML Source Files” on page 3-13

Why Convert XML Documents?

You can generate a report in a different output file format without
regenerating it by using either the Report Explorer File Converter or the
rptconvert command. These utilities convert DocBook XML source files
created by the report-generation process into formatted documents such as
HTML, RTF, or PDF.

Note The report-generation process can only convert XML source files
created by the latest version of the software.

Converting XML Documents Using the Report
Explorer
To open the Convert Properties pane:

1 In the Report Explorer, select Tools > Convert source file.

The Convert Source File Properties pane appears. All XML files in your
current directory appear in the Options pane in the middle.
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Cotreert file |
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- 5% Report - Unnamed.rpt
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2 Select your XML source file using one of the following options:

¢ (Click Browse in the Properties pane on the right to browse to the
location of your XML source.

® Double-click a file name in the Options pane in the middle to
automatically enter it into the Source file field in the Properties pane.

3 Select your output format and stylesheet:
a In the File format text box, select an output format.

b In the Stylesheet text box, select a stylesheet. The stylesheet choice
depends on the specified output format. You can use a predefined or
customized stylesheet.

For more information about available formats and predefined stylesheets,
see “Setting the Report Format” on page 3-4.
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For more information about customizing stylesheets, see “Creating
Custom Stylesheets”.

4 Use the View Report when done converting check box to indicate
whether you want to view the report after it has conversion.

5 To begin the conversion, click Convert file.

Converting XML Documents Using the Command Line

To convert files using the command line, use the rptconvert function. For
more information, see the rptconvert reference page in the MATLAB®
Report Generator™ documentation.

Editing XML Source Files
Before you send a source file to the converter, edit it as text in the Report
Explorer:

1 In the Outline pane on the left, open the File Converter.

2 Right-click MATLAB Report Generator and select Convert source file.
3 In the Options pane in the middle, select the source file to edit.

4 In the Properties pane on the right, click Edit as text.

5 Use the MATLAB® Editor to edit and save the text.
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Creating Log Files

3-14

A log file describes a report template’s report-generation settings and
components. A log file can be used for many purposes, including:

® As a debugging tool

* As a reference to a report template

¢ To share information about a report template through e-mail
A log file includes the following information:

® Report template outline
¢ Components and their attributes
® Generation status messages currently displayed in the Generation

Status tab

To generate a log file, click File > Log File. An HTML version of the log file
with the name <report_template_file name_log>.html is saved in the
same directory as the report template.
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Generating M-Code from Report Templates

You can generate M-code versions of report templates in the form of an
M-file (*.m). An M-file of a report template is useful for a variety of
purposes, including generating reports and modifying report templates
programmatically.

To generate an M-file, load a report template into the Report Explorer and
click File > Generate M-File. After the M-file generates, it opens in the
MATLAB® Editor. The M-file is saved in the same location as the report
template.

Generating Reports from M-files

This example generates an M-file from the figloop tutorial.rpt report
template, which is provided with the MATLAB® Report Generator™ software.
The example then uses the report function to generate a report from the
M-file. For more information about this function, see the report reference
page.

1 Start the Report Explorer by entering report in the MATLAB Command
Window.

2 In the Options pane in the middle, double-click figloop tutorial.rpt
to open its report template.

3 In the Outline pane on the left, click Report - figloop_tutorial.rpt
to select it.

4 In the Report Explorer menu bar, click File > Generate M-File.

The MATLAB Report Generator software generates M-code for the
figloop_tutorial.rpt report template. It saves this code in the
buildfigloop_tutorial.m file in the current directory. Part of this file
appears in the following figure.
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‘ buildfigloop_tutorial.m
File Edit Text Go el Tools Debug Deskbop Window Help o | A X
NEHE | fRBR20¢|cAedi | p-BRBBE B|sexe-] BODEFO
D -8B -l |+ | x| O
1 lfunction [BptgenML CReportl] = buildfigloop tutorial ,D
z $BUILDF IGLOOP_TUTORILL —
3
4 % Auto-generated by MATLAE on 0Z-Jan-2008 11:15:08
5
] % Creste EptgenML,.CReport
7 - RptgenMlL CReportl = RptgenML.CReport('Description',...
g ['L report which demonstrates advanced component types:' ,sprinctf('in'),'',sprincf('\n'),
3 'Stylesheet! , 'html-'3ingleClearTitleTocLot' ...
10 'Format', 'html', ...
11 'DirectoryType', 'puwd');
12 % setedit (RptgenML CReporcl):
13
14 % Create rptgen.cfr titlepage
15 = rptgen cfr titlepagel = rptgen.cfr titlepage (' Copyright Date' [ '1998', ... fm
16 "Author', ' The MathWorks',...
17 'Subtitle' 'L Tutorial',...
18 'Title','The Figure Loop'):
19 — rptgen cfr textl = rptgen.cfr text('Content', ...
20 'The Figure Loop produces s report which documents multiple figure windows. Each time ©
21 — setjrptgen cfr titlepagel,'ibstractComp'  rptgen cfr_textl):
22 = rptgen ocfr texti = rptgen.cfr Cext:
23 - set (rptgen cfr titlepagel, 'LegalloticeConp' ,rptgen cfr text2):
24 — rptgen cfr imagel = rptgen.cfr image ('Filelame',''):
25 — get (rptgen ofr titlepagel, ' ImageConp',rptagen ofr imagel):
26 — setFarent (rptgen cfr ticlepagel, RptgenML CReportil):

5 To generate the figloop tutorial report from this M-file, run the
following command in the MATLAB Command Window:

report(buildfigloop_tutorial);

The MATLAB Report Generator software runs and displays the report.
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Abstract
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function hlist=figloopfigures
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To run this tutorial, type "setedit figloop-tutorcial™
at the comwand prompt.
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Copyright 1997-2004 The MathWorks, Inc.
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Working with Legacy Report Templates

In this section...

“What Are Legacy Report Templates?” on page 3-18
“Enabling Legacy Interfaces” on page 3-18

“Using Legacy Interfaces” on page 3-19

What Are Legacy Report Templates?

Legacy report templates are files that you created in previous versions of the
MATLAB® Report Generator™ or Simulink® Report Generator™ software.
You can load legacy report templates in the current version of the Report
Explorer. Alternatively, you can use earlier versions of the product interfaces
to work with legacy report templates.

Enabling Legacy Interfaces
Enable the previous versions of the interfaces at the MATLAB® command line:

RptgenML.v1imode (true)

The result is:

ans =
1

A logical 1 indicates that Version 1 mode is on. To turn off Version 1 mode,
enter:

RptgenML.vimode (false)

The result is:

ans =
0

A logical 0 indicates that Version 1 mode is off.
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Using Legacy Interfaces

When you enable Version 1 mode, you can use previous versions of MATLAB
Report Generator or Simulink Report Generator interfaces.

When using earlier versions of these interfaces, the following restrictions
apply:

® You cannot use a report template created in the latest version of the
MATLAB Report Generator or Simulink Report Generator software with
earlier interfaces. If you save a legacy report template in the latest version
of the software, you can no longer work with the same report template
in the old interface.

® You cannot use the old interfaces with the latest version of the MATLAB
Report Generator or Simulink Report Generator software. The Report
Template Editor can coexist with the Report Explorer, but The MathWorks
does not recommend using these interfaces together.
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Troubleshooting

3-20

In this section...

“Managing Memory Usage” on page 3-20

“Displaying HTML Reports on UNIX® Systems” on page 3-21

Managing Memory Usage

By default, the MATLAB® software sets a limit of 100 MB on the amount of
memory the Sun™ Java™ Virtual Machine (JVM™) software can allocate.
The memory that the report generation process uses to build a document
must fit within this limit. If you are having trouble processing large reports,
it might be helpful to increase the amount of memory that MATLAB® Report
Generator™ and Simulink® Report Generator™ software can allocate. See
the following sections for more information.

Running the MATLAB® Software Without a Desktop

One way to increase the amount of JVM memory available to the MATLAB
Report Generator and Simulink Report Generator software is to run the
MATLAB software with -nodesktop mode enabled.

Note This option is available on UNIX® platforms only. (UNIX is a registered
trademark of The Open Group in the United States and other countries.)

Increasing the MATLAB® JVM™ Memory Allocation Limit

Increase the amount of JVM memory available by increasing the MATLAB
JVM memory allocation limit.

1 Create a file named java.opts. In this file, include the -Xmx option,
specifying the amount of memory you want to allocate to the JVM software.
For example, to increase the JVM memory allocation limit to 128 MB, use
the following syntax in the java.opts file:

-Xmx128m



Troubleshooting

Caution To avoid virtual memory thrashing, never set the -Xmx option to
more than 66% of available physical RAM.

2 Put the java.opts file into the appropriate directory. Where you put the
file depends on what operating system you are running.

® On UNIX systems, put the java.opts file in the directory where you
intend to start the MATLAB software session, and navigate to that
directory before doing so.

® On Microsoft® Windows® systems:

a Put the java.opts file in a directory the directory where you intend
to start the MATLAB software session.

b Create a shortcut to the MATLAB software.
¢ Right-click the shortcut and select Properties.

d In the Properties dialog box, specify the MATLAB startup directory
for the name of the directory in which you created the java.opts file.

¢ On Apple® Mac OS® systems, put the java.opts file into the
/Applications/matlab directory.

Displaying HTML Reports on UNIX® Systems

HTML reports may not automatically display on some UNIX platforms. To
work around this issue, configure the MATLAB Report Generator software to
launch an external browser:

1 In the Report Explorer, click File > Preferences.
2 Enter the following text in the View command field:

web(rptgen.file2urn('%file name'), '-browser')

Where file name is the name of your report template file.
You may also need to modify the docopt.m file to specify which Web browser

you want to use. For more information, see the docopt function in the
MATLAB documentation.
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to Web Views

What Are Web Views? (p. 4-2)
Exporting Models to the Web (p. 4-3)
Navigating Web Views (p. 4-7)
Tutorial: Creating Web Views of

Simulink® Models (p. 4-10)

Troubleshooting (p. 4-21)

Overview of Web views and their key
features

How to export Simulink® and
Stateflow® models to Web views

Using Web views

Tutorial that demonstrates how to
create and navigate through Web
views

How to address common Simulink
Web view issues
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What Are Web Views?

A Web view is an interactive rendition of a model that you can view in a
Web browser. You can use Web views to navigate hierarchically to specific
subsystems and see properties of blocks, signals, and scopes. You can zoom
in and out, pan, and fit your model to your view using the same keyboard
shortcuts that you use in Simulink® and Stateflow® editors.

You need the Simulink® Report Generator™ software to create Web views.
Web views require that your Web browser support Adobe® SVG, implemented
natively or through a plug-in; they do not require The MathWorks™ products
to be installed. Therefore, Web views are useful for presenting models to
audiences and for sharing models with colleagues who do not have The
MathWorks products installed.
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Exporting Models to the Web

In this section...

“Opening the Export Interface” on page 4-3
“Setting Export Options” on page 4-3

“Generating and Reviewing Web Views” on page 4-5

Opening the Export Interface

You can export a model to a Web view using either a Simulink® Report

Generator™ dialog box or a Report Explorer pane.

To Open the export
interface from ...

Use ...

Export interface
opens as...

Report Explorer

Tools > Export to
Web

Report Explorer

Simulink® model File > Export to Web | Dialog box
window
Stateflow® editor File > Export to Web | Dialog box

Command line

The slwebview
function, with no
arguments

Report Explorer

Setting Export Options

You can set options that specify which Simulink systems or Stateflow charts
to export to a Web view, including:

® Whether to export Simulink systems or Stateflow charts that include (or
are children of) the current system or chart. For more information, see
“Include Systems” on page 4-4.

¢ Which masked blocks, if any, to include. For more information, see “Look
Under Masks” on page 4-4.

4-3



4 Exporting Simulink® Models to Web Views

® Whether to follow links to library blocks. For more information, see “Follow
Library Links” on page 4-5.

e Whether to follow model reference blocks. For more information, see
“Follow Model Reference Blocks” on page 4-5.

Tip This section describes how to specify Web view export options using the
Web Views dialog box. For information about how to specify these options
using the command line, see the slwebview function reference page.

Include Systems
Specifies which Simulink systems or Stateflow charts to export.

Include Systems Option Value Meaning

Current Export only the Simulink system
that is open in the model window or
the Stateflow chart that is open in
the diagram editor

Current and above Export the current Simulink system
or Stateflow chart and all systems or
charts that contain it

Current and below Export the current Simulink
system or Stateflow chart and all
subsystems or subcharts that it
contains

All (Default) Export all Simulink systems or
Stateflow charts in the model

Look Under Masks

This option is available only when you choose Current and below or All for
Include Systems. It specifies which masked blocks, if any, to export from
Simulink subsystems or Stateflow subcharts.
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Look Under Masks Option Value

Meaning

No masked blocks

Do not export any masked blocks

Masks with no workspace and no
dialog (Default )

Export only graphical masked
blocks—those that have no
workspaces and no dialog boxes

Masks with no dialog

Export only functional masked
blocks—those that have no dialog
boxes

All masked blocks

Export all masked blocks

Follow Library Links

Specifies whether to follow links into library blocks.

Follow Library Links Option
Value

Meaning

Selected

Follow links into library blocks

Unselected (Default)

Do not follow links into library blocks

Follow Model Reference Blocks

Specifies whether to follow links into referenced models.

Follow model reference blocks
Option Value

Meaning

true

Follow links into referenced models

false (Default)

Do not follow links into referenced
models

Generating and Reviewing Web Views

The Web view export process exports the system or chart that is visible at the
time you click Export Model. If you change the visible system or chart while
the Report Explorer Web view export pane is visible, the Report Explorer pane
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does not automatically change to show information about the newly visible
system. To update the Report Explorer pane, click Refresh.

The Web view export dialog box or the Report Explorer displays a list of
layers—that is, Simulink systems or Stateflow charts—to export. The list of
layers depends on the export options you specify, as described in “Setting
Export Options” on page 4-3.

To generate a Web view of all layers in the model, click OK in the Web View
dialog box, or click Export Model in the Report Explorer pane. This action
generates two sets of files in the current MATLAB® directory:

e An HTML file to appear in a Web browser.
® A directory with the same name as the HTML file. This directory contains

supporting files, such as svg and png files.

To send the Web view to another computer, include both the HTML file and the
directory of supporting files. Package these items into a zip file for transfer.

When you generate a Web view, it appears in a Web browser by default. You
can suppress the display by setting the 'ViewFile' option to false.
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Navigating Web Views

In this section...

“Displaying Web Views” on page 4-7
“Viewing the Current Layer” on page 4-7
“Viewing Other Layers” on page 4-8

“Viewing All Layers” on page 4-9

Displaying Web Views

To display Web views, you need a Web browser with support for Scalable
Vector Graphics (SVG), implemented natively or through a plug-in. For
detailed information on software requirements and limitations for using Web
views, see the Simulink® Report Generator™ Release Notes.

A Web view display consists of:

¢ A graphical display of the current layer (Simulink® system or Stateflow®
chart)

¢ A hierarchical treeview browser for easy navigation through layers

¢ Four navigation buttons at top left

¢ Menu of navigation commands, which appears when you move the mouse
over the leftmost button

¢ Shortcut menu, which appears in some browsers when you right-click the
current layer

Viewing the Current Layer

Display an example Web view of the Simulink Automatic Climate Control
System demo model by typing the following commands at the MATLAB®
command prompt:

sldemo_auto_climatecontrol;
slwebview(gcs)
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As you move the mouse over the current layer, parameter names and
values appear for each system, chart, block, and line. Use the mouse, menu
commands, keyboard accelerators, and the arrow keys on your keyboard to
pan and zoom within the current layer.

Navigation
Menu Shortcut Menu | Keyboard
Action Command Command Accelerator
Zoom in Zoom in Zoom in R
Zoom out Zoom out Zoom out v
Zoom to normal | Zoom to 100% None 1
size (100%)
Zoom to largest | Zoom to full Zoom to full F
size that fits in screen screen
browser window
Pan up Pan up E
Pan down Pan down C
Pan left Pan left D
Pan right Pan right G
Pan with mouse | Pan with Pan with P.Q, or
(drag layer while | mouse (click mouse (click SPACEBAR
in panning mode) | to toggle panning | to toggle panning | (press to enter
mode) mode) panning mode;
release to exit
panning mode)

Note The shortcut menu command Find text searches for a text string in
the current layer. This command is only available in the Microsoft® Internet
Explorer® Web browser.

Viewing Other Layers

Click a particular layer’s subsystem or subchart to make it the current layer.
The current layer is also selected in the treeview browser, and its subsystems
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or subcharts appear in the treeview browser hierarchically. If blocks in your
current layer are linked to libraries, the Web view shows to which libraries
they belong.

Note Ifyour current layer has no subsystems or subcharts, it does not appear
in the treeview browser.

As you move the mouse over an exported subsystem or subchart, it is
highlighted or the cursor changes, depending on which Web browser you are
using. You also see the following visual cues that enable you to assess your
location in the model quickly:

¢ The subsystem or subchart’s corresponding icon in the treeview browser is
also highlighted, showing to where in the hierarchy you have navigated.

¢ The names of the subsystem or subchart’s parent systems are grayed out
and italicized in the treeview browser.

You can use the navigation buttons at the top left to view other layers.

Action Navigation Button
View the previous layer in the view | View previous
history

View the top-level layer View home

View all layers in one window View all layers

Viewing All Layers

Click the View all layers navigation button to view all layers in one window.
The layers appear in the Web browser as thumbnail images. You can click a
given layer to view details about it. Clicking the View all layers button
again returns to the previous view.

Tip You can also view all layers by selecting the Show all layers command on
the navigation and shortcut menus, and by using the X keyboard accelerator.
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Tutorial: Creating Web Views of Simulink® Models

In this section...

“About This Tutorial” on page 4-10
“Specifying Web View Export Options” on page 4-10
“Exporting Models” on page 4-12

“Navigating Web Views” on page 4-14

About This Tutorial

This tutorial takes you through the steps required to export a Simulink®
model to a Web view. If you have a detailed model of your own, you can use it
for this example. Otherwise, use the example provided in this section.

There are several ways to create a Simulink model Web view. This
tutorial creates a Web view from the Simulink model window using the
sldemo_auto_climatecontrol model, which is provided with the Simulink
software. This model simulates the working of an automatic climate control
system in a car.

You do not need to know the Simulink product to follow this tutorial.
Specifying Web View Export Options
Before creating the Web view, specify export options:

1 Start a MATLAB® software session.

2 At the command prompt, enter sldemo_auto_climatecontrol to open
the Simulink model.

3 Click File > Export to Web.

A Web view window that includes data about the current model appears.
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E! Web ¥iew - sldemo_auto_climatecontral®

— Expart Option

Include sustems: I.-’-‘-.II

=l

™ Follows model reference blocks

l._ﬁ_! Look under maszks: IMasks with no workzpace and no dialog
- ™ Follow libray links

=l

— Exparted Layer

Hame

Path

gldermo_auto_climatecantral

gdemo_auto_climatecontral

AL Contral

zdemo_auto_climatecontral

Heater Contral

ghdemo_auto_climatecontral

Interior Dynamics

gldemo_auto_climatecontral

Subsyztem

ghdemo_auto_climatecontrol

Subzyztern

gldemo_auto_climatecontral

Temperature Control Chart

gldemo_auto_climatecontral/Temperature Contral C

if_temp_range

gdemo_auto_climatecontrold Temperature Contral ©

zetpoint_calc

gldemo_auto_climatecontral/Temperature Contral C

Ok

Cancel

Help

4 In the Include systems selection list, select A11 to export all systems in

this model.

5 In the Look under masks selection list, select Masks with no workspace
and no dialog to export only graphically masked blocks.

6 Leave the Follow library links and Follow model reference blocks

check boxes cleared.

Exported Layers appears in the lower part of the Web View window. This
area lists the names of the systems to export to the Web view, along with their
Simulink paths. Because you selected All in the Include systems selection

list, all layers in the sldemo_auto_climatecontrol model appear.
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Exporting Models
Export the model to a Web view:

1 Click OK in the Web View window.

A browser window opens.

4-12

43 simulink Web View - Microsoft Internet Explorer provided by The Ma 10| =|
J File —Edit Wew Favorites Tools Help | ",'
) % A = N . : 3 T - »>
J \) Back = () ~ |£| @ _Ij ‘ pa ) search 5. Favorites e} T ] ~ _J
J Address I@ (& 'l,WINNT'l,sldemD_aub:_dimatecDntrol_slwebvie'j Go H Links J e Snaglt |21 H @ -
'(121 To help protect your security, Internet Explorer has restricted this file from showing active content that could access X
your computer. Click here for options...
SVG Renderer Required: Your browser does not support Scalable Vector Graphics. Install the
free Adobe SVG Viewer plugin or a SVG-compatible web browser to view this Stmulink model.
0] [T [T T3 My computer y

Note Scalable Vector Graphics (SVG) is required for Web views. The
screen shots in this tutorial use Microsoft® Internet Explorer® Web browser
with the SVG plug-in installed. Mozilla Firefox has native support for
SVG. For details on SVG, see “Browser Requirements for Web Views” on

page 1-12.

2 Hover over the error message at the top of the screen.
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The error message background changes color.

3 Left-click the error message. A context menu appears.

/3 Simulink Web View - Microsoft Internet Explorer provided by The Mat 10| =]

J File Edit View Favorites Tools Help | :;'

J \‘_jBack - .\_:,1 v |ﬂ @ _;\J ‘ 1/‘.:]Searl::h ‘Ej"\'s-‘ Favarites Q}‘ - I-\.-__,; .ﬁ] - _J ?
| © snagre H & -

JAddress I@ NT\sldemo_auto_dimatecontrol_shwebview, html j Go H Links »

k Allow Blocked Content. ..
What's the Risk?

SVG Renderer Required: Your browser do___ nformation Bar Help tor Graphics. Install the
free Adobe SVG Viewer plugin or a SVG-compatible web browser to view this Stmulink model.

[
/4

0] |_|_|_|_|_|deComputer

4 Select Allow Blocked Content from the context menu.

The following security warning appears.

Security Warning

Allowing active content such as script and ActiveX controls can be useful,

! ':] but active content might alse harm your computer,

Are you sure you want to let this file run active content?

Yes | Mo I

>
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5 Click Yes.

The Web view of the model appears in the browser window.

4 simulink Web View - Microsoft Internet Explorer provided by The Mathworks, Inc.
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Navigating Web Views

You can navigate Web views in ways similar to how you navigate models in
the Simulink GUI. The following steps help you experiment with the types of
navigation that are available.

1 Notice the four navigation icons in the upper-left corner of the browser
window.
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Tutorial: Creating Web Views of Simulink® Models

OODE
/PN

Navigation  View View Show all
commands home previous layers

2 Hover over the Navigation Commands icon @ to see a list of keyboard
shortcuts that allow you to move around the current window.

? (88, sntitian
Mavigation Commands

:E:F*an up

C Pan down
D Pan left
G Pan right

P | Pan with mouse

F | Zoom to full sereen
L1 | Zoom to 100%
|R |Zoom in

V| Zoom out

:x:Sh-:]w all layers

3 Press some of the keyboard keys listed here to see how the model in the
Web view reacts.

4 Hover over the Temperature Control Chart diagram.
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The name next to the navigation icons becomes Temperature Control

Chart.

®

5 Hover over the System Trigger block.

Temperature Contral Chart

The name next to the navigation icons changes to System Trigger.

@ System Trigger

In addition, the block parameter values for the System Trigger block

appear.



Tutorial: Creating Web Views of Simulink® Models

i - l
% PulseType Time based
_ Time_Bource Use simulation time

System Triggg Amplitude 1

Period 1/60

FPulseWidth 50

PhaseDelay 0

VectorParams1D on

6 Hover over other blocks and subsystems in the model and observe the
results.

7 Click the Temperature Control Chart.

The details of this Stateflow® chart appear, and the middle two navigation
icons are now enabled:

® The View Home icon takes you up to the top level of the model.

® The View Previous icon takes you up one level in the model.
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8 Click the setpoint_calc box in the Stateflow chart to see the details of

that block.
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9 Click the View home icon to return to the model’s top layer.

10 Click the Show all layers icon. An overall view of the model appears.
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This high-level view of the model shows all layers of the model. In this

figure, the arrow is hovering over the AC Control layer.

Try opening other Simulink models and exporting them to Web views, and

experiment with the results.
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Troubleshooting

Troubleshooting

Addressing Web View Display Issues

Exporting a Simulink® model to a Web view may produce the following error:

[Thu Aug 23 15:20:04 2007] [alert] [client 127.0.0.1]
/webserver/mydir/simulink_model_ slwebview files/.htaccess:
IndexIgnore not allowed here

This results in your Web browser failing to display the Web view.

This issue occurs because of settings specified in the .htaccess file in your
Web browser’s root directory. This file contains the Apache Web Server
settings for your Web server host. To fix this problem, delete this file or
remove the IndexIgnore * line from it.

4-21



4 Exporting Simulink® Models to Web Views

4-22



Working with Components

About Components (p. 5-2)

Working with Looping Components
(p. 5-3)

Working with Property Table
Components (p. 5-9)

Working with Summary Table
Components (p. 5-21)

Explains what components are and
how to use them

Example of how to use the Figure
Loop component to loop on Handle
Graphics® figures

Example of how to use Property
Table components to display property
name/property value pairs in tables
in generated reports

Example of how to use Summary
Table components to display
information about specified objects
in tables in generated reports



5 Working with Components

About Components

Components are self-contained, modular MATLAB® objects that control
the report-generation process and insert elements, such as tables, lists,
and figures, into a report template. You use components to customize the
appearance and output of reports.

The following sections provide examples of how to use different types of
components.
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Working with Looping Components

In this section...

“About Looping Components” on page 5-3
“Editing the Figure Loop Tutorial Report Template” on page 5-3
“About Figures” on page 5-3

“Figure Properties” on page 5-5

“Editing Figure Loop Components” on page 5-6

About Looping Components

A looping component runs its child components a specified number of times.
Numerous looping components are available, including logical loops and
Handle Graphics® loops. Most loops behave similarly; the Figure Loop used in
this example is representative of many types of loops.

The Figure Loop component runs its child components several times. In each
iteration, it applies its child components to Handle Graphics figures. The
figloop-tutorial report template, which is provided with the MATLAB®
Report Generator™ software, creates a report that documents multiple
Handle Graphics figures.

For more information on Handle Graphics figures, see “Understanding Handle
Graphics Objects” in the MATLAB® getting started documentation.

Editing the Figure Loop Tutorial Report Template

To edit the figure loop tutorial report template, enter the following command
at the MATLAB command prompt:

setedit figloop-tutorial

About Figures

It is important to understand the following concepts to use this tutorial:

¢ Invisibility.
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5 Working with Components

Invisible figures do not appear on screen. They exist, but they are hidden,;
that is, the visible property of these figures is 'off'. To make a given
figure visible, set its visible property to 'on'.

Some of the figures used in this example are invisible. To see this, enter the
command figloopfigures at the MATLAB command line. Figures 1, 3,
and 5 appear, but Figures 2 and 4 do not because they are invisible.

The HandleVisibility parameter.

The HandleVisibility parameter of a Handle Graphics figure allows you
to control the availability of the object’s handle from the command line and
from within callback routines in the MATLAB software. Valid values for
this parameter are 'on' and 'off'.

To list all figures currently in your workspace whose HandleVisibility
parameter is 'on', enter the following command at the MATLAB command
line:

get (0, 'children')

The result is:

ans =
5
1
2
This indicates that HandleVisibility is 'on' for figures 1, 2, and 5.

To set HandleVisibility to 'off', enter the following command at the
MATLAB command line:

set(handle, 'HandleVisibility', 'off")

Where the handle of a figure is the figure number.
Tags.

You can set tags, or labels, on Handle Graphics figures. Tags do not appear
on their associated figures. By default, figure tags are empty.

To see a given figure’s tag, enter the following at the MATLAB command
line:
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get(handle,

Itagl)

Where the handle of a figure is the figure number.

For example, to see whether Membrane Data has a tag, enter the following
at the MATLAB command line:

get(1, 'tag')

The result is:

ans =

membrane

This indicates that figure 1 has a tag called membrane.

Figure Properties
The following table shows the values for the properties of the figures used

in this tutorial.

Name Handle | Visible HandleVisibility Tag
Membrane Data | 1 on on membrane
Invisible 2 of f on membrane
Membrane Data

An 3 on of f app
Application

An Invisible 4 of f of f app
Application

Peaks Data 5 on on peaks

To display the Handle Graphics figures, enter the following at the MATLAB

command line:

figloopfigures

The figures Membrane Data, An Application, and Peaks Data appear on the
screen. Invisible Membrane Data and An Invisible Application do not
because they are invisible.
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Editing Figure Loop Components

Select the Figure Loop component from the Outline pane on the left. The
Properties pane for the Figure Loop component appears.

Figure Loop

— Figure Selection

|nclude figures: | Current figure anly ll

— Loop Figure List

— Section Option

[ Create section for each object in loop
[T | Dizplay the object type it the zection title

[™ Create link anchor for each obiect in loop

Fewert Help

Looping on the Current Figure

To include only the current figure in the report, select Current figure only
from the Include figures selection list. In this case, “current figure” refers
to the figure that is current when the report generates. This may not be the
same figure you selected as the current figure in the Report Explorer before
report generation. For example, if the report-generation process creates
figures in your report, the last figure created with HandleVisibility set

to 'on' is the current figure.
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Looping on Visible Figures

To include snapshots of all visible figures in your report, select Visible
figures in theInclude figures selection list. This option inserts a snapshot
and Property Table for all figures that are currently open and visible.

Including only Figures with HandleVisibility="on’.

1 Select the Data figures only (Exclude applications) option to exclude
figures from the loop whose HandleVisibility parameteris 'off'.

2 Click the Report button to generate the report.

The Membrane Data and Peaks Data figures appear in the generated report.
Including All Figures.

1 Clear the Data figures only (Exclude applications) option.

2 Click Report to generate the report.

All figures, regardless of the value of their HandleVisibility parameter,
appear in the report.

Looping on Figures with Tags
To include figures specified tags in the report:

1 Select the A11 figures with tags option in theInclude figures selection
list.

2 Specify a tag in the text box.

3 Click Report to generate the report.

All figures with the specified tag, regardless of the value of their
HandleVisibility parameter, appear in the report.

Modifying Section Options

In a loop, a section refers to a space in the generated report in which
information, including text, images, and tables, appears. You can alter the
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appearance of sections in each loop appear in the report by using the options
in the Figure Loop component’s Section Options pane.

Create Section for Each Object in Loop. When you select this option, the
loop automatically creates an individual section for each object found in the
loop. It uses the object title as the section title. This option is useful when

a loop does not contain a Chapter/Subsection component that organizes the
loop results.

Display the Object Type in the Section Title. Enable this option by
selecting Create section for each object in loop. It precedes section titles
with object titles in the generated report.

1 Clear this option and generate the figloop-tutorial report.
The figures produced by the loop are:

Membrane Data
Invisible Membrane Data
An Application
An Invisible Application

2 Now select this option and regenerate the report.

The figures produced are now:

Figure Membrane Data
Figure - Invisible Membrane Data
Figure An Application
Figure - An Invisible Application

Create a Link Anchor for Each Object in Loop. Select this option to
create a hyperlink to the object in the generated report.
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Working with Property Table Components

In this section...

“About Property Table Components” on page 5-9

“Opening the Example Report Template” on page 5-11
“Examining the Property Table Output” on page 5-11
“Selecting Object Types” on page 5-12

“Displaying Property Name/Property Value Pairs” on page 5-12
“Editing Table Titles” on page 5-16

“Entering Text into Table Cells” on page 5-16

“Adding, Replacing, and Deleting Properties in Tables” on page 5-17
“Displaying or Hiding Cell Borders” on page 5-18

“Adding and Deleting Columns and Rows” on page 5-19
“Resizing Columns” on page 5-19

“Zooming and Scrolling” on page 5-19

“Selecting Tables” on page 5-20

About Property Table Components

Property Table components display property name/property value pairs for
objects in tables. This appears in the following example table from the
figloop-tutorial report.
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Working with Property Table Components

Many types of Property Table components are available, including:

e MATLAB® Property Table
¢ Simulink® Property Table
¢ Stateflow® Property Table

The component used in this example represents MATLAB® Report
Generator™ Property Table components, all of which exhibit similar behavior.

Opening the Example Report Template

This example uses the figloop-tutorial report template. To open the figure
loop tutorial report template, enter the following at the MATLAB command
line:

setedit figloop-tutorial

Examining the Property Table Output

Property pages for all Property Table components are similar in form. The
following figure shows the Properties pane for the Handle Graphics® Property
Table component. To modify table settings, click Edit.

5-11



5 Working with Components

Handle Graphics Property Table

— Select Graphics Object
Ohbject type: IFigure LI
[ Filter by class: I
— Table
Preszet tahle: I Select Table - vI Apply ¥ Split propertysvalue cells
Edi... ||7 Diizplay outer border
— Table Cell — Cell Propertis
Figure Properies Contents: |°/O<Name>
ZeMamer
Z<FileMame> Show as [PROPERTY Vale =]
Z4Tag: . .
e Childhans .-’-‘«hgnment.l[lenler _I
¥ Lower border
¥ Right border
Fesvert Help

Selecting Object Types

Property Table components offer multiple object types on which to report. For
example, the Handle Graphics Property table lets you report on a figure, an
axes object, or a Handle Graphics object.

You can select a different object type on which to report in the Object type
list in the component’s Properties pane.

Displaying Property Name/Property Value Pairs

Split Property/Value Cells

In the Handle Graphics Property Table component’s Properties pane, click
Edit.
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1 For a given property name and property value to appear together in one
cell of a table, clear the Split property/value cells check box. The table
is now in nonsplit mode. Nonsplit mode supports more than one property
name/property value pair per cell and text.

</} Figure Prop Table - <no kitle> o ] 1

|Selec’c & preset table z i Apply [~ Split propertyivalue cells
T ' ;I |.&.II Properties j

I Mare nvale ManuBar mbvale MumberTitke ntvale Color cyalue I

Hanclketisibilty hwalue

Tag tvalue
Wisible vWale
CurrertCharacter
Cieranttbiert
»
1 1 x
== S |
- ] »

| m|a|| =[= == [Frorervae

2 For the property name and property value to appear in adjacent horizontal
cells in the table, select the Split property/value cells check box.
The table is now in split mode. Split mode supports only one property
name/property value pair per cell. If more than one property pair appears
in a cell, only the first pair appears in the report; all subsequent pairs
are ignored.
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:» Figure Prop Table - <no title> -0 x|

|Selec’c & preset table z i Apply [w Split propertyivalue cells

' ;I IMain Propertties d

Chilclren - I
FileMame

H Marme
I Mame | nvalue I Tag

HandieVisibility | hwalue

Tag | fWalue

Yisible | value

\ ’
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Display Options

Property name/property value pairs can appear in cells in several ways. To
specify how a given property name/property value pair appears in a cell, select
that field in the table and choose Value from the Display As selection list

under the Figure Properties box. In the selected table row, only the value
appears.
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‘) Figure Prop Table - <no title>

|Select a preset table -i Apply W Split property fvalue cells

I nYalue

HandleVizibility | hwWalue

Tag | tWalue

Wizible | vWalue

‘I 1
B Kl I

_1ol x|
IMain Propetties d
Children =]
Filehame
Mame
Tag
[
== A |

I|I|-|ili.| EE_: =

Formatting Options

To specify alignment for text in a given cell, use the four justification buttons

in the toolbar under the Figure Properties box.

In this example, the selected table row is double justified. To change
justification options, right-click a table row and make the changes in its

context menu.
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Editing Table Titles

Table titles can contain properties and text. By default, the title of a table is
the same as the value of the %$<Name> property. You can modify this property
to modify the table title.

Note Table titles are always in nonsplit mode.

Entering Text into Table Cells

To enter text into a table cell, double-click the cell. A gray box appears with
the label for the cell property.
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) Figure Prop Table - <no title: =10l x|
|Select a preset table -i Apply [~ Split propertyfvalue cells
[ = IMain Properties d
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If you type text outside the angle brackets, the text appears as is in the
report. Text inside the table brackets must specify a valid property name. If

you enter an invalid property name, the property name appears in the report
without a property value.

Note For the text to be visible, the table must be in nonsplit mode.

Adding, Replacing, and Deleting Properties in Tables

Adding Table Properties
To add a Handle Graphics property to a table cell:

1 In the Figure Prop Table window, add a new table row to the current table.
a Select a table row directly under the row to which to add a new property.

b Click Add Row Above Current Cell.
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A new row appears above the current row.

2 Add the property to the new table row.
a Select the new table row.

b In the Properties Type selection menu at the upper-right of the window,
select a property type.

¢ In the Properties menu, select the property you want to add.

d Click the << Add button, or double-click the property name. The
property appears in the table row.

Alternatively, if you know the name of the property you want to add, enter
the property name directly into the cell as described in “Entering Text into
Table Cells” on page 5-16. For information about adding new table rows,
see “Adding and Deleting Columns and Rows” on page 5-19.

Replacing Table Properties

To replace a property in a cell of a table in split mode, follow the instructions
in “Adding Table Properties” on page 5-17.

Note You cannot use these steps to delete a property in a cell when the table
is in nonsplit mode.

Deleting Table Properties
Delete a property by backspacing over it or using the Delete key.

Displaying or Hiding Cell Borders
To toggle cell borders on and off:

1 Place your cursor in a cell and right-click to invoke its context menu.

2 Choose Cell borders > Top, Bottom, Right, or Left to toggle the specified
border on or off.
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Adding and Deleting Columns and Rows

To add or delete a column or row, select a cell and then click one of the buttons
described in the following table.

Note You cannot delete a row or column when it is the only row or column
in the table.

Button Action
i Add column (added to the left of the selected
. column)
Ill Delete selected column
I:I Add row (added above the selected row)
!I Delete selected row

Resizing Columns
To resize the width of a column, click and drag its vertical borders as needed.

Zooming and Scrolling

Zooming

You can zoom in and out of the table with the zoom buttons, which are located
to the left of the horizontal scroll bar.

Bution Action
EI Zoom in
:I Zoom out
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Scrolling

You can scroll vertically and horizontally using the table’s scroll bars.

Selecting Tables

To display property name/property value pairs, you can select a preset table
or use a custom table.

® A preset table is built-in and formatted. You can select a preset table in the
preset table selection list in the upper-left of the Figure Prop Table window.
To apply a preset table, select the table and click Apply.

e To create a custom table, select a preset table and modify it to fit your
needs by adding and/or deleting rows and properties. You may want to start
with the Blank 4x4 preset table.

Note You cannot save a custom table as a preset table. If you do so, you
lose all changes to the custom table.
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Working with Summary Table Components

In this section...

“About Summary Table Components” on page 5-21
“Opening the Example Report Template” on page 5-23
“Selecting Object Types” on page 5-23

“Adding and Removing Properties” on page 5-23
“Setting Relative Column Widths” on page 5-24

“Setting Object Row Options” on page 5-24

About Summary Table Components

Summary Table components insert tables that include specified properties for
objects into generated reports. Tables contain one object per row, with each
object property appearing in a column, as shown in the following Summary
Table in the figloop-tutorial report.
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RI=TE

File Edit Wwiew Go Debug Deskiop “Window Help

Table 1.1. Figure Properties 2
Name Tag Visible HandleVisibility
Membrane |membranejon on
Data
Invisible  |membrane|off on
Membrane
Data
A app an off
Application _
A app off off
Invisible
Lpplication
Feaks peaks or on
Data
T | B

X

Many types of Summary Table components are available, including:

¢ Handle Graphics® Summary Table
¢ Simulink® Summary Table

¢ Stateflow® Summary Table

The component used in this example represents MATLAB® Report
Generator™ Summary Table components, all of which exhibit similar behavior
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Opening the Example Report Template

This example uses the figloop-tutorial report template. To open the figure
loop tutorial report template, enter the following at the MATLAB® command
line:

setedit figloop-tutorial

Selecting Object Types

You can use the Object type selection list to choose Handle Graphics object
types for the Summary Table, including blocks, signals, systems, and models.
The figloop-tutorial reports on figure objects.

Adding and Removing Properties

You can select object properties to appear in the Summary Table from the
Property Columns pane. To add a property to the summary table, select the
property category from the property category box to the right of the Property
columns field. Selecting different property categories causes the selected
category’s properties to appear in the field under the box. The following figure
shows main as the selected category.

—Property Columns

Property columns I it .,I

¥§§ " Children
Vizible FileM arne:
H andle'izibility M ame

iI Tan

Felative column widths |3 211

® To add a property:
a Select the category from the property category box.
b Select a property in the properties list.
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¢ Click the Add property il button.

The property appears in the Property columns field.
® To remove a property from the table:
a Select the property in the Property columns field.
b Press Delete.

The property name is removed from the Property columns field.

Note After making changes in the Report Explorer interface, click Apply to
make the changes take effect.

You can define your own properties by entering their names into the Property
columns field using valid variable notation. For more information, see “%
Notation” on the Text component reference page in the MATLAB Report
Generator documentation.

Setting Relative Column Widths

Use the Width field to apply a relative column width to the Summary Table
columns in the generated report. If you do not specify a value for this field,
column widths automatically set.

Setting Object Row Options

You can use the Object Rows pane to set options for table rows, including
anchor, filtering, and sorting options. Select Insert anchor for each row to
place an anchor in each table row in the report. Use the Include figures list
to specify what objects to include in the Summary Table.

Summary Table components in figloop-tutorial report on figure objects.
For more information on options for these figure objects, see the following

sections:

® “Looping on the Current Figure” on page 5-6



Working with Summary Table Components

® “Looping on Visible Figures” on page 5-7
® “Looping on Figures with Tags” on page 5-7
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Component Reference

Real-Time Workshop® Components  Report on code generated by

(p. 6-2) Real-Time Workshop® software
Requirements Management Report block requirements data
Interface Components (p. 6-3)

Simulink® Components (p. 6-4) Report on Simulink® models
Simulink® Blocks Components Report on specified Simulink block
(p. 6-7) types

Simulink® Fixed Point™ Report on Simulink® Fixed Point™
Components (p. 6-8) blocks

Stateflow® Components (p. 6-9) Report on Stateflow® models

This chapter describes Simulink® Report Generator™ components.
For information about MATLAB® Report Generator™ components, see
“Component Reference” in the MATLAB Report Generator documentation.
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Real-Time Workshop® Components

Code Generation Summary

Import Generated Code

Insert version number information,
list of generated files, tables
summarizing code generation
configuration information, and
subsystem maps into report

Import source and header files
generated by Real-Time Workshop®
software, and custom files specified
as part of model



Requirements Management Interface Components

Requirements Management Interface Components

Requirement Block Loop

Requirement System Loop

Requirements Summary Table

Requirements Table

Apply child components to blocks
with requirements

Apply child components to systems
with requirements

Display properties of blocks, systems,
or Stateflow® objects with associated
requirements

Create table with requirements
information from Simulink®
Verification and Validation™
software
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Simulink® Components

Simulink® components have the following relationships.

Model Loop

Block Execution
Order

List

Block Type Content
Documentation
Functions and
Variables

Property Table
Model Simulation
Summary Table
Linking Anchor
Object Property
System Hierarchy
Model Change Log

|

System Loop

Block Loop

Documentation
Linking Anchor
MName

Object Property
Summary Table
Property Table
System Filter
System Hierarchy
System Property
Table

Signal Loop

Simulink Automatic
Table

Block Property Table
Linking Anchor
Name

Property Table
Linking Anchor
MName

Object Property

Annotation Loop

Block Execution Order List

Run child components multiple
times for each Simulink annotation
in current context

Create a list or table of all nonvirtual
blocks in the model, showing order
in which they execute




Simulink® Components

Block Loop

Block Type Count

Model Advisor Report

Model Change Log

Model Loop

Model Simulation

Signal Loop

Simulink Automatic Table

Simulink Dialog Snapshot

Simulink Functions and
Variables

Simulink Library Information

Simulink Linking Anchor

Simulink Name

Run child components for each block
contained in the current system,
model, or signal

Count number of each block type in
the current model or system

Insert Model Advisor report or link
to Model Advisor report for current
model

Construct model history table that
displays model revision information

Loop on Simulink models and
systems, as specified by child
components

Run current model with specified
simulation parameters

Run child components for each signal
contained in current system, model,
or block

Insert two-column table with
information on selected model,
system, signal, or block

Insert snapshots of Simulink editor
dialog boxes

Create table that displays workspace
variables and MATLAB® functions
used by reported blocks in Simulink
models

Insert table that lists library links in
the current model, system, or block

Designate locations to which links
point

Insert name of a Simulink model,
system, block, or signal into report
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Simulink Property

Simulink Property Table

Simulink Summary Table

System Filter

System Hierarchy

System Loop

System Snapshot

To Workspace Plot

Insert property name/property value
pair for current Simulink model,
system, block, or signal

Insert table that reports on
model-level property name/property
value pairs

Display properties or parameters of
specified Simulink models, systems,
blocks, or signals in table

Run child components only if the
current system meets specified
conditions

Create nested list that shows
hierarchy of specified system

Specify systems and subsystems on
which to loop, as defined by parent
component

Insert snapshot of the current
system into report

Capture plot figure created in the
MATLAB workspace



Simulink® Blocks Components

Simulink® Blocks Components

Bus
Documentation

Look-Up Table
Scope Snapshot

Create list of signals exiting from
Bus Selector block

Insert text extracted from DocBlock
blocks in Simulink® models

Report on lookup table blocks

Insert images of Simulink scopes
and XY graphs
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Simulink® Fixed Point™ Components

Simulink® Fixed Point™ components have the following relationships.

Fixed Point Logging Fixed Point Block

Fixed Point Property

Fixed Point Summary

Fixed Point Block Loop

Fixed Point Logging Options

Fixed Point Property Table

Fixed Point Summary Table

Run child components for the
Simulink® model, system, or signal
defined by parent component

Set fixed-point options like in Fixed
Point Tool

Insert table that reports on
Simulink Fixed Point block property
name/property value pairs

Display table of specified fixed-point
block properties or parameters



Stateflow® Components

Stateflow® Components

Stateflow® components have the following relationships.

Model/System

Machine

Chart Loop

State

Object

Hierarchy

Hierarchy
Count
Summary

Anchor
Name

Property
Snapshot

Automatic Summary Table

Truth Table

Stateflow
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Chart Loop

Machine Lo

Object Loo

State Loop

op

p

Stateflow Automatic Table

Stateflow

Stateflow

Stateflow

Stateflow

Stateflow

Stateflow

Stateflow

Stateflow

Stateflow

Stateflow

Count

Dialog Snapshot

Filter

Hierarchy

Hierarchy Loop

Linking Anchor

Name

Property

Property Table

Snapshot

Run child components for specified
Stateflow charts

Run child components for specified
Stateflow machines

Run child components for Stateflow
objects, and then insert table into
report

Run child components for all states
in current context

Insert table with properties of
current Stateflow object

Count number of Stateflow objects
in current context

Insert snapshots of Stateflow editor
dialog boxes

Run child components only if current
object type matches specified object

type
Provide visual representation of the
hierarchy of a Stateflow object

Run child components on Stateflow
object hierarchy

Designate locations to which links
point

Insert into report name of Stateflow
object specified by parent component

Insert into report table, text, or
paragraph with information on
selected Stateflow object property

Insert into report property-value
table for Stateflow object

Insert into report snapshot of
Stateflow object



Stateflow® Components

Stateflow Summary Table

Truth Table

Display table of properties or
parameters of specified Stateflow
object

Report on truth tables in Simulink®
and Stateflow models
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7

Components: Alphabetical
List

For a list of MATLAB® Report Generator™ components, see MATLAB®
Components — Alphabetical List in the MATLAB Report Generator
documentation.



Annotation Loop

Purpose

Description

Loop
Options

Section
Options

Run child components multiple times for each Simulink® annotation in
current context

This component runs its child components multiple times for each
Simulink annotation in the current context. The parent component
determines the context. Options include:

® Model Loop: Reports on all annotations inside the reported portion
of the reported model.
e System Loop: Reports on all annotations inside the current system.

® Block Loop or Signal Loop: Does nothing.

The Loop Options pane displays information about the current context.
You can sort Alphabetically by text or In traversal order.

Child components of the Annotation Loop consider their context to be
annotations when the report is running.

For example, the following components report on the looped annotation:

e Simulink Automatic Table

® Simulink Linking Anchor

® Simulink Name

® Simulink Property

® Simulink Property Table

Use a Summary Table component to show annotation objects in reports.

Each Summary Table component creates a single table with each
reported annotation on a single row of the table.

¢ Create section for each object in loop: Inserts a section in the
generated report for each object found in the loop.

¢ Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.



Annotation Loop

See Also

® Create link anchor for each object in loop: Creates a hyperlink
to each object in the loop, the generated report.

Block Loop, Model Loop, Signal Loop, System Loop, Simulink
Linking Anchor, Simulink Name, Simulink Property, Simulink
Property Table, Simulink Summary Table



Block Execution Order List

Purpose

Description

Properties

Insert
Anything
into
Report?

File Name

See Also

Create a list or table of all nonvirtual blocks in the model, showing
order in which they execute

This component creates a list or table of all nonvirtual blocks in the
model, showing the order in which they execute.
For more information about virtual and nonvirtual blocks, see “About
Blocks” in the Simulink® documentation.
e List Title:

= Automatic: Generates a list or table title automatically.

= Custom: Enables you to enter a title.

¢ Include block type information: Include each block’s BlockType
property in the list or table.

¢ Look under nonvirtual subsystems: The default is Automatic
(On for models, Off for systems). Set it to On or Off.

Yes. List.

rptgen_sl.csl_blk_sort_list

Block Loop



Block Loop

Purpose Run child components for each block contained in the current system,
model, or signal

Description This component runs its child components for each block contained in
the current system, model, or signal.

For more information on working with looping components, see
“Working with Looping Components” on page 5-3.
Report On This pane describes the type of object on which this component operates.

* Automatic list from context: Report on all blocks in the current
context. The Block Loop component’s parent component determines
its context. If this component does not have the Model Loop, System
Loop, Signal Loop, or Block Loop as its parent, selecting this option
causes this component to report on all blocks in all models.

Options include:

= Model Loop: Reports on all blocks in the current model.

= System Loop: Reports on all blocks in the current system.

= Signal Loop: Reports on all blocks connected to the current signal.

® Custom - use block list: Enables you to specify a list of blocks on
which to report. Enter the full path of each block.

Loop Choose block sorting options and reporting options in this pane.
Options
* Sort blocks

Use this option to select how to sort blocks:

= Alphabetically by block name. Sorts blocks alphabetically by
their names.

= Alphabetically by system name. Sorts systems alphabetically.
Blocks in each system are listed, but in no particular order.



Block Loop

= Alphabetically by full Simulink path. Sorts blocks
alphabetically by Simulink® path.

= By block type. Sorts blocks alphabetically by block type.
= By block depth. Sorts blocks by their depth in the model.
= By traversal order. Sorts blocks by traversal order.

= By simulation order. Sorts blocks by execution order.

= %<VariableName>: Inserts the value of a variable from the
MATLAB® workspace. The %<> notation can denote a string or cell
array. The following example reports on the theta dot integrator
block and the theta integrator block in the demo model simppend,
using the variable Z={ 'simppend/theta'}:

simppend/theta dot
%<7Z>

The generated report includes information about the following
blocks:

e simppend/theta dot

e simppend/theta

For more information, see %<VariableName> Notation on
the Text component reference page in the MATLAB® Report
Generator™ documentation.

If you do not select this option, blocks are reported on in the order in
which they are listed in the block list.

¢ Search for Simulink property name/property value
pairs: Reports only on Simulink blocks with specified property
name/property value pairs.

Section ¢ Create section for each object in loop: Inserts a section in the
Option S generated report for each block found in the loop.

¢ Display the object type in the section title: Automatically
inserts the object type into the section title in the generated report.



Block Loop

Insert
Anything
info
Report?

File Name

See Also

® Create link anchor for each object in loop: Create a hyperlink
to the block in the generated report.

Yes, inserts a section if you select the Create section for each object
in loop option.

rptgen_sl.csl_blk_loop

Model Loop, Signal Loop, System Loop, Simulink Linking Anchor,
Simulink Name, Simulink Property, Simulink Property Table,
Simulink Summary Table



Block Type Count

Purpose

Description

Count
Types

Table
Content

Insert
Anything
into
Report?

File Name

Count number of each block type in the current model or system

This component counts the number of each block type in the current
model or system. Within a model, this component counts blocks
underneath masks and inside library links.

For more information about block types, see “About Blocks” in the
Simulink® documentation.

Where block types are counted depends on this component’s parent:

Model Loop: Reports all block types in the current model:
= All blocks in model: Counts block types in the entire model.

= All blocks in reported systems: Counts block types only in
systems that appear in the report.

System Loop: Reports all block types in the current system.

Table title: Allows you to enter the table title.

Show block names in table: Includes a column that displays all
block names in the table.

Sort table:

= Alphabetically by block type: Sorts blocks alphabetically by
block type.

= By number of blocks: Sorts by decreasing number of occurrences.

Show total count: Displays total number of block types.

Yes. Table.

rptgen_sl.csl_blk_count



Block Type Count

See Also

Block Loop, Model Loop, System Loop
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Purpose

Description

Properties

Create list of signals exiting from Bus Selector block

This component creates a list of signals exiting a Bus Selector block.
The list contains signals leaving from the reported block or downstream
buses and signals.

This component’s parent determines which buses appear in the report:

® Model Loop: Includes all buses in the current model.
e System Loop: Includes all buses in the current system.
® Block Loop : Includes the current block if it is a bus block.

e Signal Loop: Includes all buses connected to the current signal.

If the Bus component does not have a looping component as its parent,
it reports on all buses in all open models.

* Show Bus Hierarchy: Specifies whether the list displays
downstream buses hierarchically.

* Insert linking anchor for bus blocks: Inserts a linking anchor
for each bus block. This designates the list item as the location to
which other links for that block point. (For more information, see the
Simulink Linking Anchor or Link component reference pages.) Do
not use this option if you have already specified an anchor location
for the bus block with an Object Linking Anchor component.

® Insert linking anchor for signals: Inserts a linking anchor for
each signal. This designates the list item as the location to which
other links for that signal point. For more information, see the
Simulink Linking Anchor or Link component reference pages.) Do
not use this option if you have already specified an anchor location
for the signal with an Object Linking Anchor component.

® Title: Inserts a title before each list. This attribute supports the
%<varname> notation. For more information, see %<VariableName>
Notation on the Text component reference page in the MATLAB®
Report Generator™ documentation.



Bus

Insert
Anything
into
Report?

File Name

See Also

Yes. List.

rptgen_sl.csl_blk_bus

Block Loop, Model Loop, Signal Loop, Simulink Linking Anchor,
System Loop,
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Chart Loop

Purpose Run child components for specified Stateflow® charts
Description This component runs its children for specified Stateflow charts.
Report On * Automatic list from context: Report on all chart blocks in the

context set by this component’s parent component. Options for the
parent component include:

= Model Loop: Reports on all Stateflow chart blocks in the current
model.

= System Loop: Reports on all Stateflow chart blocks in the current
system.

= Signal Loop: Reports on all Stateflow chart blocks connected to
the current signal.

= Machine Loop: Reports on the current block if it is in a Stateflow
chart.

If the Chart Loop component has any other type of component as

its parent, selecting this option causes it to report on all Stateflow

chart blocks.

® Custom - use block list: Reports on a specified list of Stateflow
chart blocks.
Loop Options

Choose chart block sorting options and reporting options in this pane.

¢ Sort blocks: Specifies how to sort blocks. This option is available
if you select Automatic list from context in the Report On
section, or if you select Custom - use block list and the Sort
blocks option. Options include:

= Alphabetically by block name. Sorts blocks alphabetically by
name.

= Alphabetically by system name. Sorts systems alphabetically
by name. Blocks in each system are listed, but in no particular
order.
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Chart Loop

Section
Options

Insert
Anything
into
Report?

File Name

= Alphabetically by full Simulink path. Sorts models
alphabetically by their full paths.

= By block type. Sorts blocks alphabetically by block type.
= By depth. Sorts blocks by their depth in the model.
= By simulation order. Sorts blocks by execution order.

= %<VariableName>: Inserts the value of a variable from the
MATLAB® workspace. The %<> notation can denote a string or
cell array. For more information, see %<VariableName> Notation
on the Text component reference page in the MATLAB® Report
Generator™ documentation.

If you do not select this option, chart blocks are reported on in the

order in which they are listed in the chart list.

® Search for Simulink property name/property value pairs:
Reports on Simulink® blocks with specified property name/property
value pairs.

® Search Stateflow: Reports on Stateflow charts with specified
property name/property value pairs.

¢ Create section for each object in loop: Inserts a section in the
generated report for each object found in the loop.

¢ Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.

¢ Create link anchor for each object in loop: Creates a hyperlink
to the object in the generated report

Yes, inserts a section if you select the Create section for each object
in loop option.

rptgen_sf.csf_chart_loop
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See Also Block Loop, Machine Loop, Model Loop, Signal Loop, System Loop
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Code Generation Summary

Purpose

Description

Summary

Traceability
Report

Insert version number information, list of generated files, tables
summarizing code generation configuration information, and subsystem
maps into report

This component reports the following information:

Version number information

List of generated files

Code generation configuration information

Subsystem map

General information: Includes the following information in the
report:

= Model name and version

= Real-Time Workshop® version number

= List of full paths of generated files

Configuration settings: Includes tables that list optimization and
Real-Time Workshop target selection and build process Configuration
Parameter settings.

Subsystem map: Includes in the report a unique mapping between
subsystem numbers and subsystem labels in the model.

Use settings from model: When you select this option, the report
uses all of the following configuration settings, as specified in your
model. Deselecting this option allows you to turn off one or more of
these settings as needed:

¢ Eliminated/virtual blocks

¢ Traceable blocks

¢ Traceable StateFlow Objects
¢ Traceable Embedded MATLAB Functions

7-15



Code Generation Summary

7-16

Insert
Anything
info
Report?

File Name

See Also

For more information on these configuration settings, see “Real-Time
Workshop Pane: Report” in the Real-Time Workshop documentation.

Yes. Tables and list.

RptgenRTW.CCodeGenSummary

Import Generated Code



Documentation

Purpose Insert text extracted from DocBlock blocks in Simulink® models

Description This component inserts text extracted from DocBlock blocks in Simulink
models. It can have the following components as its parent:

® Model Loop
® System Loop
® Block Loop

The specified report format determines the format of the DocBlock
block data inserted into the report:

e HTML: Imports HTML data into the report.
¢ RTF: Imports RTF data into the report.

Properties ¢ Import file as: Specifies how to format the imported information.
The following example demonstrates how each option works, using
the following text as input:

First row.
Second row.

Third row follows blank line.

= Plain text (ignore line breaks). Imports plain text without
any line breaks (no paragraphs), as in this example:

First row. Second row. Third row follows blank line.

= Paragraphs defined by line breaks. Imports the text
contained in paragraphs defined by line breaks (hard returns or
carriage returns), as in this example:

First row.
Second row.
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Documentation

Third row follows blank line.

= Paragraphs defined by empty rows. Imports text contained in
paragraphs defined by empty rows (rows that do not contain text),
as in this example:

First row. Second row.

Third row follows blank line.

= Text (retain line breaks). Imports plain text, including line
breaks, as in this example:

First row.
Second row.

Third row follows blank line.

= Fixed-width text (retain line breaks). Imports fixed-width
text (all letters have the same width or size) including line breaks,
as in this example:

First row.
Second row.

Third row follows blank line.

Tip This option is useful for importing M-files.

¢ Insert linking anchor for blocks: Inserts a linking anchor for
each DocBlock block that designates the location where other links
for that block point. (See the Simulink Linking Anchor or Link
component reference pages for more help.) Do not use this option if
you have already specified an anchor location for a DocBlock block
with an Object Linking Anchor component.
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Documentation

Insert
Anything
into
Report?

File Name

See Also

Yes. Text, paragraph, or external RTF/HTML data.

rptgen_sl.csl_blk_doc

Block Loop, Model Loop, Simulink Linking Anchor, System Loop
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Purpose

Description

Report On

Loop
Options

Run child components for the Simulink® model, system, or signal
defined by parent component

This component runs its children for the Simulink model, system,
or signal defined by its parent component. Options for the parent
component are:

® Model Loop
® System Loop
e Signal Loop

* Automatic list from context: Reports on all fixed-point blocks
in the context of this component’s parent. For example, if the
parent component is the System Loop, this component reports on all
fixed-point blocks in the current system. If this component does not
have a looping component as its parent, selecting this option causes
the component to report on all fixed-point blocks in all models.

® Custom - use block list:: Reports on a specified list of blocks.

Choose block sorting options and reporting options in this pane.

® Sort blocks: Specifies how to sort blocks. This option is available if
you select the Automatic list from context option in the Report
On section, or if you select Custom - use block list and the Sort
blocks options. Options include:

= Alphabetically by block name. Sorts blocks alphabetically by
name.

= Alphabetically by system name. Sorts systems alphabetically.
Blocks in each system are listed, but in no particular order.

= By fixed point block type. Sorts blocks alphabetically by
block type.

= By fixed point block depth. Sorts blocks by their depth in
the model.



Fixed Point Block Loop

Section
Options

Insert
Anything
into
Report?

File Name

See Also

= By traversal order. Sorts blocks by traversal order.
= By simulation order. Sorts blocks by execution order.

= %<VariableName>: Inserts the value of a variable from
the MATLAB® workspace. For more information, see
%<VariableName> Notation on the Text component reference
page in the MATLAB® Report Generator™ documentation.

¢ Search for Simulink property name/property value pairs:
Reports only on blocks with specified property name/property value
pairs.

¢ Create section for each object in loop: Inserts a section in the
generated report for each object found in the loop.

¢ Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.

¢ Create link anchor for each object in loop: Creates a hyperlink
to the object in the generated report.

Yes, inserts a section if you select the Create section for each object
in loop option.

rptgen_fp.cfp_blk _loop

Block Loop, Model Loop, Signal Loop, Simulink Linking Anchor,
System Loop
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Purpose

Description

Data Type
Override

Set fixed-point options like in Fixed Point Tool

This component sets fixed-point options like those set in the Fixed Point
Tool (invoked by running the fxptdlg function).

This component must be a child of the Model Loop component. Use this
component to set the following options on the current model:

e Data type override
* Logging mode
* Logging type

This component can have child components. It is a good practice to
use this component with a Model Simulation component as its child.
This sets fixed-point properties for the model for the purpose of the
simulation, and then restores them to their original values after the
simulation is complete.

® Use local settings: Data types are overridden according to the value
of this parameter set for each subsystem. Otherwise, settings for
parent systems override those of child systems.

® Scaled doubles: The output data type of all blocks in the current
system or subsystem is overridden with doubles; however, the scaling
and bias specified in the mask of each block is maintained.

® True doubles: The output data type of all blocks in the current
system or subsystem is overridden with true doubles. The overridden
values have no scaling or bias.

® True singles: The output data type of all blocks in the current
system or subsystem is overridden with true singles. The overridden
values have no scaling or bias.

* Force off: No data type override is performed on any block in the
current system or subsystem.



Fixed Point Logging Options

Logging
Mode

Logging
Type

Insert
Anything
into
Report?

File Name

Specify logging options in this section. If a block is logged, minimum
and maximum simulation values are written to the workspace. Options
include:

¢ Use local settings: Data is logged according to the value of this
parameter set for each subsystem. Otherwise, settings for parent
systems always override those of child systems.

¢ Min, max, and overflow: Minimum value, maximum value, and
overflow data is logged for all blocks in the current system or
subsystem.

* Overflow only: Only overflow data is logged for all blocks in the
current system or subsystem.

* Force off: No data is logged for any block in the current system or
subsystem. Use this selection to work with models containing fixed
point-enabled blocks, if you do not have a Simulink® Fixed Point™
license.

For more information on logging simulation results, see “Tutorial:

Feedback Controller Simulation” in the Simulink Fixed Point
documentation.

Specify how to record logs in this section:

¢ Overwrite log: Information in the logs is cleared before new logging
data is entered.

e Merge log: New logging data is merged with previously logged
information.

No.

rptgen_fp.cfp_options
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See Also Model Simulation
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Fixed Point Property Table

Purpose
Description

Table

Insert table that reports on Simulink® Fixed Point™ block property
name/property value pairs

This component inserts a table that reports on Simulink Fixed Point
block property name/property value pairs.

Select a preset table, which is already formatted and configured, in
the preset table list in the upper-left corner of the attributes page.
Options include:

* preset table
Specifies the type of object property table. Options include:
= Default
"= Mask properties
= Block limits
"= Out-of-range errors
= All fixed-point properties

= Blank 4x4
To apply the specified table, select the table and click Apply.

* Split property/value cells: Split property name/property value
pairs into separate cells. For the property name and property value
to appear in adjacent horizontal cells in the table, select the Split
property/value cells check box. In this case, the table is in split
mode, so there only one property name/property value pair can exist
in a cell. If there is more than one name/property pair in a cell, only
the first pair appears in the report; all subsequent pairs are ignored.

For the property name and property value to appear together in
one cell, clear the Split property/value cells check box. This is
nonsplit mode. Nonsplit mode supports more than one property
name/property value pair and text.

Before switching from nonsplit mode to split mode, make sure that
there is only one property name/property value pair per table cell. If
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Table Cells

Cell
Properties

you have more than one property name/property value pair or text in
one cell, only the first property name/property value pair appears in
the report; subsequent pairs and text are omitted.

¢ Display outer border: Display the outer border of the table in the
generated report.

Select table properties to modify. The selection in this pane affects the
available fields in the Cell Properties pane.

e Contents

Modify the contents of the table cell selected in the Table Cells pane.

®* Show as: Specifies the format for the contents of the table cell.
Options include:

PROPERTY Value
Value

Property Value
Property: Value
PROPERTY: Value
Property - Value
PROPERTY - Value

* Alignment: Aligns the contents of the table cell. Options are:

Center

Left

Right

Double justified

* Lower border: Displays the lower border of the table in the
generated report.
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File Name

See Also

* Right border: Displays the right border of the table in the generated
report.

Creating Custom Tables

To create a custom table, edit a preset table, such as the Blank 4x4
table. Add and delete rows and add properties. To open the Edit Table
dialog box, click Edit.

For details about creating custom property tables, see “Working with
Property Table Components” on page 5-9.

Yes. Table.

rptgen_fp.cfp_prop_table

Fixed Point Summary Table
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Purpose Display table of specified fixed-point block properties or parameters

Description This component displays properties or parameters of specified
fixed-point blocks in a table.

Properties Table title

Choose a table title in the generated report:

® Automatic: Generates a title automatically from the parameter.

® Custom: Specifies a custom title.

Property Property name

Columns This field displays the object properties to include in the Summary

Table in the generated report.
¢ To add a property:
a Select the appropriate property level in the menu
b Select the property to add from the selection list and click Add.

® To delete a property, select the property name and click the Delete
button.

® To move properties up and down in the list, click the Up and Down
buttons.

Note Some entries in the list of available properties (such as Depth)
are “virtual” properties that you cannot access using the get_param
command. The properties used for property/value filtering in the block
and system loop components must be retrievable by the get param.
Therefore, you cannot configure your Summary Table to report on all
blocks of Depth == 2.

7-28



Fixed Point Summary Table

Object
Rows

Loop
Options

Insert
Anything
into
Report?

File Name

¢ Insert anchor for each row: Inserts an anchor for each row in
the summary table.

e Report On: Specifies blocks on which to report:

Automatic list from context. Reports on all blocks in the
current context.

Custom - use block list. Reports on a specified list of blocks.
To include a given block in the report, specify its full path.

¢ Sort blocks: Specifies how to sort blocks:

Alphabetically by block name. Sorts blocks alphabetically by
name.

Alphabetically by system name. Sorts systems alphabetically.
Blocks in each system are listed, but in no particular order.

Alphabetically by full Simulink path. Sorts blocks
alphabetically by Simulink® path.

By block type. Sorts blocks alphabetically by block type.
By block depth. Sorts blocks by their depth in the model.
By traversal order. Sorts blocks by traversal order.

By simulation order. Sorts blocks by execution order.

¢ Search for Simulink property name/property value
pairs: Reports only on Simulink blocks with specified property
name/property value pairs.

Yes. Table.

rptgen_fp.cfp_summ_table
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See Also Fixed Point Property Table
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Purpose

Description

Properties

Insert
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into
Report?

File Name

See Also

Import source and header files generated by Real-Time Workshop®
software, and custom files specified as part of model

This component imports source and header files generated by Real-Time
Workshop software. It also imports custom files that you specify as
part of your model.

® Source files (auto-generated): Includes the following files in the
report:

= .c and .cpp source files generated by Real-Time Workshop
software.

= Real-Time Workshop source files, such as the template main file
and supporting files in the build directory.
This check box is selected by default. Clear it to omit source files.

* Header files (auto-generated): Includes the following files in the
report:

= .h and .hpp header files generated by Real-Time Workshop
software.

= Real-Time Workshop header files in the build directory.
This check box is selected by default. Clear it to omit source files.

® Custom files: Includes custom source files that you specify in the
Real-Time Workshop > Custom Code pane of the Configuration
Parameters dialog box. This check box is deselected by default.

Yes. Generated code listings.

RptgenRTW.CImportCode

Code Generation Summary
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Purpose

Description

Look-Up
Table
Options

Report on lookup table blocks

The Look-Up Table component reports on the following Lookup table
blocks:

¢ Lookup Table

¢ Lookup Table (2-D)

¢ Lookup Table (n-D)

It inserts a figure and/or table into the report. The table contains input
and output numeric values; a figure plots these values.

This pane allows you to specify the types of 1ookup table blocks to
include in the report and how they appear. If none of the check boxes
in this pane are selected, the component does not insert anything into
the report.

® The Look-Up Table displays results according to the type of its parent
component:
= Model Loop: Includes all lookup tables in the current model.
= System Loop.: Includes all lookup tables in the current system.
= Block Loop.: Includes the current block if it is a lookup table.

= Signal Loop: Includes all lookup tables connected to the current
signal.

If the Look-Up Table does not have any of the looping components
as its parent, it includes all lookup tables in all open models.

¢ Plot 1-D data: Plots data from a lookup table block. Choose the
plot type, Line plot or Bar plot, from the corresponding list. The
input data appears on the horizontal or x-axis, and the output data
appears on the vertical or y-axis.

For more information on line and bar plots, see “Types of MATLAB®
Plots” in the MATLAB Graphics documentation.



Look-Up Table

Print
Options

e Create table for 1-D data: Creates a table that contains numeric

data values from the lookup table block.

Plot 2-D data: Creates a plot of 2-D lookup table blocks. You can
specify whether the data appears as a surface plot or a line plot. The
line plot is best for small data sets, and the surface plot for larger

tables. For more information on surface and line plots, see “T'ypes of
MATLAB Plots” in the MATLAB Graphics documentation.

Note This is a 2-D slice through n-D data.

Create table for 2-D data: Creates a table that contains numeric
data values from the lookup table (2-D) block.

Create table for N-D data: Creates a table that contains numeric
data values from the lookup table (n-D) block.

Image file format: Specifies the image file format. Select
Automatic HG Format (the default) to automatically choose the
format best suited for the output format that you chose in the Report
component. Otherwise, choose an image format that your output
viewer can read. Options include:

= Automatic SL Format (Uses the Simulink® file format selected
in the Preferences dialog box)

= Adobe Illustrator

= Bitmap (16m-color)

= Bitmap (256-color)

= Black and white encapsulated PostScript

= Black and white encapsulated PostScript (TIFF)
= Black and white encapsulated PostScript2

= Black and white encapsulated PostScript2 (TIFF)
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= Black and white PostScript
= Black and white PostScript2
= Color encapsulated PostScript
= Color encapsulated PostScript (TIFF)
= Color encapsulated PostScript2
= Color encapsulated PostScript2 (TIFF)
= Color PostScript
= Color PostScript2
= JPEG high quality image
= JPEG medium quality image
= JPEG low quality image
= PNG 24-bit image
= TIFF - compressed
= TIFF - uncompressed
= Windows metafile
* Paper orientation: Options include:
= Landscape
= Portrait
= Rotated

= Use figure orientation
For more information on paper orientation, see orient in the
MATLAB documentation.

¢ Image size: Allows you to specify the image size in the report by
selecting Use figure PaperPositionMode setting and setting
the PaperPositionMode property of the Handle Graphics® figure.
Options include:
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= Automatic (same size as on screen):

= Custom: Specifies a custom image size. Set the image size using
the Size field and Units list.

For more information on paper position mode, see orient in the

MATLAB documentation.

® Size: Allows you to enter the size of the Handle Graphics figure
snapshot in the format wxh(width times height). This field is active
only if you choose Custom in the Image size list box.

® Units: Allows you to enter for the size of the Handle Graphics figure
snapshot. This field is active only if you choose Custom in the Image
size list box.

¢ Invert hardcopy: Causes the Handle Graphics InvertHardcopy
property to invert colors for printing; that is, it changes dark colors to
light colors and vice versa. To change colors in your image, choose
one of the following options:

= Automatic: Automatically changes dark axes colors to a light axes
color. If the axes color is a light color, it is not inverted.

= Invert: Changes dark axes colors to light axes colors and vice
versa.

= Don't invert: Does not change the colors in the image that
appears on the screen for printing.

= Use figure's InvertHardcopy setting: Uses the
InvertHardcopy property set in the Handle Graphics image.

= Make figure background transparent: Makes the image
background transparent.

Display ¢ Scaling: Options include:
Options

= Fixed size: Specifies the number and type of units.

= Zoom: Specifies the percentage, maximum size, and units of
measure.
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= Use image size: Sets the size of the image in the report to the
same size as it is on screen.

® Size: Specifies the size of the snapshot in the form w h (width height)
format. This field is active only if you choose Fixed size in the
Scaling selection list.

® Max size: Specifies the maximum size of the snapshot in the form
w h (width height). This field is active only if you choose Zoom from
the Scaling selection list.

® Units: Allows you to enter units for the size of the snapshot. This
field is active only if you choose Zoom or Fixed size in the Image
size list box.

¢ Alignment: Only PDF and RTF reports support this option. Options
include:

= Auto
= Right
= Left
= Center
¢ Title: Enter text to appear above the snapshot.

e Caption: Enter text to appear under the snapshot.

Yes. Figure and/or table.

rptgen_sl.csl_blk_lookup

Block Loop, Model Loop, Signal Loop, System Loop
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Purpose

Description

Loop
Options

Section
Options
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See Also

Run child components for specified Stateflow® machines

This component runs its child components for selected Stateflow
machines. The behavior of this component depends on its parent
component. If it has no parent, the Machine Loop runs its child
components for all machines. If it has the Model Loop is its parent, it
runs its child components for all machines in the model.

Search Stateflow

If selected, searches states that you specify in the field that appears

under the check box.

* Create section for each object in loop: Inserts a section in the
generated report for each object in the loop.

* Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.

® Create link anchor for each object in loop: Creates a hyperlink
to each object in the loop.

Yes, inserts a section if you select the Create section for each object
in loop option.

rptgen_sf.csf_machine_loop

Model Loop
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Purpose

Description

Properties
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See Also

Insert Model Advisor report or link to Model Advisor report for current
model

This component inserts a Model Advisor report for the current model
into the report if the report is in HTML format. For other report
formats, it inserts a link to a Model Advisor report for the current
model. For more information about Model Advisor reports, see “About
the Model Advisor” in the Simulink® documentation.

Use existing report: Includes an existing Model Advisor report in
the report. This check box is selected by default. If you clear it, a new
Model Advisor report is generated.

Yes, a Model Advisor report.

rptgen_sl.CModelAdvisor

Model Change Log



Model Change Log
|

Purpose Construct model history table that displays model revision information

Description This component should run before the Model Simulation component.
It uses a reported model’s ModifiedHistory parameter to construct a
model history table that displays information about each logged revision
to the model. This model history table includes:
¢ The author of each change
¢ The model version of the change
¢ The time and date of the change
¢ A description of the change

For more information on model history, see “Creating a Model Change
History” in the Simulink® documentation.

Tip If your model has a long revision history, you may want to limit
the number of revisions reported.

Table Choose the information displayed in the model revision table in this
Columns section:

®* Author name: Includes the name of the person who last revised
the model.

® Version: Includes the model’s version number.
* Date changed: Includes the date on which the model was revised.

* Description of change: Includes a description of the revision to
the model.
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¢ Limit displayed revisions to: Limits the number of revisions that
appears in the report.

* Show revisions since date: Limits the number of revisions that
appears in the report by date. Enter the date in the corresponding
text field. This field supports %<varname> notation. For example,
the default value, %<datestr(now-14)>, returns revision history for
the last two weeks.

Choose how the model revision history table appears in this section.

¢ Table title: Specifies the title of the table.

* Sort order: Sorts the table entries from most recent to oldest, or
vice-versa.

¢ Date format: Specifies a preferred date format for the date/time
stamps in the table.

Yes. Table.

rptgen_sl.csl_mdl_changelog

Model Advisor Report
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Purpose

Description

Models to
Include

Model
Options

Loop on Simulink® models and systems, as specified by child components

This component loops on Simulink models and systems, as specified by
child components. For example, you can use a Model Loop with a child
System Loop to report on the specified system’s subsystems.

It is a good practice to make these components children of the Model
Loop (although the Model Loop is not necessarily required to be a given
component’s immediate parent).

You can add a model to the list by clicking Add New Model to List.
The following table shows the buttons you can use to move a model up
or down in the list, or to add or delete a model.

Button Action
% Move a model up in the list.
3 Move a model down in the list.
% Remove a model from the list.
E Add a new model to the list.

¢ Active: Includes a given model in the loop. This option is selected by
default. Deselecting this option omits the model from the loop.

This option allows you to temporarily omit one or more models from a
report.

¢ Model name: Specifies the model name. Options include:
= Current block diagram
= All open models

= All open libraries
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= Block diagrams in current directory

= Custom block diagram: Selecting this option automatically sets
the Starting system(s) field to $top, which denotes the model
root.

= %<VariableName>: For more information, see %<VariableName>
Notation on the Text component reference page in the MATLAB®
Report Generator™ documentation.

* Traverse model: Specifies the system(s) to traverse. Options

include:

= All systems in model

= Selected system(s) only

= Selected system(s) and ancestors
= Selected system(s) and children

Look under masks: Specifies how to handle masks. Options
include:

= Functional masks only
= No masks
= All masks

= Graphical masks only
For more information, see “About Masks” in the Simulink
documentation.

Follow library links: Specifies library links to include. Options
include:

= Do not follow library links
= Include library links

= Include unique library 1links
For more information, see “Creating a Reference Block” in the
Simulink documentation.
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Section
Options

Examples

® Starting system(s): Specifies the system in which to start the loop.
Available options in this list depend on the value you select in the
Traverse model list. Selecting any option other than A11 systems
in model for Traverse model activates the Starting system(s)
field. This enables you to enter the full path of a subsystem or
subsystems.

Other options include:
= $top: Starts in the model root system.

= S$current: Starts in the currently selected system.

¢ Create section for each object in loop: Inserts a section in the
generated report for each object found in the loop.

¢ Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.

¢ Create link anchor for each object in loop: Creates a hyperlink
to the object in the generated report.

Generating Reports on Specified Systems and their Subsystems

This example shows how to loop over a specified system and its
subsystems in the sample model sldemo_auto_climate_elec, which is
provided with the Simulink software.

1 (Optional) Enter the following command at the MATLAB® command
prompt to open the sldemo_auto_climate_elec model:

sldemo_auto_climate_elec
Explore the model and familiarize yourself with its subsystems.
2 Open the Report Explorer.
3 Create a new report template by clicking File > New.

4 Save the report template by clicking File > Save As. Give it the
name sldemo_auto_report.
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5 Add a Chapter/Subsection component to the report template, to
include information about the model’s subsystems:

a In the Options pane in the middle, double-click
Chapter/Subsection to add it to the report template.

b For Title, choose Custom. In the title field, enter Description of
sldemo_auto_climate_elec subsystems.

6 Add a Model Loop as a child of the Chapter/Subsection component.
This loops over the ClimateControlSystem system and its
subsystems in the sldemo_auto_climate_elec model:

a In the Options pane in the middle, double-click Model Loop to add
it to the report template. By default, it is added as a child of the
Chapter/Subsection component.

b In the Model Loop properties pane, select <Custom block
diagram> from the Model name selection list.

¢ Delete the text <Custom block diagram> from the Model name
field, and then enter sldemo_auto _climate_elec.mdl. Click any
component in the report template to add this model to the Models
to include list.

d In the Traverse model selection list, select Selected system(s)
and children.

e In the Look under masks selection list, select A11 masks.

f In the Starting system(s) field, enter
sldemo_auto_climate_elec/ClimateControlSystem.
Because you selected Selected system(s) and children
for Traverse model, the Model Loop loops over
sldemo_auto_climate_elec/ClimateControlSystem and its
subsystems.

g Under Section Options, select the Create section for each
object in loop check box. Selecting this option creates separate
sections in the generated report for each model over which this
component loops.
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The Model Loop properties pane looks as follows.

Model Loop
— Models ta Include———— — Model Option
Models to Include: V¥ Active

sldemo_auto_climate_slec Model name: Isldemn auto_climate_elec.mdl | |

Traverze model: ISelected aystem(z] and children

Look under masks: I.t’-‘-.ll mazks ;I

Fallow librany links: IDD ot follov ibrany links ;I
Starting system[s]:

sldemo_auto_climate_elec/ClimateContralS ystem

[ x|« |

Section Option:

¥ Create section for each ohisct in loop
[ Display the objsct type in the section itk

[ Create link anchor for each obiect in loop

Fesvert Help

7 Save the report by clicking File > Save.
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8 Add a System Loop as a child of the Model Loop component.

a In the Options pane in the middle, double-click System Loop to
add it to the report template. By default, it is added as a child
of the Model Loop.

b In the System Loop properties pane, under Section Options,
select the Create section for each object in loop check box.
Selecting this option creates a section in the generated report for
each subsystem on which this component loops. Accept the default
values for all other fields.

9 Add a System Snapshot component as a child of the System

Loop component. This creates snapshots of all the subsystems of
ClimateControlSystem in the generated report. Double-click System
Snapshot In the Options pane in the middle. By default, it is added
as a child of the System Loop component.

10 Save the report.

The report template hierarchy now looks as follows.

.ﬂﬂepnrt Explorer - Report - sldemo_auto_report.rpk

File Edit *“iew Toolz Help

I £ 28 XE | et § =@

=- ‘?J Report Generator
=- f? Report - slderno_auto report rpk
=~ 458 Chapter - Description of subsys...
=1-458 Model Loop Section 1 - sldemo_auta_climate_elec.mdl
EG,EE Syztem Loop Section 2 - Reported aystems in curent model
L System Snapshot

11 Run the report by clicking File > Report.
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The report loops on the system ClimateControlSystem of the
sldemo_auto_climate_elec model and all of its subsystems, as
shown in the following Message List.

_lojx

Beqinning repark

Looping on rmodel “sldemo_auto_climate_elec”
Looping on syskem "ClimateContral3ystem”
Looping on syskerm "&C Conkral”

Looping on syskem "External Temperature in Celsius"
Looping on syskem "Heat from occupants"
Looping on syskem "Heater Conkrol”

Looping on syskem "Interior Cynamics”
Looping on syskem "Subsystem”

Looping on syskem "Subsystem1”

Looping on syskem "User Setpoint in Celsius"
Canverting repork

Report complete

The report looks as follows.
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INNT /Profiles /nlum/Desktop/sldemo_auto_report.hkml
File Edit ¥iew Go Debug Project Deskiop Window Help

@ o c ‘ “-é | ﬂ | Location:Ifi\e:,iHC:p’TEMPFs\demo_auto_report.html

Table of Contents

1. Description of subsystem
sldemo auto climate elec

ClimateCaontrolSystern
AL Cantrol
External Temperature in Celsius
Heat from occupants
Heater Contral
Interior Dynamics
Subsystern
Subsystern?
User Setpaint in Celsiug

Chapter 1. Description of subsystem

Table of Contents

sldemo_auto climate elec
ClirnateControlSystem
AC Contral
External Temperature in Celsius
Heat from occupants
Heater Control
Interior Dynamice
Subsystern
Subsystern?
User Setpoint in Celsius

sldemo_auto_climate_elec

ClimateControlSystem

fﬂ_‘ R4 B

ompmgon
1

Facysing Art

Usar Sepoirtn Calsius

Trnpanians Caniesl Coel.

He Saeromn. -l

[T e——————

RuAc]

Heat bom accagars
=

L4
L) 3
E weporion n spead Fan pas

G Conval

Heakr Contrd

Done
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Temporarily Omitting a Model from a Loop

This example shows how to use the Model Loop Active check box to
temporarily omit a model from the loop. This example uses the report
template that you created in Generating Reports on Specified Systems
and their Subsystems, sldemo_auto_report.rpt, and the model
f14.md1, which is provided with the Simulink software.

1 Click File > Open in the Report Explorer, and then open
sldemo_auto_report.rpt by double-clicking it.

2 In the Outline pane on the left, click Model Loop Section 1 -
sldemo_auto_climate_elec.

+
3 In the Model Loop properties pane, click the ﬂ button to add a
model to the Models to include list.

4 In the Model Loop properties pane, select <Custom block diagram>
from the Model name selection list.

5 Delete the text <Custom block diagram> from the Model name
field, and enter f14.md1.

The Model Loop properties pane now looks as follows.
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Model Loop

— Models to Include———————— — Model Option
Models ko Include: V¥ Active
14

: Model name: I f14.mdl |
zldemo_auto_climate_elec

Traverze model: IAII systems in model

Look. under masks: IAII masks

uuut

Fallawy librany links: IDn ot Fallovs library links

Starting syztem(z]:

$top

| |x e |

Section Optian:

¥ Create section for each object in loop
[ Display the object type in the section title

[ Create link anchor for each object in loop

Fiewert Help

6 Save the report template.

7 Generate the report.
The report generation process loops over the specified systems in

the f14 and sldemo_auto _climate elec models, as shown in the
following message box.
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| 3) Important messages (running a loop) j

Eeginning report
Looping on syskem “F14"
Looping on syskem "Aircraft Dynarmics Model
Looping on system "Controller”
Looping on system "Dryden Wind Gust Models"
Looping on system "More Infoz"
Looping on system "Mz pilat calculation”

ooping on model "sldemn_aut@
Looping on system "ClimateConkrolSystem”
Looping on syskem "aC Conkral
Looping on system "External Temperature in Celsius"
Looping on syskem "Heat from occupants"
Looping on system "Heater Conkral”
Looping on system "Interior Dynamics”
Looping on syskem "subsystem”
Looping on syskem "Subsystermnl”
Looping on system "User Setpoink in Celsius"
Converting repaort
Repaort complete

The report looks as follows.
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File Edt Wew Go Debug Project Desktop ‘Window Help

@ o 2| | @A | Location: [fle:if/H/Documents/DOCRptGen/skdemo_auto_repart, himl

Tahle of Contents

1. Description of subsystern

fl4
Aircraft Dynamics hodel
Contraller
Dryden Wind Gust hodels
Mare Info2
Iz pilot calculation

sldemo_auto climate elec
ClimateControlSystem
AC Control

Heat from occupants
Heater Contral

nterior Dynamics
Subsystern
Subsystem]

User Setpoint in Celsius

temal Temperature in Celsius

Chapter 1. Description of subsystem

Tahle of Contents

f4
4
Aircraft Dynamics hodel
Contraller
Dryden Wind Gust Models
Iars Info2
Mz pilot calculation
sldemo_auto climate elec
ClimateControlSystern
AC Control
External Ternperature in Celsius
Heat from occupants
Heater Cantrol
Interior Dynamics
Subsystem
Subsystem?
User Setpoint in Celsius

f14

StickInput

Sticks Input (in}
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w
Filot o force (9)|
q
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calculation

Pileh Rate 0

Aircraft
Dynamics

Rotary Gast cCut (ractsed L—»@

Pilot G force
Scope

Nz Pilot ig)

Angle of
Attack
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8 In the Models to include list, click f14 to select it.

9 Clear the Active check box to omit f14 model information from the
generated report.

10 Rerun the report.

The report now includes information only on the
sldemo_auto_climate_elec model, as shown at the end of

the previous example, Generating Reports on Specified Systems and
their Subsystems.

11 To reactivate the f14 model, select it in the Model Loop Models to
include list and select the Active check box.

Yes, inserts a section if you select the Create section for each object
in loop option.

rptgen_sl.csl_mdl_loop

Block Loop, System Loop

7-53



Model Simulation

Purpose Run current model with specified simulation parameters

Description This component runs the current model using specified simulation
parameters. This component should have the Model Loop component as
its parent.

For more information on simulation parameters, see:
¢ “Configuration Parameters Dialog Box” in the Simulink®
documentation.

e The simset function in the Simulink documentation.

1/0 Use model’s workspace I/0 variable names

Parameters Use the names of the parameters specified in the Simulation Parameters

dialog box.

The following options are available if you do not select the Use model’s
workspace I/O variable names option:

* Time : Specifies a new variable name for the Time parameter.

e States: Specifies a new variable name for the States parameter.

® Output: Specifies a new variable name for the Output parameter.

Timespan Use model’s timespan values: Use the model’s Start time and
Stop time values, as specified in the Solver tab in the Simulation
Parameters dialog box.

The following options are available if you do not select the Use model’s
timespan values option:

e Start: Specifies a simulation starting time.

® Stop: Specifies a simulation ending time.
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Simulation
Options
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File Name

See Also

Note If you set your model’s stop time to inf (infinity) in Simulink
or on this component’s attribute page, Simulink® Report Generator™
terminates the model simulation after 60 seconds to prevent the
report generation process from entering an infinite loop.

¢ Compile model before simulation: Compiles the model before
simulating, preserving scope content. Select this option if:

= You use Real-Time Workshop® Summary properties.
= You sort systems or blocks by simulation order.
= You use scope snapshots.

¢ Simulation status messages: Displays simulation status messages,
or inserts them into the report. Options include:

= Display to command line: Sends messages to a command-line
window.

= Display to Report Generator Message List: Sends messages
to the Simulink Report Generator message window.

= Insert into report: Includes messages in the report.

¢ Simulation parameters: Specifies simulation parameters.

No.

rptgen_sl.csl_mdl_sim

Model Loop
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Purpose
Description

Obiject
Types

Loop
Options
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Run child components for Stateflow® objects, and then insert table
into report

This component runs its child components for each Stateflow object and
inserts a table into the generated report.

* Report on “Data” objects: Includes Stateflow data objects in the
loop.

¢ Report on “Event” objects: Includes Stateflow event objects in
the loop.

* Report on “Transition” objects: Includes Stateflow transition
objects in the loop.

* Report on “Junction” objects: Includes Stateflow junction objects
in the loop.

* Report on “Target” objects: Includes Stateflow target objects in
the loop.

* Report on “Note” objects: Includes Stateflow note objects in the
loop.
¢ Report depth: Specifies the level at which to loop:

= Local children only (Default). Reports only on children one
level down.

= All objects. Reports on all Stateflow objects.

¢ Skip autogenerated charts under truth tables: Excludes
autogenerated charts under truth tables from the report.

* Remove objects which do not contain more information than
a snapshot: Excludes objects that contain only a snapshot.

® Search Stateflow: Reports on Stateflow charts with specified
property name/property value pairs.
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See Also

* Create section for each object in loop: Inserts a section in the
generated report for each object found in the loop.

¢ Display the object type in the section title: Automatically
inserts the object type into the section title in the generated report.

® Create link anchor for each object in loop: Creates a hyperlink
to the Stateflow object in the generated report.

Yes, inserts a section if you select the Create section for each object
in loop option.

rptgen_sf.csf_obj_loop

Stateflow Filter, Stateflow Hierarchy, Stateflow Hierarchy
Loop
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Requirement Block Loop

Purpose Apply child components to blocks with requirements

Description This component applies its child components to blocks with associated
requirements.

Report On * Automatic list from context: If selected, this option reports on

all blocks in the current context. TheRequirement Block Loop
component’s parent component determines its context. Options
include:

= Model Loop: Reports on all blocks in the current model.
= System Loop: Reports on all blocks in the current system.

= Signal Loop: Reports on all blocks connected to the current signal.
If the Requirement Block Loop does not have the Model Loop,
System Loop, Signal Loop, or Block Loop component as its parent,
it reports on all blocks in all models.

® Custom - use block list: Reports on a list of blocks with specified
requirements. You must enter the full paths of each blocks into this
field.

Loop ¢ Sort blocks
Options Specify how to sort blocks:

= Alphabetically by block name: Sorts blocks alphabetically by
name.

= Alphabetically by system name: Sorts systems alphabetically
by name. Blocks in each system are listed, but in no particular
order.

= Alphabetically by full Simulink path: Sorts blocks
alphabetically by Simulink® path.

= By block type: Sorts blocks alphabetically by block type.
= By block depth: Sorts blocks by their depth in the model.

= By traversal order: Sorts blocks by traversal order.
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File Name

See Also

= By simulation order: Sorts blocks by execution order.

¢ Search for Simulink property name/property value pairs:
Reports on Simulink blocks with specified property name/property
value pairs.

¢ Create section for each object in loop: Inserts a section in the
generated report for each block found in the loop.

¢ Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.

¢ Create link anchor for each object in loop: Creates a hyperlink
to the block in the generated report.

Yes, inserts a section if you select the Create section for each object
in loop option.

RptgenRMI.CReq_Block_Loop

Model Loop, Signal Loop, System Loop
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Requirement System Loop

Purpose Apply child components to systems with requirements

Description This component applies its child components to systems with associated
requirements.

Report On ¢ Loop on systems

= Select systems automatically: If selected, this option reports
on all systems in the current context. The component’s parent
determines its context:

e Model Loop: Reports on systems in the current model.

e System Loop: Reports on the current system.

e Signal Loop: Reports on the current signal’s parent system.
e Block Loop: Reports on the current block’s parent system.

If the Requirement System Loop does not have any of these
components as its parent, selecting this option reports on all
systems with requirements in all models.

= Custom - use system list: Reports on a list of specified
systems. Enter the full path of each system.

Loop ® Sort Systems: Options include:
ophons = Alphabetically by system name (default): Sorts systems
alphabetically by name.

= By number of blocks in system: Sorts systems by the number
of blocks in the system. The list displays systems by decreasing
number of blocks; the system with the largest number of blocks
appears first in the list.

= By system depth: Sorts systems by their depth in the model.

= By traversal order: Sorts systems in the order they are
traversed.

¢ Search for: Reports on Simulink® blocks with specified property
name/property value pairs.
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Section
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File Name

See Also

* Create section for each object in loop: Inserts a section in the
generated report for each object found in the loop.

* Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.

¢ Number sections by system hierarchy: Numbers sections in the
generated report hierarchically.

® Create link anchor for each object in loop: Creates a hyperlink
to the object in the generated report.

Yes, inserts a section if you select the Create section for each object
in loop option.

RptgenRMI.CReq_Sys_Loop

Block Loop, Model Loop, Signal Loop, System Loop
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Purpose
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Type

Table Title
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Display properties of blocks, systems, or Stateflow® objects with
associated requirements

This component displays properties of blocks, systems, or Stateflow
objects with associated requirements.

Choose the object type to display in the generated report. Options
include:

® Block (Default)

® System

e Stateflow

The selected object type affects the options available in the Property
Columns pane.

Specify a table title in the generated report. Options include:

® Automatic: Generates a title automatically from the parameter.

® Custom: Specifies a custom title.

® Object properties to include in the Requirements Summary Table
appear in a list.

= To add a property:
a Select the appropriate property level in the text box on the left.

b In the text box on the right, select the property that you want to
add and click Add.

= To delete a property, select the property name and click Delete.

%<SplitDialogParameters> is a unique property that can be
specified for Requirements Summary Tables where the object type is
Block. This property generates multiple summary tables, grouped



Requirements Summary Table

Object
Rows

Loop
Options

by block type. Each Summary Table group contains the dialog box
parameters for that block.

Some entries in the list of available properties (such as Depth) are
“virtual” properties that you cannot access using the get _param
command. The properties used for property/value filtering in the
block and System Loop components must be retrievable by the
get_param. Therefore, you cannot configure your Requirements
Summary Table to report on all blocks of Depth == 2.

Remove empty columns: Removes empty columns from the table.

Insert anchor for each row: Inserts an anchor for each row in the
Requirements Summary Table.

¢ Report On

Automatic list from context: Reports on all blocks in the
current context. The parent of this component determines its
context.

= Custom - use block list: Reports on a list of blocks that you
specify, and enter the block names in the corresponding field.
Specify the full path of each block.

Choose block sorting options and reporting options in this pane.

Sort blocks

= Alphabetically by block name: Sorts blocks alphabetically by
name.

= Alphabetically by system name: Sorts systems alphabetically
by name. Blocks in each system are listed, but in no particular
order.

= Alphabetically by full Simulink path: Sorts blocks
alphabetically by Simulink® path.

= By block type: Sorts blocks alphabetically by block type.
= By block depth: Sorts blocks by their depth in the model.
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= By traversal order: Sorts blocks by traversal order.
= By simulation order: Sorts blocks by execution order.

¢ Search for Simulink property name/property value pairs:
Reports on blocks with specified property name/property value pairs.

Insert Yes. Table.

Anything

info

Report?

File Name RptgenRMI.CReq_Summ_Table
See Also Block Loop
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Create table with requirements information from Simulink® Verification
and Validation™ software

This component creates a table that contains information from the
Simulink Verification and Validation software. Objects can have
multiple requirements. Each requirement is a row in the table.

* Show requirements for current: Specifies the object type to
display. Options include:
= Simulink object
= Stateflow object
¢ Table title: Specifies a title for the table. Options include:
= No title
= Object name (Default)

= Custom

® Description: Includes the object description in the table.
* Document name: Includes the report name in the table.

* Locations within document: Includes the object’s locations within
the document in the table.

* Requirement keyword: Includes the object’s requirement keyword
in the table.

Yes. Table.

RptgenRMI.CReqTable

Stateflow Automatic Table, Stateflow Name
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Description
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Options
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Insert images of Simulink® scopes and XY graphs

This component inserts images of Simulink scopes and XY graphs.
If the model has not been simulated, scopes are empty. For more
information, see the Model Simulation reference page.

The Scope Snapshot’s parent component determines its behavior.
Options include:

Model Loop or no Simulink looping component: Includes all XY
graphs and scopes in the current model.

System Loop: Includes all XY graphs and scopes in the current
system.

Block Loop: Includes the current block if it is an XY graph or scope.

Signal Loop: Includes all XY graphs and scopes connected to the
current signal.

If the Scope Snapshot does not have any of the Simulink looping
components as its parent, it includes all XY graphs and scopes in
all open models.

Report on closed scopes: Takes a snapshot of all scopes in context.
This option forces closed scopes to open when the report is generating.

Autoscale time axis: Scales the Simulink scope time axis to include
the entire log.

Image file format: Specifies the image file format (e.g., JPEG, TIFF,
ete.). Select Automatic HG Format (the default) to automatically
choose the format best suited for the specified output format.
Otherwise, choose an image format that your output viewer can read.
Options include:

= Automatic HG Format (uses the Simulink file format selected in
the Preferences dialog box)

= Adobe Illustrator



Scope Snapshot

Bitmap (16m-color)

Bitmap (256-color)

Black and white encapsulated PostScript

Black and white encapsulated PostScript (TIFF)
Black and white encapsulated PostScript2
Black and white encapsulated PostScript2 (TIFF)
Black and white PostScript

Black and white PostScript2

Color encapsulated PostScript

Color encapsulated PostScript (TIFF)

Color encapsulated PostScript2

Color encapsulated PostScript2 (TIFF)

Color PostScript

Color PostScript2

JPEG high quality image

JPEG medium quality image

JPEG low quality image

PNG 24-bit image

TIFF - compressed

TIFF - uncompressed

Windows metafile

Paper orientation:

Landscape
Portrait

Rotated
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Display
Options

= Use figure orientation
For more information about paper orientation, see the orient
reference page in the MATLAB® documentation.

Image size: Specifies the size of the Handle Graphics® figure
snapshot in the form [w h] (width height). In the units text box,
select one of the follow options:

= Inches

= Centimeters
= Points

= Normalized

Invert hardcopy: Inverts colors for printing; that is, changes dark
colors to light colors and vice versa. Options include:

= Automatic: Automatically changes dark axes colors to a light axes
color. If the axes color is a light color, it is not inverted.

= Invert: Changes dark axes colors to light axes colors and vice
versa.

= Don't invert: Does not change the colors in the image that
appears on the screen for printing.

= Use figure's InvertHardcopy setting: Uses the
InvertHardcopy property set in the Handle Graphics image.

= Make figure background transparent: Makes the image
background transparent.

¢ Scaling:

= Fixed size: Specifies the number and type of units.

= Zoom: Specifies the percentage, maximum size, and units of
measure.

= Use image size: Causes the image to appear the same size in
the report as on screen.



Scope Snapshot

Size: Specifies the size of the snapshot in the form w h (width
height). This field is active only if you choose Fixed size from the
Scaling selection list.

Max size: Specifies the maximum size of the snapshot in the form
w h (width height). This field is active only if you choose Zoom from
the Scaling selection list.

Units: Specifies the units for the size of the snapshot. This field
is active only if you choose Zoom or Fixed size in the Image size
list box.

Alignment: Options include:
= Auto
= Right
= Left

= Center
Only PDF and RTF reports support this option.

Title: Specifies a title for the snapshot figure. Options include:

= Block name: Uses the block name as the title.

= Full Simulink path name: Uses the Simulink path as the title.
= Custom: Specifies a custom title.

Caption: Select or enter a short text description for the snapshot
figure. Options include:

= No caption

= Automatic (use block description). Uses the Simulink block
description as the caption.

= Custom. Specifies a short text description for the snapshot figure.
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Yes. Image.

rptgen_sl.csl_blk_scope

Block Loop, Model Loop, Signal Loop, System Loop



Signal Loop

Purpose

Description

Run child components for each signal contained in current system,
model, or block

The Signal Loop component runs its child components for each signal
contained in the current system, model, or block. Its behavior is
determined by its parent component. Options include:

® Model Loop: Loops on all signals in the current model.

e System Loop: Loops on all signals in the current system. Choose
not to report on the following types of signals by clearing the
corresponding option in the Section options area:

= System input signals
= System output signals
= System internal signals
e Signal Loop: Loops on the current signal.

® Block Loop : Loops on all signals connected to the current block.
Choose not to report on the following types of signals by clearing the
corresponding option in the Section options area:

= Block input signals
= Block output signals

¢ If the Signal Loop does not have a looping component as its parent,
it loops on all signals in all models. Choose not to report on the
following types of signals by clearing the corresponding option in
the Section options area:

= Block input signals

= Block output signals
= System input signals
= System output signals

= System internal signals
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Select Include block input signals: Loops on signals that feed into blocks.
Signals This option is valid only when the Block Loop is this component’s
parent.

¢ Include block output signals: Loops on signals that leave
the block. This option is valid only when the Block Loop is this
component’s parent.

¢ Include system input signals: Loops on signals coming from
inports. This option is valid only when the System Loop is this
component’s parent.

¢ Include system internal signals: Loops on system internal
signals. his option is valid only when the System Loop is this
component’s parent.

¢ Include system output signals: Loops on signals going to outports.
his option is valid only when the System Loop is this component’s
parent.

® Sort signals: Specifies how to sort signals:

= Alphabetically by signal name: Sorts signals alphabetically
by name.

= Alphabetically by signal name (exclude empty): Sorts
signals alphabetically by name.

= Alphabetically by system name: Sorts alphabetically by parent
system names. Signals in each system are listed, but in no
particular order.

= By signal depth: Sorts signals by their depth in the model.

Section * Create section for each object in loop: Inserts a section in the
OPtion S generated report for each object found in the loop.

¢ Display the object type in the section title: Automatically
inserts the object type into the section title in the generated report.

¢ Create link anchor for each object in loop: Creates a hyperlink
to the object in the generated report.
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Yes, inserts a section if you select the Create section for each object
in loop option.

rptgen_sl.csl_sig_loop

Block Loop, Model Loop, System Loop
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Purpose
Description

Options

Display
Options

Insert two-column table with information on selected model, system,
signal, or block

This component inserts a two-column table that contains details for the
selected model, system, signal, or block into a generated report.

Show current: Includes a specified Simulink® software feature in
the generated report. Options include:

= Automatic: Uses the context of the parent loop.
= Model

= System

= Block

= Annotation

= Signal

Properties list: Specifies whether to select properties manually or
automatically. Options include:

= Determine properties automatically: Uses blocks and dialog
box properties.

= Show properties: Enables you to specify properties manually.

Show full path name: Displays the full path of the selected
Simulink model.

Display property names as prompts: Displays property names as
prompts in the generated report. The report includes the dialog box
string instead of the underlying code property.

Table title: Displays a table title in the generated report. Options
include:

= Name: Automatically generates a title from the parameter.

= Custom: Specifies a custom title.
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= No title: Does not include a title.

* Header row: Select a header row for the table in the generated
report. Options include:

= No header: Includes no header row.

= Type and Name: Includes a header row with columns for name
and object type.

= Custom: Includes a custom header.

¢ Don’t display empty values: Excludes empty parameters in the
generated report.

Yes. Table.

rptgen_sl.csl_auto_table

Block Loop, Model Loop, Signal Loop, System Loop
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Purpose

Description

Format

Display
Options

Insert snapshots of Simulink® editor dialog boxes

This component takes snapshots of Simulink editor dialog boxes. You
use it to display the current settings associated with an object or
document the appearance of your custom mask dialog boxes.

The behavior of this component is determined by its parent component.
Options include:
® Block Loop: Documents the current reported block’s dialog box.

e System Loop: Documents the current reported system’s dialog box.

* Image file format: Specifies the format for the snapshot image file.
The automatic format chooses BMP format for PDF files, and PNG for
other formats.

* Show all tabs: Automatically generates images for all the tabs
for the dialog box. If this check box is cleared, Simulink® Report
Generator™ creates an image of only the first tab.

® Scaling:
= Fixed size: Specifies the number and type of units.

= Zoom: Specifies the percentage, maximum size, and units of
measure.

= Use image size: Causes the image to appear the same size in
the report as on screen.

® Size: Specifies the size of the snapshot in the format w h (width
height). This field is active only if you choose Fixed size from the
Scaling selection list.

® Max size: Specifies the maximum size of the snapshot in the format
w h (width height). This field is active only if you choose Zoom from
the Scaling selection list.
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Units: Specifies the units for the size of the snapshot. This field
is active only if you choose Zoom or Fixed size in the Image size
list box.

Alignment:
= Auto
= Right
= Left

= Center
Only PDF and RTF reports support this option.

Title: Specifies text to appear above the snapshot.

Caption: Specifies text to appear under the snapshot.

Yes. Snapshot.

rptgen_sl.Cdialog boxesnapshot

Block Loop, System Loop
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Purpose

Description

Functions

Variables

Create table that displays workspace variables and MATLAB® functions
used by reported blocks in Simulink® models

This component creates a table that displays workspace variables and
MATLAB functions used by blocks in a Simulink model. The current
model and systems in which the blocks appear are specified in the Model
Loop component. For example, a Simulink Gain block might have a
string cos (x) instead of a number. The Simulink software looks for a
variable x in the workspace and uses the cos function.

¢ Include table of functions: Includes a table of Simulink functions
in the generated report.

® Table Title: Specifies a title for the table in the generated report:
= Automatic: Generates a title automatically from the parameter.
= Custom: Specifies a custom title.

¢ Parent block: Includes a column in the table that includes the name
of the block, which contains the reported variable.

® Calling string: Includes the M-code that calls the reported variable.

¢ Include fixed-point functions (sfix, ufix, , ...): Includes
Fixed-Point Toolbox™ functions in the report.

¢ Include table of variables: Includes a table of Simulink variables
in the generated report.

¢ Table title: Specifies a title for the table in the generated report.
Options include:

= Automatic: Generates a title automatically from the parameter.
= Custom: Specifies a custom title.

¢ Include Workspace I/0O parameters: Reports on variables that
contain parameters with time vectors and state matrices. These
parameters are set in the Workspace I/O pane in the Simulation
Parameters dialog box in a Simulink model.



Simulink Functions and Variables

In the following table, if any of the entries in the first column are on,
the component looks for the variable listed in the second column. If
the component finds the variable in the workspace, it includes it in

the report.

Parameter name Variable name
LoadExternalInput Externallnput
SaveTime TimeSaveName
SaveState StateSaveName
SaveOutput OutputSaveName
LoadInitialState InitialState
SaveFinalState FinalStateName

Parent block: Includes the name of the block that contains the
reported variable.

Calling string: Includes the M-code that calls the reported variable.

Size of variable: Includes the size of the reported variable.

Class of variable: Includes the variable class to which the reported
variable belongs.

Memory size: Includes the amount of memory in bytes that the
reported variable needs.

Value in workspace: Includes the value of the reported variable.

Very large arrays may appear as [MxN CLASS]. For example, if you
have a 300-by-200 double array, it appears in the report as [300x200
DOUBLE].

RTW storage class: Include the storage class of the reported
variable.

The title of this column is Storage Class. This option looks
at the model’s TunableVars property to see if any of the model
variables specify their storage class. If you specify the storage class,
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TunableVarsStorageClass and TunableVarsTypeQualifier appear

in a table column in the model variables table.

The column entries are TunableVarsStorageClass
(TunableVarsTypeQualifier) if TunableVarsTypeQualifier is not
empty. If TunableVarsTypeQualifier is empty, the column entry

is TunableVarsStorageClass.

Values for TunableVarsStorageClass include:

= Exported Global

= Auto

= ImportedExtern

= ImportedExtern Pointer

¢ Data object properties: Reports on data object properties.

Example

This is an example of a table created by the Model Variables
component. This Property Table reports on the variables in the
Controller in the F14 demo model.

Variable Calling

Name Parent Blocks String | Value

Ka f14/Controller/Gain3 Ka 0.677

Kf f14/Controller/Gain Kf -1.746

Ki f14/Controller/Proportional [Ki] -3.864
plus integral compensator

Kq f14/Controller/Gain2 Kq 0.8156
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Yes. Table.

rptgen_sl.csl_obj_fun_var

Block Loop, Model Loop, Signal Loop, System Loop
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Purpose

Description

Table
Columns

Display
Options

Insert table that lists library links in the current model, system, or block

This component inserts a table that lists library links in the current
model, system, or block.

Block: Includes the Simulink® block name in the generated table.

¢ Library: Includes the Simulink library root name in the generated
table.

* Reference block: Includes the Simulink reference block name in
the generated table.

® Link status: Includes the link status in the generated table.

Title: Specifies a title for the generated report.

* Sort table by:

= Block: Sorts the table by block name.

= Library: Sorts the table by library name.

= Reference Block: Sorts the table by reference block name.
= Link Status: Sorts the table by link status.

®* Merge repeated rows: Merges sorted rows in the generated table.

Example

The following table, which is sorted on the Reference Block column,
is generated from the aero_guidance model with Merge repeated
rows deselected.

Block Library Reference Block | Status
Equations Aerospace Equations of resolved
of Motion Motion (Body

(Body Axes) Axes)




Simulink Library Information

Block Library Reference Block | Status

Incidence & | Aerospace Incidence & resolved

Airspeed Airspeed

Fin Actuator | Aerospace 2nd Order resolved
Nonlinear
Actuator

3DoF Aerospace 3DoF Animation resolved

Animation

Atmosphere | Aerospace Atmosphere model | resolved

Cm Simulink Interpolation (n-D) | resolved
using PreLookup

Cx Simulink Interpolation (n-D) | resolved
using PreLookup

Cz Simulink Interpolation (n-D) | resolved
using PreLookup

Kg Simulink Interpolation (n-D) | resolved
using PreLookup

Ki Simulink Interpolation (n-D) | resolved
using PreLookup

Alpha Index | Simulink PreLookup Index | resolved
Search

Mach Index | Simulink PreLookup Index | resolved
Search

Mach Index | Simulink PreLookup Index | resolved
Search

| Alpha | Simulink PreLookup Index | resolved

Index Search

When you select Merge repeated rows, the generated table collapses
rows in the Block column so that each row in the Reference Block
column is unique, as shown in the following table.
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Block Library Reference Block | Status
Equations Aerospace Equations of resolved
of Motion Motion (Body
(Body Axes) Axes)
Incidence & | Aerospace Incidence & resolved
Airspeed Airspeed
Fin Actuator | Aerospace 2nd Order resolved
Nonlinear
Actuator
3DoF Aerospace 3DoF Animation | resolved
Animation
Atmosphere | Aerospace Atmosphere resolved
model
Cm Simulink Interpolation resolved
(n-D) using
i PreLookup
Cz
Kg
Ki
Alpha Index | Simulink PreLookup Index | resolved
Mach Index SEErEn
Mach Index
| Alpha |
Index
Insert Yes. Table.
Anything
Into
Report?
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File Name rptgen_sl.CLibinfo

See Also Block Loop, Model Loop, System Loop
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Purpose Designate locations to which links point

Description This component designates a location to which links point. This
component should have the Model Loop, System Loop, Block Loop, or
Signal Loop component as its parent.

Properties * Insert text: Specifies text to appear after the linking anchor.

¢ Link from current: Sets the current model, system, block, or signal
as the linking anchor. Options include:

Insert Yes.
Anything

into

Report?

Automatic: Automatically selects the appropriate model, system,
block, or signal as a linking anchor. If the Model Loop component
is the parent component, the linking anchor is set on the current
model. Similarly, if the Block Loop or Signal Loop is the parent
component, the linking anchor is inserted for the current system,
block, or signal, respectively.

Model: Sets the linking anchor to the current model.

System: Sets the linking anchor to the current system.

Block: Sets the linking anchor to the current block.
Annotation: Sets the linking anchor to the current annotation.

Signal: Sets the linking anchor to the current signal.

Note Each object should have only one anchor per report. For
more information, see the Simulink Summary Table component
reference page.

A link, and possibly text, depending on attribute choices.



Simulink Linking Anchor
|

File Name rptgen_sl.csl_obj_anchor

See Also Block Loop, Model Loop, Signal Loop, System Loop
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Simulink Name

Purpose Insert name of a Simulink® model, system, block, or signal into report

Description This component inserts the name of a Simulink model, system, block,
or signal into the report.

You can use this component as the first child component of a
Chapter/Subsection component, which allows the current Simulink
model, system block, or signal name to be the chapter or section title.

Properties ¢ Object type

Automatic: Automatically selects the appropriate model, system,
block, or signal name as the Simulink object name to include in the
report. If the Model Loop component is the parent component, the
object name is the current model name. Similarly, if the System
Loop, Block Loop, or Signal Loop is the parent component, then
the object name is the name of the current system, block, or signal,
respectively.

Model: Includes the current model name in the report.
System: Includes the current system name in the report.
Block: Includes the current block name in the report.

Signal: Includes the current signal name in the report. If the
signal name is empty, the signal <handle>, which is a unique
numerical identifier to that signal, appears in the report.

Annotation: Includes the current annotation name in the report.

* Display name as: Display the Simulink object name in the report.
Options include:
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Name: For example, f14

Type Name: For example, Model f14
Type - Name: For example, Model - f14
Type: Name: For example, Model: f14



Simulink Name

Insert
Anything
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Report?

File Name

See Also

¢ Show full path name: Displays the full path of a system or block.
Choosing this option for a block causes the Simulink block name to
appear as <Model Name>/<System Name>/<Block Name>.

Note This option is not available for models or signals.

Yes. Text.

rptgen_sl.csl_obj_name

Chapter/Subsection
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Simulink Property

Purpose Insert property name/property value pair for current Simulink® model,
system, block, or signal

Description This component inserts a single property name/property value pair for
the current Simulink model, system, block, or signal.
Simulink ® Object type: Specifies the Simulink object type to include in the
Obiect report. Options include:
and = System
Parameter - odel
= Block
= Signal

= Annotation

* System parameter name: Specifies a Simulink parameter name to
include in the generated report:

= If you select Model for Object type, this option appears as Model
parameter name.

= If you select Block for Object type, this option appears as Block
parameter name.

= If you select Signal for Object type, this option appears as
Signal parameter name.

Display ¢ Title: Choose a title to display in the generated report:
Options = Automatic: Uses the parameter name as the title.
= Custom: Specifies a custom title.

= None: Uses no title.

¢ Size limit: Limits the width of the display in the generated report.
Units are in pixels. The size limit for a given table is equal to the
hypotenuse of the table width and height [sqrt(w~2+h~2)]. The size
limit for text is the number of characters squared. If you exceed the
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Simulink Property

Insert
Anything
info
Report?

File Name

See Also

size limit, the variable appears in condensed form. Setting a size limit
of zero always causes the variable to display, regardless of its size

¢ Display as: Specifies a display style. Options include:

= Auto table/paragraph: Displays as a table or paragraph based
on the information.

= Table: Displays as a table.
= Paragraph: Displays as a text paragraph.

= Inline text: Displays as inline, which fits in line with the
surrounding text.

¢ Ignore if value is empty: Excludes the parameter from the
generated report if the parameter is empty.

Yes. Text.

rptgen_sl.csl_property

Block Loop, Model Loop, System Loop
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Simulink Property Table

Purpose
Description

Properties

Table
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Insert table that reports on model-level property name/property value
pairs

This component inserts a table that reports on model-level property
name/property value pairs.

Select Object: Choose the object for the Property Table in the
generated report. Options include:

® Model

® System

® Block

® Signal

® Annotation

For more information about selecting object types in Property Table
components, see “Selecting Object Types” on page 5-12.

Select a preset table, which is already formatted and set up, in the
preset table list in the upper-left corner of the attributes page.

¢ preset table: Specifies the type of the object property table. Options
include:
= Default
= Simulation parameters
= Version information
= RTW information
= Summary (req. RTW)

= Blank 4x4
To apply a preset table, select the table and click Apply.



Simulink Property Table

Cell
Properties

* Split property/value cells: Split property name/property value
pairs into separate cells. For the property name and property value to
appear in adjacent horizontal cells, select the Split property/value
cells check box. In this case, the table is in split mode, so only one
property name/property value pair is allowed per cell. If there is more
than one name/property pair in a cell, only the first pair appears in
the report. All subsequent pairs are ignored.

For the property name and property value to appear together in
one cell, clear the Split property/value cells check box. This is
nonsplit mode. Nonsplit mode supports more than one property
name/property value pair and text per cell.

Before switching from nonsplit mode to split mode, make sure that
there is only one property name/property value pair per table cell. If
there is more than one property name/property value pair or text per
cell, only the first property name/property value pair appears in the
report; subsequent pairs and text are omitted.

¢ Display outer border: Displays the outer border of the table in
the generated report.

e Table Cells: Specifies table properties to modify. The selection in
this pane affects available fields in the Cell Properties pane.

The options in this pane depend on the object selected in the Table
Cells pane. If you select %<Name> Information, only Contents and
Show appear. If you select any other object in the Table Cells pane,
Lower border and Right border display.

¢ Contents: Enables you to change the contents of the table cell
selected in the Table Cells pane.

¢ Show as: Specifies the format for the contents of the table cell.
Options include:

= Value
= Property Value
= PROPERTY Value
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Simulink Property Table
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= Property: Value
= PROPERTY: Value

= Property - Value
= PROPERTY - Value

® Alignment: Specifies the alignment of the contents of the selected
table cell in the Table Cells pane. Options include:

= Left

= Center

= Right

= Double justified

¢ Lower border: Displays the lower border of the table in the
generated report.

* Right border: Displays the right border of the table in the generated
report.

Creating Custom Tables

To create a custom table, edit a preset table, such as the Blank 4x4
table. Add and delete rows and add properties. To open the Edit Table
dialog box, click Edit.

For more information on creating custom property tables, see “Working
with Property Table Components” on page 5-9.

If the Real-Time Workshop® software is not installed, Summary (req
RTW) does not appear in this list. If you are using a report template that
contains a summary property, the property name appears in the report,
but the property value does not.

Example

The following report displays information on the F14 demo model using
the Simulation Parameters preset table.



Simulink Property Table
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Solver ode45

ZeroCross on

StartTime 0.0
StopTime 60

RelTol le-4

AbsTol 1e-6

Refine 1

InitialStep auto

FixedStep auto

MaxStep auto

LimitMaxRows off

MaxRows 1000

Decimation 1

Yes. Table.

rptgen_sl.csl prop_table

Model Loop, Signal Loop, System Loop
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Simulink Summary Table

Purpose
Description

Obiject
type

Table title

Property
Columns
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Display properties or parameters of specified Simulink® models,
systems, blocks, or signals in table

This component displays properties or parameters of selected Simulink
models, systems, blocks, or signals in a table.

Choose the object type to display in the generated report. Options
include:

® Block (Default)

* Model

® System

® Signal

® Annotation

The selected object type affects the options available in the Property
Columns pane.

Choose a title to appear in the generated report:

® Automatic: Automatically generates a title from the parameter.
® Custom: Specifies a custom title.
This pane displays object properties to include in the Summary Table in
the generated report.
e To add a property:
a select the appropriate property level in the text box on the left.

b In the text box on the right, select the property that you want to
add and click Add.

® To delete a property, select the property name and click Delete.



Simulink Summary Table

Object
Rows

%<SplitDialogParameters> is a unique property that can be specified
for Simulink Summary Tables where the object type is Block. This
property generates multiple summary tables, organized by block type.
Each Summary Table group contains the dialog box parameters for
that block.

Some entries in the list of available properties (such as Depth) are
“virtual” properties that you cannot access using the get param
command. The properties used for property/value filtering in the block
and System Loop components must be retrievable by the get_param.
Therefore, you cannot configure your Summary Table to report on all
blocks of Depth == 2.

You can create multiple values for a property in a Simulink Summary
Table. For example, to report on blocks of type Inport, Outport and
Constant:

1 Check the Search for Simulink property name/property value
pairs box.

2 Make sure that you set Property Name to BlockType.
3 Type the following text into the Property Value field:

\<(Inport]|Outport|Constant)\>

Remove empty columns: Removes empty columns from the table.

¢ Insert anchor for each row: Inserts an anchor for each row in
the summary table.

¢ Report On: Options include:

= Automatic list from context: Reports on all blocks in the
current context, as set by the parent component.
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Simulink Summary Table
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Loop
Options

Custom - use block list: Reports on a list of specified blocks.
Specify the full path of each block.

¢ Sort blocks

Alphabetically by block name: Sorts blocks alphabetically by
name.

Alphabetically by system name: Sorts systems alphabetically
by name. Blocks in each system are listed, but in no particular
order.

Alphabetically by full Simulink path: Sorts blocks
alphabetically by Simulink path.

By block type: Sorts blocks alphabetically by block type.
By block depth: Sorts blocks by their depth in the model.
By traversal order: Sorts blocks by traversal order.

By simulation order: Sorts blocks by execution order.

%<VariableName>: Inserts the value of a variable from the
MATLAB® workspace. The %<> notation can denote a string or cell
array. For more information, see %<VariableName> Notation on
the Text component reference page.

¢ Search for Simulink property name/property value pairs:
Reports on blocks with specified property name/property value pairs.

Example

Specify the following options to generate a Summary Table in a report
for on the demo model F14:

® Sort on systems by system depth.

® Include the system parameters Name and Block in the table.

The following table appears in the report.



Simulink Summary Table
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Blocks

f14

u, Actuator Model, Aircraft Dynamics Model,
Angle of Attack, Controller, Dryden Wind Gust
Models, Gain, Gainl, Gain2, Gain5, More Info,
More Infol, Nz pilot calculation, Pilot, Pilot G
force Scope, Stick Input, Sum, Sum1, alpha (rad),
Nz Pilot (g)

Aircraft

Dynamics Model

Elevator Deflection d (deg), Vertical Gust wGust
(ft/sec), Rotary Gust qGust (rad/sec), Gain3, Gain4,
Gainb, Gain6, Suml, Sum2, Transfer Fen.1,
Transfer Fen.2, Vertical Velocity w (ft/s), Pitch
Rate q (rad/s)

Controller

Stick Input (in), alpha (rad), q (rad/s),
Alpha-sensor Low-pass Filter, Gain, Gain2, Gain3,
Pitch Rate Lead Filter, Proportional plus integral
compensator, Stick Prefilter, Sum, Sum1, Sum2,
Elevator Command (deg)

Dryden Wind

Band-Limited White Noise, Q-gust model, W-gust

Gust Models model, Wg, Qg
More Info None
More Infol None
Nz pilot w, q, Constant, Derivative, Derivativel, Gainl,
calculation Gain2, Product, Sum1, Pilot g force (g)
Yes. Table.

rptgen_sl.csl_summ_table

Block Loop, Model Loop, Signal Loop, System Loop
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State Loop

Purpose

Description

State
Types

Loop
Options
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Run child components for all states in current context

This component runs its children for all states in its context, which is
determined by its parent component. Options include:

® Model Loop: Includes all states in the models.

e System Loop: Includes all states in the systems.

® Machine Loop: Includes all states in the machines.

® Chart Loop: Includes all states in the charts.

e State Loop: Includes all states in the current state.

¢ Include “and” and “or” states: Includes AND and OR states in the
loop.

® Include “box” states: Includes “box” states in the loop.
¢ Include functions: Includes “function” states in the loop.
¢ Include truth tables: Includes truth tables in the loop.

¢ Include Embedded MATLAB functions: Includes Embedded
MATLAB™ functions in the loop.

* Report depth: Specifies the level on which to loop. Options include:
= Local children only
= All objects

¢ Skip autogenerated charts under truth table: Keeps
autogenerated state objects under truth tables from appearing in
the report.

¢ Search Stateflow: Indicates specific states to include in the loop.



State Loop

Section
Options
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See Also

* Create section for each object in loop: Inserts a section in the
generated report for each object found in the loop.

* Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.

® Create link anchor for each object in loop: Creates a hyperlink
to the object in the generated report.

Yes, section, if you select the Create section for each object in loop
option.

rptgen_sf.csf_state_loop

Chart Loop, Machine Loop, Model Loop, State Loop, System Loop
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Stateflow Automatic Table

Purpose Insert table with properties of current Stateflow® object

Desc ription The Stateflow Automatic Table component inserts a table that contains
the properties of the current Stateflow object. Parents of this component
can be:

® Machine Loop

® State Loop

® Chart Loop

® Graphics Object Loop

Displdy * Table title: Specifies a title for the table in the generated report.
Options Options include:

= No title: Includes no title.

= Custom: Includes a custom title.

= Name (default): Uses an object name as the title. Options include:
e Object name
e Object name with Stateflow path
e Object name with Simulink and Stateflow path

¢ Header row: Selects a header row for the table in the generated
report. Options include:

= No header: Includes no header row.

Type and Name: Includes a header row with columns for name
and object type. When selected, this option creates a header row
for the table with object name and type.

= Custom: Includes a custom header.

¢ Don’t display empty values: Excludes empty values from the
generated report.
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Yes. Table.

rptgen_sf.csf_auto_table

Chart Loop, Graphics Object Loop, Machine Loop, State Loop
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Stateflow Count

Purpose

Description

Properties

Insert
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See Also
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Count number of Stateflow® objects in current context

This component counts the number of Stateflow objects in the current
context.

® Search depth: Specifies the search depth for the count. Options
include:

= Immediate children only (default): Searches only children one
level under the Stateflow object.

= All descendants: Searches all children of the Stateflow object.

® Sort results: Specifies the sort method for the count results. Options
include:

= Numerically decreasing by object count (Default)
= Alphabetically increasing by object type

® Include a list of objects in table: Inserts a column containing
the counted objects.

* Show total count: Displays a total of counted objects.

Yes. Table.

rptgen_sf.csf_count

State Loop



Stateflow Dialog Snapshot

Purpose

Description

Format

Display
Options

Insert snapshots of Stateflow® editor dialog boxes

This component reports on the current reported Stateflow dialog box
object, depending on its context. If this component is the child of a
State Loop, for example, the report includes information about the
current State’s dialog box. Display the current settings associated with
an object or document the appearance of your custom mask dialog boxes.

* Image file format: Specifies the format for the snapshot image file.
The Automatic format uses BMP format for PDF files and PNG for
other formats.

e Show all tabs: Automatically generates images for all the tabs for
the dialog box. If this check box is cleared, the Simulink® Report
Generator™ software creates an image of only the first tab.

¢ Scaling: Options include:
= Fixed size: Specifies the number and type of units.

= Zoom: Specifies the percentage, maximum size, and units of
measure.

= Use image size: Causes the image to appear the same size in
the report as on screen.

® Size: Specifies the size of the snapshot in the form w h (width
height). This field is active only if you choose Fixed size in the
Scaling selection list.

® Max size: Specifies the maximum size of the snapshot in the form
w h (width height). This field is active only if you choose Zoom in
the Scaling selection list.

¢ Units: Specifies the units for the size of the snapshot. This field
is active only if you choose Zoom or Fixed size in the Image size
list box.

® Alignment: Aligns your snapshot. Options include:

= Auto
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= Right
= Center

= Left
Only PDF and RTF reports support this option.

¢ Title: Specifies text to appear above the snapshot.

¢ Caption: Specifies text to appear under the snapshot.

Yes. Snapshot.

rptgen_sl.Cdialog boxesnapshot

State Loop



Stateflow Filter

Purpose Run child components only if current object type matches specified
object type

Description This component runs its children only if the current object type, as
set by its parent Stateflow Hierarchy Loop, matches the selected
object type.

Properties * Object type: Specifies the Stateflow® object type to include in the
report.

¢ Run only if Stateflow object has at least the following number
of Stateflow children: Specifies a minimum number of children
that a Stateflow object must have to include in the report.

* Automatically insert linking anchor: Inserts a linking anchor
before the reported object. If an anchor for this object exists, a second
anchor is not created.

Insert No.

Anything

info

Report?

File Name rptgen_sf.csf_obj_filter
See Also Stateflow Hierarchy Loop
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Stateflow Hierarchy

Purpose

Description

Tree
Options

Children
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Provide visual representation of the hierarchy of a Stateflow® object

This component inserts a tree that shows the hierarchy of a given
Stateflow object.

* Construct tree from: Specifies the object to use for the tree
representation. Options include:

= Current object

= Root of current object: Starts reporting from the top of the
hierarchy.

e Emphasize current object in tree: Highlights the current object
in the tree representation.

¢ Show number of parents: Specifies the number of parents to
include in the tree representation.

¢ Show siblings: Displays siblings in the tree representation.

¢ Show children to depth: Specifies the depth of children to display
for each object in the tree representation.

* Show junctions: Specifies the level of junction detail to display in
the generated report. Options include:

= All
= Non-redundant
= None

* Show transitions: Specifies the level of transition detail to display
in the generated report. Options include:

= All
= Labeled or non-redundant
= Non-redundant

= Labeled



Stateflow Hierarchy

" None

¢ Skip autogenerated charts under truth tables: Excludes
autogenerated charts under truth tables.

List ¢ List style: Options include:

Formatting - Bulleted list

= Numbered list: Allows you to specify numbering options in the
Numbering style section.

e Numbering style: Allows you to specify a numbering style.
Options include:

. 1,2,3,4...

e a,b,c,d...

« A,B,C,D...

o i,ii,iii,iv...

e I,II,III,IV...

To show the parent number in each list entry, select Show

parent number in nested list (1.1.a). To show only the
current number or letter, select Show only current list

value (a).
Insert Yes. Tree graphic.
Anything
into
Report?
File Name rptgen_sf.csf_hier
See Also Stateflow Hierarchy Loop
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Run child components on Stateflow® object hierarchy

This component runs its child components on the Stateflow object
hierarchy.

* Minimum legible font size: Specifies the minimum font size to use
in the report. The default font size, 8, is the smallest recommended
font size.

¢ Skip autogenerated charts under truth tables; Excludes
autogenerated charts under truth tables in the report.

* Search Stateflow: Reports on Stateflow charts with specified
property name/property value pairs.

* Create section for each object in loop: Inserts a section in the
generated report for each object found in the loop.

* Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.

® Create link anchor for each object in loop: Creates a hyperlink
to the object in the generated report.

No.

rptgen_sf.csf_hier_loop

Stateflow Hierarchy



Stateflow Linking Anchor
|

Purpose Designate locations to which links point

Description This component designates a location to which other links point. The
linking anchor is set to the current object, as defined by the parent
component.

This component must have the Chart Loop, State Loop, Machine
Loop, or Stateflow Filter component as its parent.

Properties Insert text: Specifies text to appear after the linking anchor.
Insert Yes. A link, and possibly text, depending on attribute choices.
Anything

into

Report?

File Name rptgen_sf.csf_obj_anchor

See Also Chart Loop, Machine Loop, State Loop, Stateflow Filter,
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Purpose

Description

Properties
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Insert into report name of Stateflow® object specified by parent
component

This component inserts the name of the Stateflow object, as defined
by its parent component, into the report. This component must have
the State Loop, Chart Loop, or Stateflow Filter component as its
parent.

You can use this component as the first child component of a
Chapter/Subsection component to allow the current Stateflow object
name to be the chapter or section title.

¢ Display name as: Displays the Stateflow object name in the report.
Options include:
= Name: For example, Object
= Type Name: For example, Object <ObjectName>
= Type - Name: For example, Object - <ObjectName>
= Type: Name: For example, Object: <ObjectName>

* Display name as: Specifies the level of detail with which the
Stateflow object name displays the report. Options include:

™ Object name
™ Object name with Stateflow path
™ Object name with Simulink and Stateflow path

Yes. Text.

rptgen_sf.csf_obj_name

Chapter/Subsection, Chart Loop, State Loop, Stateflow Filter



Stateflow Property

Purpose
Description

Property
to Display

Display
Options

Insert into report table, text, or paragraph with information on selected
Stateflow® object property

This component inserts a table, text, or paragraph that contains details
of the selected Stateflow object property.

Property name: Specifies the Stateflow property name to display.

¢ Title: Specifies a title to display in the generated report. Options
include:

= Automatic: Uses the parameter name as the title.

= Custom: Specifies a custom title.
= None: Specifies no title.

¢ Size limit: Specifies the width of the display in the generated report.
Units are in pixels. The size limit for a given table is the hypotenuse
of the table’s width and height, sqrt(w*2+h~2). The size limit for
text is the number of characters squared. If you exceed the size limit,
the variable appears in condensed form.

Setting a size limit of 0 always displays the variable in long form,
regardless of its size.

¢ Display as: Specifies a display style from the menu. Options include:

= Auto table/paragraph (default): Displays as a table or paragraph
based on the information.

= Table: Displays as a table.

Paragraph: Displays as a text paragraph.

Inline text: Displays in line with the surrounding text.

¢ Ignore if value is empty: Excludes empty parameters from the
generated report.
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Insert Yes. Text, paragraph, or table.
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File Name rptgen_sf.csf_property

See Also Paragraph, Table, Text, Stateflow Name
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Stateflow Property Table

Purpose

Description

Table

Insert into report property-value table for Stateflow® object

This component inserts a property-value table for a Stateflow object
into the report. This component’s parent must be Stateflow Filter.

For more information on working with Property Table components, see
“Working with Property Table Components” on page 5-9.

Select a preset table, which is already formatted and set up, in the
preset table list in the upper-left corner of the attributes page.

* preset table: Specifies a type of table to display the object property
table. Options include:

Default
Machine
Chart

State

Truth table
EM function
Data

Event

Junction

To apply a preset table, select the table and click Apply.

* Split property/value cells: Splits property name/property value
pairs into separate cells.

For the property name and property value to appear in adjacent
horizontal cells, select the Split property/value cells check
box. In this case, the table is in split mode, so only one property
name/property value pair is allowed per cell. If there is more than
one name/property pair in a cell, only the first pair appears in the
report. All subsequent pairs are ignored.
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Stateflow Property Table

Cell
Properties
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= For the property name and property value to appear together in
one cell, clear the Split property/value cells check box. This is
nonsplit mode. Nonsplit mode supports more than one property
name/property value pair and text.

= Before switching from nonsplit mode to split mode, make sure that
there is only one property name/property value pair per table cell.
If there is more than one property name/property value pair or any
text in a given cell, only the first property name/property value
pair appears in the report. Subsequent pairs and text are omitted.

¢ Display outer border: Displays the outer border of the table in
the generated report.

¢ Table Cells: Specifies table properties to modify. The selection in
this pane affects the available fields in the Cell Properties pane.

The options in the Title Properties pane depend on the object selected
in the Table Cells pane. If you select %<Name>, only Contents and
Show appear. If you select any other object in the Table Cells pane,
Lower border and Right border appear.

¢ Contents: Modifies the contents of the table cell selected in the
Table Cells pane.

¢ Alignment: Justifies the contents of the selected table cell in the
Table Cells pane. Options include:

= Left

= Center

= Right

= Double justified

¢ Show As: Specifies the format for the contents of the table cell.
Options include:

= Value

= Property Value



Stateflow Property Table
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= PROPERTY Value

= Property: Value
= PROPERTY: Value
= Property - Value
= PROPERTY - Value

¢ Lower border: Displays the lower border of the table in the
generated report.

¢ Right border: Displays the right border of the table in the generated
report.

Creating Custom Tables

You can edit a preset table, such as the Blank 4x4 table, to create a
custom table. Add and delete rows and add properties. To open the
Edit Table dialog box, click Edit.

For details about creating custom property tables, see “Working with
Property Table Components” on page 5-9.

Yes. Table.

rptgen_sf.csf_prop_table

Stateflow Filter
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Stateflow Snapshot

Purpose Insert into report snapshot of Stateflow® object

Description This component inserts a snapshot of a Stateflow object, defined by the
Stateflow Filter parent component, into the report.

This component only executes if the selected object in the Stateflow
Filter component is a graphical object, such as Chart, State,
Transition, and Frame

Snapshot

Image file format: Specifies the image file format (for example, JPEG
or TIFF). Select Automatic SF Format (default) to automatically
choose the format best suited for the specified report output format.
Otherwise, choose an image format that your output viewer can read.
Options include:

= Automatic SF Format (uses the file format selected in the
Preferences dialog box)

= Adobe Illustrator

= Bitmap (16m-color)

= Bitmap (256-color)

= Black and white encapsulated PostScript

= Black and white encapsulated PostScript (TIFF)
"= Black and white encapsulated PostScript2

= Black and white encapsulated PostScript2 (TIFF)
= Black and white PostScript

= Black and white PostScript2

= Color encapsulated PostScript

= Color encapsulated PostScript (TIFF)

= Color encapsulated PostScript2

= Color encapsulated PostScript2 (TIFF)

= Color PostScript
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Color PostScript2

JPEG high quality image

JPEG medium quality image
JPEG low quality image

PNG 24-bit image

Scalable vector graphics (SVG)
TIFF - compressed

TIFF - uncompressed

Windows metafile

Paper orientation: Options include:

Portrait
Landscape

Rotated

Largest dimension vertical. Positions the image so that its

largest dimension is vertical.

Use Chart PaperOrientation setting. Uses the paper
orientation setting you have specified for your chart.

Image sizing: Options include:

= Shrink image to minimum font size specified in
Stateflow Hierarchy Loop: Resizes the image so that the text
label font size is the minimum font size.

= Fixed and Zoom: Specifies the size of the image.

Scaling: Specifies a percentage of the image’s size to which to scale

it.

Maximum size: Specifies the maximum size for the snapshot in
the generated report in the selected units. Use [width height]
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Properties

Display
Options
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format. In the units text box, select Inches, Centimeters, Points,
or Normalized.

Use printframe: Inserts a frame around your image. Use the
default frame or create a custom one.

Use printframe paper settings: Uses the dimensions and
parameters as set by the specified printframe to size your image.
If you choose this option, all other options (except for Image file
format) become inactive.

Include callouts to describe visible objects: Displays descriptive
callouts for visible objects.

Insert anchors for transitions and junctions: Inserts anchors
for transitions and junctions into the report. Options include:

= None
= Redundant children only
= All

Run only if Stateflow object has at least the following number
of children: Specifies the minimum number of children that the
current Stateflow object must have to include in the report. This
option is inactive unless the selected object in the parent Stateflow
Filter component is a graphical object.

Tip This option allows you to exclude certain images to decrease the
size of the report for large models.

Scaling: Options include:

= Use image size: Uses the image size that you specify in the
snapshot option.

= Zoom and Fixed size: Allows you to specify the size of the image.

Size: Specifies a size in inches for your image. The default is 7-by-9.



Stateflow Snapshot

Max size: Specifies the maximum size of the snapshot in the format
w h (width height). This field is active only if you choose Zoom from
the Scaling selection list.

Units: Specifies the units for the size of the snapshot. This field is
active only if you choose Zoom or Fixed size in the Image size
list box.

Alignment: Options include:
= Auto

= Right

= Center

= Left
Only PDF and RTF reports support this option.

Image title: Options include:
= None(Default).
= Object name: Uses the object name as the title.

= Full Stateflow name: Specifies the Stateflow path and the name
of the object.

= Full Simulink + Stateflow name: Specifies the Simulink® path
and name of the object.

= Custom: Enter a different title.

Caption: Specifies a caption for your image. Options include:
= None(Default).

= Custom: Specifies a custom caption.

= Description: Sets the caption to the value of the object
Description property.
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Yes. Image.

rptgen_sf.csf_obj_snap
rptgen_sf.csf_prop_table
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Stateflow Summary Table

Purpose

Description

Properties

Property
Columns

Display table of properties or parameters of specified Stateflow® object

This component displays a table of properties or parameters of specified
Stateflow objects. It can have the following parents:

® Any Stateflow looping component

¢ Any Simulink® looping component (Model Loop, System Loop,
Block Loop, or Signal Loop)

Object type: Specifies the object type to display in the generated
report. This value affects the options available in the Property
Columns pane.

Table title: Specifies a title for the Summary Table in the generated
report. Options include:

= Automatic: Generates a title automatically from the parameter.

= Custom: Specifies a custom title.

Property columns: Displays the object properties to include in the
Summary Table in the generated report.

= To add a property:
« Select the appropriate property level in the text box.

e In the context list under the text box, select the property that
you want to add and click Add.

= To delete a property, select the property name and press the
Delete key.

Some entries in the list of available properties (such as Depth) are
“virtual” properties that you cannot access using the get _param
command. The properties used for property/value filtering in the
block and System Loop components must be retrievable by the
get_param. Therefore, you cannot configure your Summary Table to
report on all blocks of Depth == 2.
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Object
Rows

Report On

Loop
Options
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* Remove empty columns: Removes empty columns from the
Summary Table in the generated report.

Insert anchor for each row: Inserts an anchor for each row in the
summary table.

¢ Automatic list from context: Reports on all blocks in the current
context, as set by the parent component.

¢ Custom - use block list: Reports on a specified list of blocks.
Specify the full path of each block.

Choose block sorting options and reporting options in this pane.

¢ Sort blocks: Specifies how to sort blocks:

Alphabetically by block name: Sorts blocks alphabetically by
name.

Alphabetically by system name: Sorts systems alphabetically
by name. Blocks in each system are listed, but in no particular
order.

Alphabetically by full Simulink path: Sorts blocks
alphabetically by Simulink path.

By block type: Sorts blocks alphabetically by block type.
By block depth: Sorts blocks by their depth in the model.
By traversal order: Sorts blocks by traversal order.

By simulation order: Sorts blocks by execution order.

%<VariableName>: Inserts the value of a variable from the
MATLAB® workspace. The %<> notation can denote a string or cell
array. For more information, see %$<VariableName> Notation on
the Text component reference page.

¢ Search for Simulink property name/property value pairs:
Reports on blocks with specified property name/property value pairs.
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® Search Stateflow: Reports on Stateflow charts with specified
property name/property value pairs.

Yes. Table.

rptgen_sf.csf_summ_table

Block Loop, Chart Loop, Model Loop, Object Loop, Signal Loop,
State Loop, Stateflow Hierarchy Loop, System Loop
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Purpose
Description

Properties

Insert
Anything
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File Name

See Also
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Run child components only if the current system meets specified
conditions

This component runs child components only if the current system meets
specified conditions.

* Report only if system has at least N blocks: Specifies the
minimum number of blocks that the system must include for the
child components to execute. If you enter 0, child components execute
regardless of the number of blocks in the system.

* Report only if system has at least N subsystems: Specifies
the minimum number of subsystems that the system must include
for the child components to execute Note that if you enter 0, child
components execute regardless of the number of subsystems in the
system.

* Report only if system mask type is: Specifies which masks to
include in the generated report. Options include:

= Either masked or unmasked
= Masked

= Unmasked

No.

rptgen_sf.csf_obj_filter
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System Hierarchy

Purpose

Description

Starting
System

Display
Systems

List
Formatting

Create nested list that shows hierarchy of specified system

This component creates a nested list that shows the hierarchy of a
specified system. The list can display all systems in a model, or the
parents and children of the current system.

¢ Build list from: Specifies the system or model from which the list
is built. Options include:

= Current system
= Current model

e Emphasize current system: Highlights the current system or
model in the generated report.

* Show number of parents: Specifies the number of parents to list.

* Display peers of current system: Shows the current system’s
peers in the generated report.

* Show children to depth: Specifies the depth of children to list.

¢ List style: Options include:
= Bulleted list

= Numbered list: Allows you to select numbering options in the
Numbering style section.

e Numbering style: Allows you to select a numbering style in this
selection list, if you set List style to Numbered List. Options include:

= 1,2,3,4,...
= a,b,c,d,...
= A,B,C,D,...
i,ii,iii,iv,...

- I,II,III,IV,...
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Insert Yes. List.

Anything

into

Report?

File Name rptgen_sl.csl_sys_list
See Also Model Loop, System Loop
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System Loop

Purpose

Description

Report On

Loop
Options

Specify systems and subsystems on which to loop, as defined by parent
component

This component runs its child components for each system defined by
the parent component. For example, you can include this component as
the child of a Model Loop component to include systems and subsystems
within a given model in the report.

* Loop on Systems:

= Select systems automatically: Reports on all systems in the

current context as set by the parent component. Options include:
» Model Loop: Reports on systems in the current model.

e System Loop: Reports on the current system.

e Signal Loop: Reports on the current signal’s parent system.

e Block Loop: Reports on the current block’s parent system.
If this component does not have any of these components as its
parent, selecting this option reports on all systems in all models.

* Custom - use system list: Reports on a list of specified systems.
Specify the full path of each system.

® Sort Systems: Specifies how to sort systems. Options include:

Alphabetically by system name (default): Sorts systems
alphabetically by name.

By number of blocks in system: Sorts systems by number of
blocks. The list shows systems by decreasing number of blocks;
that is, the system with the largest number of blocks appears first
in the list.

By system depth: Sorts systems by their depth in the model.

By traversal order: Sorts systems in the order they are
traversed.
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= %<VariableName>: Inserts the value of a variable from the
MATLAB® workspace. The %<> notation can denote a string or cell
array. For more information, see %<VariableName> Notation on
the Text component reference page.

e Search for: Reports only on blocks with specified property
name/property value pairs.

Section * Create section for each object in loop: Inserts a section in the
OPtion S generated report for each object found in the loop.

¢ Display the object type in the section title: Inserts the object
type automatically into the section title in the generated report.

¢ Number sections by system hierarchy: Hierarchically numbers
sections in the generated report.

¢ Create link anchor for each object in loop: Creates a hyperlink
to the object in the generated report.

Examples For an example of how to use this component with a Model Loop as
its parent, see Model Loop.

Insert Yes, inserts a section if you select the Create section for each object
Any[hing in loop option.

into

Report?

File Name rptgen_sl.csl_sys_loop

See Also Block Loop, Model Loop, Signal Loop, System Loop
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System Snapshot

Purpose

Description

Snapshot

Insert snapshot of the current system into report

This component inserts a snapshot of the current system into the report.

* Image file format: Specifies the image file format (for example,
JPEG or TIFF). Select Automatic SL Format (the default) to
automatically choose the format best suited for the specified report
output format. Otherwise, choose an image format that your output
viewer can read. Options include:

Automatic SL Format (uses file format selected in the Preferences
dialog box)

Adobe Illustrator

Bitmap (16m-color)

Bitmap (256-color)

Black
Black
Black
Black
Black
Black
Color
Color
Color
Color
Color

Color

and white
and white
and white
and white
and white

and white

encapsulated PostScript
encapsulated PostScript (TIFF)
encapsulated PostScript2
encapsulated PostScript2 (TIFF)
PostScript

PostScript2

encapsulated PostScript

encapsulated PostScript (TIFF)

encapsulated PostScript2

encapsulated PostScript2 (TIFF)

PostScript

PostScript2

JPEG high quality image

JPEG medium quality image
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= JPEG low quality image
= PNG 24-bit image
= Scalable vector graphics (SVG)
= TIFF - compressed
= TIFF - uncompressed
= Windows metafile
* Paper orientation: Options include:
= Largest dimension vertical
= Landscape
= Portrait

= Use system orientation: The Use system orientation
option uses the Simulink® PaperOrientation parameter. For
more information, see “Model Parameters” in the Simulink
documentation.

* Image Size: Options include:

= Automatic (default): Automatically scales the image to output
dimensions.

= Custom: Specifies image size.

Note If you select Use printframe , the Custom option is
deactivated and the image is automatically scaled to the print
frame size.

¢ Use printframe: Prints a frame around the image. You can use
the default frame, rptdefaultframe.fig, or use the Frame Editor
to build a custom frame. For more information, see frameedit in
the MATLAB® documentation.
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|

The default frame is five inches wide and four inches high. It
includes the name of the system and the model directory. This frame
is optimized for use with a portrait paper orientation. The Flight
Control Model in the f14 Simulink demo model appears here with
the default Simulink® Report Generator™ frame option.
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File Edit Yew Simulation Format Tools Help
DE=EH&| BR[| Es 4|2 r = Nomal FllEE RS wEE e
F-14 Longitudinal Flight Control
This demonstration moedels a flight contral
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Filat G-
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Dryden Wind Airoraft
Gust Models Dynamics
L tq Model alpha, rad
» (1)
alpha, rad
Copyright 1990-2005 The hathiifads, Inc.
Feady [1o0es [ |odes v
M . . .
Dlspluy ® Scaling: Options include:

Options

= Fixed size: Specifies the number and type of units.

= Zoom: Specifies the percentage, maximum size, and units of
measure.
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= Use image size: Causes the image to appear the same size in
the report as on screen.

Size: Specifies the size of the snapshot in the format w h (width
height). This field is active only if you choose Fixed size in the
Scaling selection list.

Max size: Specifies the maximum size of the snapshot in the format
w h (width height). This field is active only if you choose Zoom in
the Scaling selection list.

Units: Specifies the units for the size of the snapshot. This field
is active only if you choose Zoom or Fixed size in the Image size
list box.

Alignment: Options include:
= Auto
= Right
= Left

= Center
Only PDF and RTF reports support this option.

Image title: Options include:
= No title (Default)
= System name: Uses the system name as the image name.

= System name (full path): Uses the system name, with path
information, as the image name.

= Custom: Specifies a custom title.

Caption Options include:

= None (Default)

= Description (use system description)

= Custom: Specifies a custom caption.
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Yes. Image.

rptgen_sl.csl_sys_snap

System Loop
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To Workspace Plot

Purpose Capture plot figure created in the MATLAB® workspace

Description This component captures a plot figure created in the MATLAB
workspace, and then inserts one or both of the following into the report:
¢ A table that includes input and output numeric values.

e A figure that plots the values included in the table.

Print * Image file format: Specifies the image file format (for example,

Options JPEG or TIFF) from this list. Select Automatic HG Format (the
default) to automatically choose the format best suited for the
specified report output format. Otherwise, choose an image format
that your output viewer can read. Other options include:

= Automatic HG Format (Uses the file format selected in the
Preferences dialog box)

= Adobe Illustrator

= Bitmap (16m-color)

= Bitmap (256-color)

= Black and white encapsulated PostScript

= Black and white encapsulated PostScript (TIFF)
"= Black and white encapsulated PostScript2

= Black and white encapsulated PostScript2 (TIFF)
= Black and white PostScript

= Black and white PostScript2

= Color encapsulated PostScript

= Color encapsulated PostScript (TIFF)

= Color encapsulated PostScript2

= Color encapsulated PostScript2 (TIFF)

= Color PostScript
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= Color PostScript2

= JPEG high quality image

= JPEG medium quality image
= JPEG low quality image

= PNG 24-bit image

= TIFF - compressed

= TIFF - uncompressed

= Windows metafile

Paper orientation: Options include:
= Landscape

= Portrait

= Rotated

= Use figure orientation
For information about paper orientation, see the orient command
in the MATLAB documentation.

Image size:

= Use figure PaperPositionMode setting: Uses the
PaperPositionMode property of the Handle Graphics® figure to set
the image size in the report. For information about paper position
mode, see the orient command in the MATLAB documentation.

= Automatic (same size as on screen): Causes the image to
appear the same size in the report as on screen.

= Custom: Specifies a custom image size. Specify the image size in
the size and units fields.

Size: Specifies the size of the Handle Graphics figure snapshot in
the format wxh (width times height). This field is active only if you
choose Custom in the Image size list box.
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Display
Options
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Units: Specifies units for the size of the Handle Graphics figure
snapshot. This field is active only if you choose Set image size
in the Custom list box.

Invert hardcopy: Uses the Handle Graphics figures
InvertHardcopy property, which inverts colors for printing; it
changes dark colors to light colors and vice versa.

Select one of the following options:

= Automatic: Automatically changes dark axes colors to a light axes
color. If the axes color is a light color, it is unchanged.

= Invert: Changes dark axes colors to light axes colors and vice
versa.

= Don't invert: Retains image colors displayed on screen in the
printed report.

= Use figure's InvertHardcopy setting: Uses the
InvertHardcopy property set in the Handle Graphics image.

= Make figure background transparent: Makes the image
background transparent.

Scaling
= Fixed size: Specifies the number and type of units.

= Zoom: Specifies the percentage, maximum size, and units of
measure.

= Use image size: Causes the image to appear the same size in
the report as on screen.

Size: Specifies the size of the snapshot in the format w h (width
height). This field is active only if you choose Fixed size in the
Scaling list.

Max size: Specifies the maximum size of the snapshot in the format
w h (width height). This field is active only if you choose Zoom from
the Scaling list.
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® Units: Specifies units for the size of the snapshot. This field is active
only if you choose Zoom or Fixed size in the Image size list box.

® Alignment: Options are:
= Auto
= Right
= Left

= Center
Only PDF and RTF reports support this option.

¢ Title: Specifies text to appear above the snapshot.

¢ Caption: Specifies text to appear under the snapshot.

Yes. Figure.

rptgen_sl.csl_blk_toworkspace

Figure Loop
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Truth Table

Purpose

Description

Title

Condition
Table

Action
Table
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Report on truth tables in Simulink® and Stateflow® models

The Truth Table component reports on truth tables in Simulink and
Stateflow models. It displays both the condition table and the action
table. The parent component of the Truth Table determines its behavior.
Options include:

® Model Loop: Reports on all truth tables in the current model.

® System Loop: Reports on all truth tables in the current system.

® Block Loop : Reports on all truth tables in the current block.

e Signal Loop: Reports on all truth tables in the current signal.

Title: Specifies a title for the truth table. Options include:

® No title
® Use Stateflow name

® Custom

Specify display parameters for the condition table. Options include:

¢ Show header: Displays the column headers in the table.

¢ Show number: Displays the condition number column in the table.
* Show condition: Displays the condition column in the table.

¢ Show description: Displays the description column in the table.

® Wrap if column count: Specifies how many columns to display
before creating a table continuation. If the specified number is
greater than the number of columns that can appear on the page,
some columns do not appear in the report.

¢ Show header: Displays the column headers in the table.

¢ Show number: Displays the condition number column in the table.
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* Show condition: Displays the condition column in the table.

®* Show description: Displays the description column in the table. If
this option is not selected, no action table appears in the report.

Yes. Table.

rptgen_sf.csf_truthtable

Block Loop, Model Loop, Signal Loop, System Loop
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Function Reference

GUI (p. 8-2)
Report Generation (p. 8-3)
Web Views (p. 8-4)

Perform GUI-related tasks
Generate reports

Export Simulink® models to Web
Views



8 Function Reference

GUI

rptlist Return list of all report templates in
MATLAB® path

8-2



Report Generation

Report Generation

report Generate report from specified
Simulink® system
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8 Function Reference

Web Views

slwebview Export Simulink® models to Web
views

8-4
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report

Purpose
Syntax

Description

See Also

Generate report from specified Simulink® system
report (system_name)

report (system_name) generates a report from the specified Simulink
system. If the specified system’s ReportName property is empty, the
ReportName property of its parent system is used instead.

report, Generating Reports



rptlist

Purpose
Syntax

Description

See Also

Return list of all report templates in MATLAB® path
rptlist ('system_name')

rptlist ('system_name') opens the Report Explorer with the
Simulink® system’s ReportName property selected.

report, setedit
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slwebview

Purpose

Syntax

Description

Export Simulink® models to Web views

slwebview
filename = slwebview(system_name)
. = slwebview(system_name, 'optioni', valuel, ...)

This function creates an interactive Web view of a Simulink model. For
more information about Web views, see Exporting Simulink Models
to Web Views.

® slwebview with no arguments starts the Web View dialog box in
the Report Explorer.

e filename = slwebview(system_name) exports the subsystem
system_name and its child systems to the file filename.

You can specify system_name as:

= A string

= A handle to a Simulink subsystem or block diagram
= A handle to a Stateflow® chart or subchart

® ... = slwebview(system_name, 'optioni', valuel, ...) sets
Web view export options. For more information, see “Export Options’
on page 9-4.

4

Export Options

The first argument passed to the slwebview command is the name (a
string) or a handle identifying the Simulink system or Stateflow chart
to export. Remaining arguments are alternating name and value pairs
(strings) that set export options.

SearchScope
Specifies which Simulink systems or Stateflow charts to export.



slwebview

’SearchScope’ Option Value

Meaning

Current

Export only the Simulink system
or the Stateflow chart specified
by the first argument

CurrentAndAbove

Export the Simulink system or
the Stateflow chart specified

by the first argument and all
systems or charts that contain it

CurrentAndBelow

Export the Simulink system or
the Stateflow chart specified

by the first argument and all
systems or charts that it contains
(default )

All

Export all Simulink systems or
Stateflow charts in the model
that contains the system or chart
specified by the first argument

LookUnderMasks

This option is relevant only when you are exporting Simulink
subsystems or Stateflow subcharts that the specified system or chart
contains. It specifies which masked blocks, if any, in subsystems or

subcharts to export.

‘LookUnderMasks’ Option

Value Meaning

None Do not export any masked blocks

Graphical Export only masked blocks that
have no workspaces and no dialog
boxes (default )

Functional Export only masked blocks that
have no dialog boxes

All Export all masked blocks




slwebview

FollowlLinks

Specifies whether to follow links into library blocks.

’FollowlLinks’ Option Value

Meaning

On

Follow links into library blocks

Off

Do not follow links into library
blocks (default)

FollowModelReferenceBlocks

Specifies whether to follow links into referenced models.

’FollowModelReferenceBlocks’
Option Value

Meaning

Oon Follow links into referenced
models
Off Do not follow links into referenced
models (default)
ViewfFile

Specifies whether to display the Web view in a Web browser.

‘ViewfFile’ Option Value Meaning
true Display the Web view in a Web
browser (default )
false Do not display the Web view in a
Web browser
See Also Exporting Simulink Models to Web Views
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Use this list to find examples in the documentation.



A

Examples

Creating Reports

Chapter 2, “Creating Simulink® Reports”

Generating Reports from M-files
Generating Reports from M-files on page 3-15

Creating Web Views
“Tutorial: Creating Web Views of Simulink® Models” on page 4-10

Working with Components

“Working with Looping Components” on page 5-3

“Working with Property Table Components” on page 5-9

“Working with Summary Table Components” on page 5-21

Generating Reports on Specified Systems and their Subsystems on page
7-43

Temporarily Omitting a Model from a Loop on page 7-49
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